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What is JDemetra+?

JDemetra+ is an open source software for seasonal adjustment and time se-
ries analysis, developed by the National Bank of Belgium with the support of
the Bundesbank, Insee and the partners of the COSA, (COfidentiality Seasonal
Adjustment and time series), project co-founded by Eurostat. JDemetra+ has been
officially recommended by Eurostat to the members of the European Statistical
System since 2015. It is unique in its combination of very fast Java routines, a
Graphical User Interface and an ecosystem of R packages (rjdverse). The
graphical interface provides structured visual feedback suitable for refined analy-
sis and training. R tools allow to combine the capabilities of JDemetra+ with the
versatility of the R world, be it for statistical functions or data wrangling. A pdf
version of this documentation is available here

Main Features

JDemetra+ provides algorithms for:

• Seasonal Adjustment
• Trend estimation
• Benchmarking and temporal disaggregation
• Nowcasting
• Revision analysis
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Currently available versions

The latest release in version 3 family can be found here.
Version 3.x family provides, among other things, extended features for seasonal
adjustment and trend estimation, including high frequency data.
The latest release in version 2 family can be found here.
The highest version using Java 8 is v2.2.4.

User Support and Useful links

If you need user support, please raise an issue in this repository
For specific questions related to production of seasonally adjusted series you
can look up these pages
To keep up with all JDemetra+ related news head over to the JDemetra+ Uni-
verse Blog
You can also browse and watch tutorials for JDemetra+. On this YouTube channel
you will also find JDemetra+ related webinars.

Background

This website is under construction, in the meantime you can fill a large number of
the gaps by referring to the previous version of the on-line documentation, coor-
dinated by Sylwia Grudkowska-Kubik (National Bank of Poland).
Eurostat’s recommendations on the statistical processes described in this docu-
mentation are outlined in:

• Eurostat’s Guidelines on seasonal adjustment (2024)
• Eurostat’s Guidelines on temporal disaggregation, benchmarking and recon-
cilation (2018)

Key methodological explanations and state-of-the-art description and references
can be found in:

• Handbook on seasonal adjustment (2018)
• Handbook on rapid estimates (2017)
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How to contribute

If you want to help us improve this book, you can fork this repository on GitHub
and create pull requests with your contributions.

Installing the software

The sections below detail how to install JDemetra+ (Graphical user interface and
Cruncher) and how to configure R to run rjd3 packages.

Graphical User Interface (GUI)

You can find the latest releases

• in the v2.x family: here

To install v2.2.4:

• Scroll down the page, download and unzip the file jdemetra-2.2.4-bin.zip.
• To start the application, run the file nbdemetra64.exe located in the follow-
ing subfolder …\jdemetra-2.2.4-bin\nbdemetra\bin

Remark: You can create shortcuts to the executable files if you want to launch
them from another folder (Desktop, project folder…).

• in the v3.x family: here

You should install the latest release available denoted from now on v3.x.y

• Scroll down the page, download and unzip the file jdemetra-standalone-3.x.y-
windows-x86_64.zip, if you use Windows, or the zip corresponding to your OS
in the list.

• To start the application, run the file nbdemetra64.exe located in the follow-
ing subfolder …\jdemetra-standalone-3.x.y-windows-x86_64\nbdemetra\bin
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Version 3.x requires Java 21 or higher, jdemetra-standalone-3.x.y-windows-
x86_64.zip contains a portable version of Java, so you don’t have to deal with this
issue on your computer.
R packages related to version 3.x (rjd3…) also require Java 21 or higher, you can
(and should) use the portable version provided with the graphical user interface
to run them, this is explained here.

Additional Plug-ins

To benefit from extended features of the graphical user interface installing addi-
tional plug-ins is required. The list of available extensions and the installation pro-
cedure are detailed here. How to access the added features in the GUI is described
here.
In the v2.x family some of the additional features are:

• Benchmarking and Temporal disaggregation Plug-in here
• Nowcasting Plug-in here

In the v3.x family some of the additional features are:

• Benchmarking and Temporal disaggregation Plug-in here
• Seasonal adjustment of high frequency data Plug-ins here
• Additional algorithms for seasonal adjustment Plug-ins here

Cruncher

JDemetra+ has an executable module, called the Cruncher, allowing to automate
tasks
To install it :

• in v2, go to the JWSACruncher page, download and unzip the com-
pressed folder jwsacruncher-2.2.x-bin.zip, corresponding to the version of
your Graphical User Interface.

• in v3, go to the jdplus-main page, download and unzip the compressed
folder jwsacruncher-standalone-3.x.y-windows-x86_64.zip, corresponding to
the version of your Graphical User Interface.
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R packages

JDemetra+ algorithms can be accessed in R, which is detailed here
You can directly head over to this GitHub page, then for each package indications
for installation and basic use are provided in the readme files.

Configuration needed to run rjd3 packages

To use rjd3 packages in R, you need Java 21 or higher.
You can (and should) use the version of Java that comes with the Graphical User
Interface (GUI). It is contained in the file jdemetra-standalone-3.x.y-windows-
x86_64.zip available on this page, in the “Assets” section, which you might have
to expand to be able to see all the files.
Once unzipped, the Java will be in located in C:\Software\jdemetra-standalone-
3.x.y-windows-x86_64\nbdemetra\jdk-21.0.2+13-jre (path to be adapted to your
computer/server): this location must be declared in R.
After unzipping the file:

• run this code at the beginning of your programs

Sys.setenv(JAVA_HOME = ".../jdemetra-standalone-3.x.y-windows-x86_64/nbdemetra/jdk-21.0.2+13-jre")

or

• declare it “permanently” is the Renviron file (where environment variables
specific to R are stored), following the steps below:

– in the R console run file.edit("~/.Renviron")

– in the file that opens add the line :

JAVA_HOME = "C:/Software/jdemetra-standalone-3.x.y-windows-x86_64/nbdemetra/jdk-21.0.2+13-jre"

– save the file and restart R

Follow R packages installation procedure and run basic examples from the readme
files of each package. They are all listed on this page

17

https://github.com/rjdverse?view_as=public
https://github.com/jdemetra/jdplus-main/releases
https://github.com/rjdverse?view_as=public


COSA project

The COSA (COfidentiality Seasonal Adjustment and time series) project is com-
posed of two Centres of Excellence (CoE): one on Time Series Analysis (TSA), coor-
dinated by Insee, and one on Statistical Disclosure Control (SDC) coordinated by
CBS. In a context of development of common tools and methods within the ESS,
this action will carry on the work of the STACE project (2020-2024) around three
pillars: knowledge sharing and support to practitioners, development and mainte-
nance of bespoke software (JDemetra+ for TSA, τ-ARGUS and sdcMicro for SDC)
andmethodological guidance (Handbooks, Guidelines, research papers). The over-
arching goals is to provide user friendly, efficient and technically up-to date tools
for statistical production in both fields.
In the previous project JDemetra+ has undergone a major refactoring with the
development of version 3.x providing extensions of TSA algorithms, e.g. seasonal
adjustment of high frequency data. The current action will aim at consolidating
and completing this new version, by further extending some algorithms, improving
technical and user-documentation, uploading R packages on CRAN and adapting
JDemetra+ to new IT environments, like cloud infrastructure.
Τ-ARGUS is considered to be the standard software for table protection. However,
τ-ARGUS urgently needs to be modernized. The current project will make a start
with developing/designing a modern software architecture for and apply some of
the ideas in a proof of concept. The other SDC tools as well as the “old” τ-ARGUS
needs to be supported.
Eleven institutions (Insee, CBS, NBB, Istat, INE, Destatis, SURS, HSO, Statistic Aus-
tria, Iceland and Norway) are beneficiaries from this grant and will contribute in
the aforementioned directions with the collaboration of the Deutsche Bundesbank
in TSA. Additional institutions will be involved as members of user-groups and ob-
servers (ECB, ABS, OECD…).
Results will be presented at workshops and conferences and developments can be
followed on dedicated Github repositories.
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How to use this book

JDemetra+ on-line documentation provides a step-by-step guidance on how to
use the algorithms featured in JDemetra+, highlighting all available options and
outputs. It also describes the different tools giving access to these algorithms and
provides a specific methodological background.

Structure

This book is divided in three parts, allowing the user to access the resources from
different perspectives.

• Algorithms
• Tools
• Methods
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New Features in v 3.x family

In this chapter

This chapter provides an overview of the new features in version 3.x as well as
significant modification of display or content for features already available in v
2.2.4. Compared to its predecessor, version 3.x provides:

• Additional Algorithms for Seasonal Adjustment (SA), Benchmarking and Tem-
poral Disaggregation (TD), Nowcasting, Revision Analysis

• More stand alone time series tools
• More “acceptable” frequencies in SA
• New SA (mass) production possibilities

Seasonal Adjustment and Modelling

Seasonal adjustment algorithms
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Improvements on historical algorithms

Improvements X-13-ARIMA and Tramo-Seats (historical JD+)

• New acceptable data frequencies for seasonal adjustment and modelling of
low frequency data:

- In v3.x Low frequency data: $p$ in ${2,3,4,6,12}$ is admissible in all
algorithms (historical and new)

- In version 2, only Tramo-Seats supported all these frequencies, whereas
X-13-ARIMA was restricted to $p$ in ${2,4,12}$

• outlier correction taken into account when selecting decomposition scheme
• ex-ante leap year correction added to Tramo-Seats (like in X-13)
• automatic trading day regressors selection from pre-defined sets built, ac-
cording to groups of days

• specification: split into two distinct concepts, which can be directly manipu-
lated by the user:

– reference (or domain) specification: a global set of constraints inside of
which estimation will be performed

– point (or estimation) specification: contains all parameter choices result-
ing from estimation

The user can transform a given “estimation specification” in a user defined speci-
fication.

New algorithms in v3.x

Tramo-Seats and X-13-ARIMA share a very similar and sophisticated pre-
adjustment process for the ARIMA model selection phase.
For new algorithms, the philosophy is to offer

• a simplified pre-adjustment on the ARIMA modelling side, reduced to airline
model

• several enhanced decomposition options

– stl+ (“+” stands for airline based pre-adjustment)
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– x12+: airline based pre-adjustment + new trend estimation filters (Local
Polynomials)

– seats+ (to come in the target v3 version): airline based pre-adjustment
+ AMB decomposition

SA with Basic Structural Models (BSM) available in GUI

In version 3.x, SA with Basic Structural Models is a fully integrated process with
outlier detection, calendar correction and options on external regressors.
Fundamentally it is a one-step estimation, performing pre-adjustment and decom-
position (with explicit components) in the same run
This makes regression variable selection more complicated:

• first step: a variable selection is performed with a Tramo like airline model
regression

• second: the entire structural model is estimated

In version 3.x this process is available from the graphical user interface.

SA algorithms extended for high-frequency data

All algorithms are available via an R package and will be available in GUI (in target
v 3.x version)

• Extended Airline estimation, reg-ARIMA like (rjd3highfreq and GUI )
• Extended Airline Decomposition, Seats like (rjd3highfreq and GUI )
• MX12+ (rjd3x11plus, GUI upcoming)
• MSTL+ (rjd3stl and in GUI)
• MSTS (rjd3sts, GUI upcoming)
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Algorithm Access in GUI Access in R (v2) Access in R (v3)

Modelling Algorithms

Algorithm Access in GUI Access in R (v2) Access in R (v3)
Reg-ARIMA ✔ RJDemetra rjd3x13
Tramo ✔ RJDemetra rjd3tramoseats
Extended Airline ✔ (v3 only) ✖ rjd3highfreq
STS ✔ (v3 only) rjdsts (deprecated) rjd3sts

New SA (mass) production possibilities

New R Tools for wrangling workspaces

With functions for

• changing raw data path
• customizing specifications
• merging workspaces by series names, as you would do with a data table

These functions are in rjd3providers and rjd3workspace packages, (already in a v
2.x stable precursor rjdworkspace)

Production fully in R

without a workspace structure

• TS objects and full flexibility for customizing specifications
• new R functions enabling to apply revision policies (rjd3x13::refresh and

rjd3tramoseats::refresh), with even more flexibility on data spans
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Figure 1: BSM output view in GUI
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Figure 2: BSM specification box
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Inherent shortcoming: data no readable by GUI, depriving of more sophisticated
and visual feedback (compared to R) for manual fine tuning.
Solution : new R functions to create GUI readable dynamic workspaces on the fly
(in aforementioned packages).
In the target 3.x, additional algorithms (X12+, STL+, BSM) will also be usable in
production with a workspace and cruncher (on low frequency data)

Time series general purpose tools

Version 3.x offers more stand alone tools (mainly in rjd3toolkit)

• Tests (seasonality, auto-correlation, normality, randomness…)
• (Fast) ARIMA Modelling
• Flexible Calendar regressors generation
• Auxiliary variables for pre-adjustment
• Spectral analysis (in GUI)
• Detection of multiple seasonal patterns (Canova-Hansen test)
• State space frame work as a toolbox (rjd3sts)

Canova-Hansen test to identify multiple seasonal patterns

rjd3toolkit::seasonality_canovahansen(
data = df_daily$births,
p0 = min(ch.sp),
p1 = max(ch.sp),
np = max(ch.sp) - min(ch.sp) + 1

)
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Figure 3: Canova Hansen seasonality test

Underway developments

• Moving Trading Days module integrated in all SA algorithms (for low and high
frequency data), with two implementations one based on rolling windows and
one on state space modelling

• Using Cubic Splines for smoother seasonal factors estimation of long period-
icities (𝑝 = 365, 25)
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JDemetra+ History

In this chapter

We try to cast some light at history of the project and be grateful to people who
contributed…
If you end up reading this and have elements to share (anecdotes, pictures, arti-
cles….), please don’t hesitate to write in. Consider also writing a guest blog post
here.

Articles

• a paper from Insee
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Part I

Algorithms
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This part provides practical guidance for using all the algorithms featured in JDeme-
tra+, be it with the Graphical User Interface or R packages
Further methodological insights on each algorithm can be found in the Methods
part of this book, whereas detailed description of all the available tools allowing
to access the algorithms can be found in the Tools part.
JDemetra+ provides algorithms in the following domains:
Seasonal Adjustment (SA)

• Seasonal Adjustment overview
• Pre-treatment
• SA: X11 decomposition
• SA: Seats-decomposition
• SA: Revision policies
• SA of High-Frequency Data
• SA: STL+ and MSTL+
• X12+ and MX12+
• STS and MSTS

Modelling and Auxiliary Variables

• Reg-ARIMA modelling
• Outlier detection and external regressors
• Calendar correction

And also

• Benchmarking and temporal disaggregation
• Trend-Cycle estimation
• Revision analysis
• Nowcasting
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Modelling

In this chapter

This chapter gives an overview of modelling algorithms available in JDemetra+.
Modelling features can be used stand alone or as pre-treatment (first step of sea-
sonal adjustment).
Details on modelling (specifications and output characteristics) are provided in
the pre-treatment chapter as they relate to the same procedure. High-Frequency
(infra-monthly) data is tackled here.
Additional methodological explanations are covered in this chapter and in this one
for high-frequency data.

Modelling Algorithms

Algorithm Access in GUI Access in R (v2) Access in R (v3)
Reg-ARIMA ✔ RJDemetra rjd3x13
Tramo ✔ RJDemetra rjd3tramoseats
Extended Airline ✔ (v3 only) ✖ rjd3highfreq
STS ✔ (v3 only) rjdsts (deprecated) rjd3sts

Steps to use Reg-ARIMA and Tramo in a pre-treatment context are described
here.
The possibility of saving parameters and generating output in the GUI is differ-
ent when using modelling methods directly or seasonal adjustment process as
explained here.
Extended Airline Model allows to handle infra-monthly series in a restricted reg-
ARIMA framework, more details here.
Structural time series (STS) allow another kind of modelling using state space
framework, more details here.
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Practical Reg-ARIMA modelling

For the user not needing seasonal adjustment, the sections below highlight the
functions or steps allowing to perform reg-ARIMA (or Tramo) as a stand alone goal,
outside of a seasonal adjustment process.

In R

In version 2

# Reg-ARIMA
regA_v2 <- RJDemetra::regarima_x13(raw_series, spec = "RG5c")
# Tramo
tramo_v2 <- RJDemetra::regarima_tramoseats(raw_series, spec = "TRfull")

Full documentation of RJDemetra::regarima() function can be found here
Full documentation of RJDemetra::regarima_tramoseats() function can be found
here
In version 3

# Reg-ARIMA
sa_regarima_v3 <- rjd3x13::regarima(raw_series, spec = "RG5c")

# Tramo
sa_tramo_v3 <- rjd3tramoseats::tramo(raw_series, spec = "TRfull")

Full documentation of ‘rjd3x13::regarima’ function can be found here
Full documentation of ‘rjd3tramoseats::tramo’ function can be found here

GUI

In the graphical user interface modelling algorithms can be accessed in two ways
described below. In both cases a document (.xml file) will be generated and can be
save in the workspace. The output (series, parameters and diagnostics) cannot be
exported as files, just directly copied from the interface. Further details on window
structure in GUI are available here.
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Modelling in the Workspace Window

Figure 4: The Workspace window with the nodes for the modelling proce-
dure marked

Modelling in Statistical Methods Panel

Figure 5: The RegARIMA menu item

33



Seasonal Adjustment (SA) Overview

In this chapter

This chapter is a first of a series focusing on the practical step by step use of
JDemetra+ Seasonal Adjustment (SA) algorithms, restricted to monthly and quar-
terly series. For infra-monthly data see the following chapter. In the sections below
an overview of the seasonal adjustment process is provided. Themost widely used
SA algorithms (Tramo-Seats and X-13-ARIMA) have two steps: a pre-treatment to
remove (temporarily) deterministic effects and a decomposition phase to estimate
the seasonal factors.
The following chapters get into the specifics of each algorithm.

• Pre-treatment
• SA: X11 decomposition
• SA: Seats-decomposition
• SA: Revision policies
• SA of High-Frequency Data
• SA: STL+ and MSTL+
• X12+ and MX12+
• STS and MSTS

The use of Graphical User Interface and R packages is described simultaneously
whenever relevant.
In-depth methodological explanations of the algorithms are covered in separated
chapters, in the Methods part of this book.
More information on the steps and best practices of a seasonal adjustment process
can be found in the Eurostat guidelines on seasonal adjustment
For an overview on the algorithms and methodological issues, the user can refer
to the Handbook on Seasonal Adjustment
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SA process

The goal of seasonal adjustment is to remove seasonal fluctuations from a time
series. Seasonal fluctuations are quasi-periodic infra-annual movements. They
can mask evolutions of greater interest for the user such as short term evolution
or long time trends.
When setting up the process:

• seasonality tests (can also be done in the frame of quality assessment at the
end)

• trading days correction set up if relevant

– regressors generation
– regressors selection

• estimation with selected algorithm (see section below), might be automated
with the cruncher

• quality report
• selective editing and manual fine tuning of parameters, re-estimation if
needed

• updating when new data available with tailored revision policy

Seasonal Adjustment Algorithms

Two categories of algorithms :

• historical core (main): X-13-ARIMA and Tramo-Seats improved in version 3
• version 3 additional algorithms (incubator)

35



X-13-ARIMA and Tramo-Seats are two-step algorithms with a pre-treatment phase
(Reg-ARIMA or Tramo) and a decomposition phase (X11 and Seats).
STL+ combines STL local regression based decomposition and a simplified Reg-
ARIMA pre-treatment restricted to airline models.
X12+ combines X11 (enhanced) decomposition and a simplified Reg-ARIMA pre-
treatment restricted to airline models.
Seats+ combines Seats decomposition and a simplified Reg-ARIMA pre-treatment
restricted to airline models.
In a Structural Time Series approach pre-treatment and decomposition are done
simultaneously in a State Space Framework.

Admissible data frequencies

For low frequency data - in version 3.x 𝑝 in 2, 3, 4, 6, 12 is admissible in all al-
gorithms - in version 3.x 𝑝 in 2, 3, 4, 6, 12 is admissible in Tramo-Seats and 𝑝 in
2, 4, 12 is admissible in X-13.
Algorithms extended for high-frequency (infra-monthly) data can be applied to
“any periodicity” in their R version and to 𝑝 in 7, 52.18, 365.25 in the graphical
user interface, see here for more details.

Decomposition in unobserved components

To seasonally adjust a series, seasonal factors 𝑆𝑡 will be estimated and removed
from the original raw series: 𝑌𝑠𝑎 = 𝑌𝑡/𝑆𝑡 or 𝑌𝑠𝑎 = 𝑌𝑡 − 𝑆𝑡. To do so the series
is first decomposed into unobservable components. Two decomposition models 1
are used in JDemetra+ :

• The additive model: 𝑋𝑡 = 𝑇𝑡 + 𝑆𝑡 + 𝐼𝑡;
• The multiplicative model: 𝑋𝑡 = 𝑇𝑡 × 𝑆𝑡 × 𝐼𝑡.

The main components, each representing the impact of certain types of phenom-
ena on the time series (𝑋𝑡), are:

• The trend (𝑇𝑡) that captures long-term and medium-term behaviour;

1other options as the log-additive model are also available in a more specific context described
here
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• The seasonal component (𝑆𝑡) representing intra-year fluctuations, monthly
or quarterly, that are repeated more or less regularly year after year;

• The irregular component (𝐼𝑡) combining all the other more or less erratic fluc-
tuations not covered by the previous components.

In general, the trend consists of 2 sub-components:

• The long-term evolution of the series;
• The cycle, that represents the smooth, almost periodic movement around the
long-term evolution of the series. It reveals a succession of phases of growth
and recession. Trend and cycle are not separated in SA algorithms.

Detecting seasonal patterns

A large number of seasonality tests are available in JDemetra+. They can be ac-
cessed in the graphical user interface or via R.

In R

In rjd3toolkit package:

• Canova-Hansen (seasonality.canovahansen())
• X-12 combined test (seasonality.combined())
• F-test on seasonal dummies (seasonality.f())
• Friedman Seasonality Test (seasonality.friedman())
• Kruskall-Wallis Seasonality Test (seasonality.kruskalwallis())
• Periodogram Seasonality Test (seasonality.periodogram())
• QS Seasonality Test (seasonality.qs())

Full documentation of those functions can be found here

In GUI

How to perform tests in the graphical user interface is described here.
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Direct or Indirect seasonal adjustment

when seasonally adjusting series which are aggregates following a given classifi-
cation, the user has to chose whether to directly adjust the aggregate from its raw
version or to aggregate the adjusted components.
The graphical user interface in version 2.x provides a module to compare the two
options. It won’t be provided in version 3.x.

38



SA: Pre-Treatment

In this chapter

The following sections cover pre-treatment with Reg-ARIMA (or Tramo) algorithms.
Tramo and the Reg-ARIMA part of X-13-ARIMA rely on very similar principles. Thus
Tramo will only be mentioned to highlight differences with the Reg-ARIMA part of
X-13-ARIMA.
Reg-ARIMA modelling part can be the first of a seasonal adjustment process or run
on its own. Below we focus on performing Reg-ARIMA modelling as pre-treatment
in a SA processing.
More in-depth methodological explanations of the algorithms can be found in this
part of the documentation.

Pre-treatment principles

The goal of this step is to remove deterministic effects (calendar and outliers) in
order to improve the decomposition.

𝑌𝑡 = ∑ 𝛼𝑖𝑂𝑖𝑡 + ∑𝛽𝑗𝐶𝑗𝑡 + ∑𝛾𝑖𝑅𝑒𝑔𝑖𝑡 + 𝑌𝑙𝑖𝑛,𝑡

• 𝑂𝑖𝑡 are the 𝑖 final outliers (AO, LS, TC)
• 𝐶𝑖𝑡 are the calendar regressors (automatic or user-defined), details here
• 𝑅𝑒𝑔𝑖𝑡 are all the other user-defined regressors details here

• 𝑌𝑙𝑖𝑛,𝑡 ∼ 𝐴𝑅𝐼𝑀𝐴(𝑝, 𝑑, 𝑞)(𝑃 ,𝐷, 𝑄)
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Reallocation of pre-treatment effects

The linearised series (𝑌𝑙𝑖𝑛,𝑡) is be decomposed into unobservable components in
the decomposition phase

𝑌𝑙𝑖𝑛 = 𝑆𝑙𝑖𝑛 + 𝑇𝑙𝑖𝑛 + 𝐼𝑙𝑖𝑛

Pre-treatment effects are then reallocated to build the final components

𝑆 = 𝑆𝑙𝑖𝑛 + 𝑐𝑎𝑙 + 𝑜𝑢𝑡𝑠 + 𝑟𝑒𝑔𝑠

𝑇 = 𝑇𝑙𝑖𝑛 + 𝑜𝑢𝑡𝑡 + 𝑟𝑒𝑔𝑡

𝐼 = 𝐼𝑙𝑖𝑛 + 𝑜𝑢𝑡𝑖 + 𝑟𝑒𝑔𝑖

Where

• 𝑐𝑎𝑙 is the total calendar effect
• 𝑜𝑢𝑡𝑗 is the total effect of outliers on component 𝑗
• 𝑟𝑒𝑔𝑗 is the total effect of user-defined regressors on component 𝑗

Setting Specifications

Default specifications are set for the whole SA procedure, pre-treatment and de-
composition. They are slightly different for X-13-ARIMA and Tramo-Seats and can
be modified with user-defined parameters.
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Spec
identifier

Log/level
detection

Outliers
detection

Calendar
effects ARIMA

Starting point for X-13-ARIMA

Spec
identifier

Log/level
detection

Outliers
detection

Calendar
effects ARIMA

RSA0 NA NA NA Airline(+mean)
RSA1 automatic AO/LS/TC NA Airline(+mean)
RSA2c automatic AO/LS/TC 2 TD

vars+Easter
Airline(+mean)

RSA3 automatic AO/LS/TC NA automatic
RSA4c automatic AO/LS/TC 2 TD

vars+Easter
automatic

RSA5 automatic AO/LS/TC 7 TD
vars+Easter

automatic

X-11 NA NA NA NA

explanations:

• NA: non applied, for example in RSA3 there is no calendar effect correction
• automatic: test is performed

outliers detection: AO/LS/TC type of outliers automatically detected under a critical
T-Stat value (default value=4)
calendar:

• 2 regressors: weekdays vs week-ends + LY
• 7 regressors: each week day vs Sundays + LY
• always tested
• easter tested (default length = 6 days in Tramo, 8 days in X-13-ARIMA)

Starting point for Tramo-Seats
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Spec
identifier

Log/level
detection

Outliers
detection

Calendar
effects ARIMA

RSA0 NA NA NA Airline(+mean)
RSA1 automatic AO/LS/TC NA Airline(+mean)
RSA2 automatic AO/LS/TC 2 TD

vars+Easter
Airline(+mean)

RSA3 automatic AO/LS/TC NA automatic
RSA5 automatic AO/LS/TC 6 TD

vars+Easter
automatic

RSAfull automatic AO/LS/TC automatic automatic

User-defined specifications

Principle oser setting parameters: can be done from one of the default specifica-
tions or any specification in a “Save as” mode very similar in GUI and R, as detailed
below.
The user may add new seasonal adjustment specifications to the Workspace win-
dow. To do it, go to the Seasonal adjustment section, right click on the tramoseats
or x13 item in the specifications node and select New from the local menu.

Figure 6: Creating a new specification in the Seasonal adjustment section

Next, double click on the newly created specification, change the settings accord-
ingly and confirm with the OK button.
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Figure 7: Changing settings of seasonal adjustment specification

43



Spans

Estimation span

Specifies the span (data interval) of the time series to be used in the seasonal
adjustment process. The user can restrict the span
Common settings

Option Description (expected format)
All default
From first observation included (yyyy-mm-dd)
To last observation included (yyyy-mm-dd)
Between interval [from ; to] included (yyyy-mm-dd to yyyy-mm-dd)
First number of obs from the beginning of the series included (dynamic)

(integer)
Last number of obs from the end of the series (dynamic)(integer)
Excludingexcluding N first obs and P last obs from the computation,dynamic)

(integer)
Preliminary
check

check to exclude highly problematic series e.g. the series with a
number of identical observations and/or missing values above
pre-specified threshold values. (True/False)

Setting series span in GUI
Use the specification window for a given series and expand the nodes.

Figure 8: Setting series span in R

X-13 in version 2

library("RJDemetra")
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# estimation interval: option with static dates
user_spec_1 <- x13_spec(

spec = c(
"RSA5c", "RSA0", "RSA1", "RSA2c",
"RSA3", "RSA4c", "X11"

),
preliminary.check = TRUE,
estimate.from = "2012-06-01",
estimate.to = "2019-12-01"

)

# estimation interval: option with dynamic numbers of observations

#
# spec can be applied on different series and therefore exclude different dates
user_spec_2 <- x13_spec(

spec = c("RSA5c", "RSA0", "RSA1", "RSA2c", "RSA3", "RSA4c", "X11"),
estimate.first = 12

)

# eestimation on the last 120 obs
user_spec_3 <- x13_spec(

spec = c("RSA5c", "RSA0", "RSA1", "RSA2c", "RSA3", "RSA4c", "X11"),
estimate.last = 120

)

# excluding first 24 and last 36 observations
user_spec_4 <- x13_spec(

spec = c("RSA5c", "RSA0", "RSA1", "RSA2c", "RSA3", "RSA4c", "X11"),
estimate.exclFirst = 24,
estimate.exclLast = 36

)

# Retrieve settings

For comprehensive details about x13_spec() function see RJDemetra R help
pages.
Tramo-Seats in version 2

# excluding first 24 and last 36 observations
user_spec_1 <- tramoseats_spec(
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spec = c("RSAfull", "RSA0", "RSA1", "RSA2", "RSA3", "RSA4", "RSA5"),
estimate.exclFirst = 24,
estimate.exclLast = 36

)

For comprehensive details about tramoseats_spec() function see RJDemetra R help
pages.

Setting model span

The user can also specify the span (data interval) of the time series to be used for
the estimation of the Reg-ARIMA model coefficients. It allows to impede a chosen
part of the data from influencing the regression estimates. Setting works the same
way as setting series (estimation) span described above.
Additional (vs series span setting) parameters are described below:

Tolerance Convergence tolerance for the non-linear estimation.
The absolute changes in the log-likelihood are compared to
Tolerance to check the convergence of the estimation iterations.
The default setting is 0.0000001.

Tramo specific
parameters
Exact ML When this option is marked, an exact maximum likelihood

estimation is performed.
Alternatively, the Unconditional Least Squares method is used.
However, in the current version of JDemetra+ it is not
recommended to change this parameter’s value

Unit Root
Limit

Limit for the autoregressive roots. If the inverse of a real root of
the autoregressive polynomial of the
ARIMA model is higher than this limit, the root is set equal to 1.
The default parameter value is 0.96.

Setting model span in GUI:
Use the specification window
Tramo example in version 2

# excluding first 24 and last 36 observations
user_spec_1 <- tramoseats_spec(

spec = c("RSAfull", "RSA0", "RSA1", "RSA2", "RSA3", "RSA4", "RSA5"),
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Figure 9: Setting in R

estimate.tol = 0.0000001,
estimate.eml = FALSE,
estimate.urfinal = 0.98

)

Decomposition Scheme

Parameters

Transformation test: a test is performed to choose between an additive decompo-
sition (no transformation) (link to reg A chap to detail this)
Settings
Function
transform {function=}
Transformation of data. 2 The user can choose between:
None – no transformation of the data;
Log – takes logs of the data;
Auto – the program tests for the log-level specification. This option is recom-
mended for automatic modelling of many series.
The default setting is Auto.
Reg-ARIMA specific settings
AIC difference
transform {aicdiff=}
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Defines the difference in AICC needed to accept no transformation over a log trans-
formation when the automatic transformation
selection option is invoked. The option is disabled when Function is not set to Auto.
The default AIC difference value is -2.
Adjust
transform {adjust=}
Options for proportional adjustment for the leap year effect. The option is available
when Function is set to Log. Adjust can be set to:
LeapYear – performs a leap year adjustment of monthly or quarterly data;
LengthofPeriod – performs a length-of-month adjustment on monthly data or
length-of-quarter adjustment on quarterly data;
None – does not include a correction for the length of the period.
The default setting is None
Tramo specific settings
Fct
Transformation; fct

Controls the bias in the log/level pre-test (the function is active when Function
is set to Auto); Fct > 1 favours levels, Fct < 1 favors logs. The default setting is
0.95.
Set in GUI

Figure 10: Model span setting

Set and in R
X-13

# excluding first 24 and last 36 observations
user_spec <- x13_spec(

spec = c("RSA5c", "RSA0", "RSA1", "RSA2c", "RSA3", "RSA4c", "X11"),
transform.function = "Log", # choose from: c(NA, "Auto", "None", "Log"),
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transform.adjust = "LeapYear", # c(NA, "None", "LeapYear", "LengthOfPeriod"),
transform.aicdiff = -3

)
# Retrieve settings: to complete*

Tramo-Seats settings

# transfo
user_spec_1 <- tramoseats_spec(

spec = c("RSAfull", "RSA0", "RSA1", "RSA2", "RSA3", "RSA4", "RSA5"),
transform.function = "Auto", # c(NA, "Auto", "None", "Log"),
transform.fct = 0.5

)
# Retrieve settings: to complete

Calendar correction

Some calendar correction options included in the starting specifications for X-13-
ARIMA or Tramo-Seats, they can be fine-tuned by modifying specifications. The
following section lists all the available options, illustrates how to set them in GUI
or R and shows have to retrieve used parameters, regressors as well as results.
JDemetra+ offers two default options for calendar correction working days regres-
sors and trading days regressors, with Leap-year effect if needed. Those options
don’t take into account national calendars (link) and their specific holidays. There
are two ways to change this:

• user-defined regressors (link)
• customized calendars (link)

Overview: what you can do
Need 1: correct for working days, trading days (+ easter) not taking national cal-
endars
Need 2: taking national calendar into account Solutions

• add a work of means of allocating regressors to the calendar component
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Available Options

0.0.0.0.1 * Trading Days
“Trading Days” has two meanings: general calendar correction process (here with-
out easter effect) and one of the options of this correction (see below)

- "None": no correction for trading days and working days effects

- "Default": JDemetra + built regressors (xorking days or trading days)

- "Holidays": same as above but taking into accoutn a national calendar, available on ly in GUI, R interface requires direct use of pre-built regressors

- "UserDefined": user-defined trading days regressors (see below)

- (if NONE) indicating the day of the month when inventories and other stock are reported (to denote the last day of the month, set the variable to 31).

0.0.0.0.2 * Leap Year effect
Autoadjust
If enabled, the program corrects automatically for the leap year effect.. When is
the option available Modifications of this variable are taken into account only when
transform.function is set to “Auto”.
Leapyear
to specify whether or not to include the leap-year effect in the model: - “LeapYear”:
leap year effect; - “LengthOfPeriod”: length of period, - “None” = no effect in-
cluded.
The leap-year effect can be pre-specified in themodel only if the input series hasn’t
been pre-adjusted (transform.adjust set to “None”) and if the automatic correction
for the leap-year effect isn’t selected (tradingdays.autoadjust set to FALSE).

Test

Test: defines the pre-tests for the significance of the trading day regression vari-
ables based on the AICC statistics: “Add” = the trading day variables are not
included in the initial regression model but can be added to the Reg-ARIMA model
after the test; “Remove” = the trading day variables belong to the initial regres-
sion model but can be removed from the Reg-ARIMA model after the test; “None”
= the trading day variables are not pre-tested and are included in the model.
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0.0.0.0.1 * Easter
Easter.enabled a logical. If TRUE, the program considers the Easter effect in the
model.
easter.Julian a logical. If TRUE, the program uses the Julian Easter (expressed in
Gregorian calendar).
easter.duration a numeric indicating the duration of the Easter effect (length in
days, between 1 and 20).
easter.test defines the pre-tests for the significance of the Easter effect based
on the t-statistic (the Easter effect is considered as significant if the t-statistic
is greater than 1.96): “Add” = the Easter effect variable is not included in the
initial regression model but can be added to the Reg-ARIMA model after the test;
“Remove” = the Easter effect variable belongs to the initial regression model but
can be removed from the Reg-ARIMA model after the test; “None” = the Easter
effect variable is not pre-tested and is included in the model.
A user-defined regressor can also be used, see chapter on calendar correction
(to be added: additional options in Tramo)

Setting Calendar correction in GUI

0.0.0.0.1 * Using default options (without national calendars)
In GUI Use the specification window
Calendar effects

Figure 11: STEP 1: Selection from JDemetra+ Default…or User_defined
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Figure 12: STEP2: Calendar effects minus Easter are labeled trading days

0.0.0.0.2 * Holidays option
using a customized calendar just show how to fetch it building process in calendar
chapter
Missing: stock td option, length-of-period
User-defined regressors: adding see below
Link to Import data Once data imported: here explain how to link variables

0.0.0.0.3 * Easter

Setting Calendar correction in R

In version 2

# Parameter choice NA=...
tradingdays.option <- c(NA_character_, "TradingDays", "WorkingDays", "UserDefined", "None")
tradingdays.autoadjust <- NA
tradingdays.leapyear <- c(NA_character_, "LeapYear", "LengthOfPeriod", "None")
tradingdays.stocktd <- NA_integer_
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Figure 13: The list of calendars displayed under Holidays option corre-
sponds to the calendars defined in the Workspace window

Figure 14: easter Options
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tradingdays.test <- c(NA_character_, "Remove", "Add", "None")
easter.enabled <- NA
easter.julian <- NA
easter.duration <- NA_integer_
easter.test <- c(NA_character_, "Add", "Remove", "None")
# example

In version 3 (Under construction)

User defined regressors

If User Defined options is used for trading days, regressors have to be provided
by the user.
Building Regressors The underlying methodology and implementation in JDeme-
tra+ to build these regression variables are provided here

0.0.0.0.1 * Adding Regressors in GUI
Step 1: import data set containing the regressors, general procedure explained
here
Step 2: Link the regressors to the workspace, procedure detailed here
Step 3: Modify specifications Modifications are done the same way in a global
specification (whole SAP) or series by series.

• select trading days User-defined option and select variables

In the specification window, click right from “userVariables” on “Unused” to open
the variable selection window

Move right the chosen regressors
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• set TEST option (expl)
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0.0.0.0.2 * Adding Regressors in R
“UserDefined” = user-defined trading days regressors (regressors must be de-
fined by the usrdef.var argument with usrdef.varType set to “Calendar” and us-
rdef.varEnabled = TRUE).

# example
spec_4 <- x13_spec(

spec = spec_1,
tradingdays.option = "UserDefined",
tradingdays.test = "None",
usrdef.varEnabled = TRUE,
usrdef.varType = "Calendar",
usrdef.var = reg3

) # set of regressors in TS format

Retrieving Results

The following section details how to retrieve results (parameters, regressors, re-
gression coefficients and tests) when using GUI or R interface.
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0.0.0.0.1 * Parameters
Parameters are regressors used in fine. If non test options, parameters are known
If test options are selected by the algorithm.
In GUI
Automatically chosen or user-defined calendar options (as well as other pre-
adjustment options) are displayed at the top of the MAIN Results NODE displayed
by clicking on a given series name in the SAProcessing panel.

In R
(to be added)
version 2: RJDemetra
version 3: rjd3x13 or rjd3tramoseats

0.0.0.0.2 * Regressors
In GUI All regressors in the pre-adjustment phase (calendar, outliers, external) are
displayed in the pre-processing-regressors node.

In R
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(to be added)
Version 2
version 3

0.0.0.0.3 * Regression results
Regressions results
In GUI
The results of the whole Reg-ARIMA regression (link to last section) including cal-
endar effects (below) are displayed in the pre-processing panel.

In R

0.0.0.0.4 * Test for residual trading-days effects
Residual calendar effects are tested with A F-Test 7 regressors and no national
calendar, on sa final series and on irregular component (link to calendar chapter
for test details)
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In GUI
F-Test results are displayed at the bottom of Main Results NODE in the SAPro-
cessing panel

Figure 15: F-Test results in GUI

In R

Customizing Calendars

The following describes how to take a national calendar into account.
Solution 1: if working with GUI build a new calendar in GUI (here
(to be added: GUI: how to use it or customize HTML file structure explanation)
set this option in GUI
(to be added: image: spec window calendar / holidays / choice of calendars)
set this option in R (to be added) version 2:
version 3:
solution 2: import external regressors, which can be built with rjd3toolkit (link)
which can then be used in via are or imported via GUI
set this option in GUI how to import variables into JD+ / set utility (in interface
chapter) classical user defined
set this option in R version 2:
version 3
Once the calendar regressors are set, the Reg-ARIMA (Tramo) model will be es-
timated globally with all the other regression variables and taking into account
ARIMA model specificities as well. That is why diagnostics are all jointly displayed
at the end of the process. (link)
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(to be added: worked example: french calendar in R)

Outliers

The sections below focus on

• outlier detection parameters (type and critical value)
• pre-specifying outliers in a seasonal adjustement (Reg-ARIMA modelling) pro-
cess

Additional information can be found in this chapter.

Options for automatic detection

• Is enabled
outliers; iatip

Enables/disables the automatic detection of outliers in the span determined
by the Detection span option. By default, the checkbox is marked, which
implies that the automatic identification of outliers is enabled.

• Use default critical value
outliers; va

The critical value is automatically determined by the number of observations
in the interval specified by the Detection span option. When Use default
critical value is disabled, the procedure uses the critical value inputted in
the Critical value item (see below). Otherwise, the default value is used
(the first case corresponds to “critical = xxx”; the second corresponds to a
specification without the critical argument). It should be noted that it is not
possible to define a separate critical value for each outlier type. By default,
the checkbox is marked, which implies that the automatic determination of
the critical value is enabled.

• Critical value
outliers; va

The critical value used in the outlier detection procedure. The option is active
once Use default critical value is disabled. By default, it is set to 3.5.

60



• Detection span $→$ type
outliers; int1, int2*

A span of the time series to be searched for outliers. The possible values of
the parameter are:

– All – full time series span is considered in the modelling;
– From – date of the first time series observation included in the pre-
processing model;

– To – date of the last time series observation included in the pre-
processing model;

– Between – date of the first and the last time series observations included
in the pre-processing model;

– Last – number of observations from the end of the time series included
in the pre-processing model;

– First – number of observations from the beginning of the time series in-
cluded in the pre-processing model;

– Excluding – number of observations excluded from the beginning (spec-
ified in the first field) and/or end of the time series (specified in the last
field) of the pre-processing model.

With the options Last, First, Excluding the span can be computed dynamically
on the series. The default setting is All.

• Additive
outliers; aio*

Automatic identification of additive outliers. By default, this option is enabled.

• Level shift
outliers; aio*

Automatic identification of level shifts. By default, this option is enabled.
• Transitory change
outliers; aio*

Automatic identification of transitory changes. By default, this option is en-
abled.

• Seasonal outlier
outliers; aio*

Automatic identification of seasonal outliers. By default, this option is dis-
abled. Tramo specific
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• EML estimation
outliers; imvx

The estimation method used in the automatic model identification procedure.
By default, the fast method of Hannan-Rissanen is used for parameter esti-
mation in the intermediate steps of the automatic detection and correction
of outliers. When the checkbox is marked the exact maximum likelihood es-
timation method is used.

• TC rate
outliers; deltatc

The rate of decay for the transitory change outlier. It takes values between 0
and 1. The default value is 0.7.

Options for pre-specified outliers

User-defined outliers are used when prior knowledge suggests that certain effects
exist at known time points[^14]. Four pre-defined outlier types, which are simple
forms of intervention variables, are implemented: * Additive Outlier (AO); * Level
shift (LS); * Temporary change[^15] (TC); * Seasonal outliers (SO).

Setting in GUI

Pre-specified :

• Click on …
• Click on +
• Fill the outlier’s information
• Click on Ok

To change the view to set the outliers, got to Tools –> Options
Then to Demetra –> Pre-specified Outliers –> Calendar-like Grid –> Ok
Then you have the calendar view (when selecting the pre-specified outliers) :

Setting in R

(to be added)
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Figure 16: Automatic detection of outliers in GUI
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Figure 17: Outliers types in GUI
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Figure 18: Pre-specified outliers in GUI
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Figure 19: Options in GUI

Retrieving results

0.0.0.0.1 * Parameters
In GUI
In main results NODE (same info at top of pre-processing NODE)

0.0.0.0.2 * Regressors
In GUI
In R
(to be added)

0.0.0.0.3 * Regression details
In GUI
In R
(to be added)
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Figure 20: Change view to calendar
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Figure 21: **Calendar view in GUI
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Figure 22: Main results in GUI

Figure 23: Regressors in GUI

Figure 24: Regression details in GUI
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User-defined regressors

(to be added)

• rationale
• parameters: assign to a component

Pre-treatment regression with additional outliers

𝑌𝑡 = ∑ ̂𝛼𝑖𝑂𝑖𝑡 + ∑ ̂𝛽𝑗𝐶𝑗𝑡 + ∑ ̂𝛾𝑘𝑅𝑒𝑔𝑘𝑡 + 𝑦𝑙𝑖𝑛𝑡

0.0.0.0.1 * Allocation to components
𝑟𝑒𝑔 = 𝑟𝑒𝑔𝑖 + 𝑟𝑒𝑔𝑡 + 𝑟𝑒𝑔𝑠 + ... The user-defined regression variable associated
to a specific component should not contain effects that have to be associated
with another component. Therefore, the following rules should be observed: *
The variable assigned to the trend or to the seasonally adjusted series should not
contain a seasonal pattern; * The variable assigned to the seasonal should not
contain a trend (or level); * The variable assigned to the irregular should contain
neither a seasonal pattern nor a trend (or level). - no external regressors can be
assigned to calendar component. It has to be be done via user defined calendar
regressors specific part (link)
Ramps and intervention variables are Specific cases of external regressors

Setting in GUI

User-defined variables
Step 1: import data set containing the regressors, general procedure explained
here
Step 2: Link the regressors to the workspace, procedure detailed here
Step 3: Modify specifications via window
Modifications are done the same way in a global specification (whole SAP) or series
by series.

Setting in R

(to be added)
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Figure 25: Creation of user-defined variables in GUI
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Special case 1: Ramp effects

A ramp effect means a linear increase or decrease in the level of the series over a
specified time interval 𝑡0 to 𝑡1. All dates of the ramps must occur within the time
series span. (tested: not true). Ramps can overlap other ramps, additive outliers
and level shifts.

0.0.0.0.0.1 * Creation in GUI

0.0.0.0.0.2 * Allocation to components
allocation when intervention or ramps ? in test allocated to trend ? (reg)
impossible (?) to create several intervention variables

Special case 2: Intervention variables

Intervention variables are modeled as any possible sequence of ones and zeros,
on which some operators may be applied. They are built as combinations of the
following basic structures:

• Dummy variables [^17];
• Any possible sequence of ones and zeros;
• 1

(1−𝛿𝐵) ,
• (0 < 𝛿 ≤ 1)
• 1

(1−𝛿𝑠𝐵𝑠) ,
• (0 < 𝛿𝑠 ≤ 1);
• 1

(1−𝐵)(1−𝐵𝑠) ;

where 𝐵 is backshift operator (i.e. 𝐵𝑘𝑋𝑡 = 𝑋𝑡−𝑘) and 𝑠 is frequency of the time
series (𝑠 = 12 for a monthly time series, 𝑠 = 4 for a quarterly time series).
These basic structures enable the generation of not only AO, LS, TC, SO and RP
outliers but also sophisticated intervention variables that are well-adjusted to the
particular case.

0.0.0.0.0.1 * Creation in GUI
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Figure 26: Creation of ramp variable in GUI
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Figure 27: Step 1
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Figure 28: Step 2

Figure 29: Step 3
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0.0.0.0.0.2 * Creation in R
(to be added)

0.0.0.0.0.3 * Allocation to components
allocation (to be added)
fixed coefficient options

• Fixed regression coefficients
regression variables; –

For the pre-specified regression variables this option specifies the parameter
estimates that will be held fixed at the values provided by the user. To fix a
coefficient the user should undertake the following actions:

– Choose the transformation (log or none).
– Define some regression variables in the Regressors specification.
– Push on the fixed regression coefficients editor button in the User-
defined variables row.

– Select the regression variable from the list for which the coefficient will
be fixed.

– Save the new setting with the Done button.

Retrieving Results

For all types of external regressors: user-defined, ramps or intervention vari-
ables.

0.0.0.0.1 * Regressors
In GUI
To retrieve regressors that were actually used, expand pre-processing NODE and
click on Regressors pane.
In R
(to be added )
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Figure 30: Regressors in GUI

0.0.0.0.2 * Regression details
In GUI
Regression details are in the pre-processing pane.

Figure 31: Regression details

IN R
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ARIMA Model

Key specifications on ARIMA modelling are embedded in default specifications: air-
line (default model) or full automatic research.(links)
Two kinds of interventions are available to the user

• modify automatic detection parameters
• set a user defined ARIMA model

In both cases forecast horizon can also be set (link)

Options for modifying automatic detection

automdl.enabled If TRUE, the automatic modelling of the ARIMA model is enabled.
(If FALSE, the parameters of the ARIMA model can be specified, see below)
Control variables for the automatic modelling of the ARIMA model (when au-
tomdl.enabled is set to TRUE):
automdl.acceptdefault a logical. If TRUE, the default model (ARIMA(0,1,1)(0,1,1))
may be chosen in the first step of the automatic model identification. If the Ljung-
Box Q statistics for the residuals is acceptable, the default model is accepted and
no further attempt will be made to identify another model.
automdl.cancel the cancellation limit (numeric). If the difference in moduli of an
AR and an MA roots (when estimating ARIMA(1,0,1)(1,0,1) models in the second
step of the automatic identification of the differencing orders) is smaller than the
cancellation limit, the two roots are assumed equal and cancel out.
automdl.ub1 the first unit root limit (numeric). It is the threshold value for the
initial unit root test in the automatic differencing procedure. When one of the
roots in the estimation of the ARIMA(2,0,0)(1,0,0) plus mean model, performed in
the first step of the automatic model identification procedure, is larger than the
first unit root limit in modulus, it is set equal to unity.
automdl.ub2 the second unit root limit (numeric). When one of the roots in the
estimation of the ARIMA(1,0,1)(1,0,1) plus mean model, which is performed in the
second step of the automatic model identification procedure, is larger than sec-
ond unit root limit in modulus, it is checked if there is a common factor in the
corresponding AR and MA polynomials of the ARMA model that can be cancelled
(see automdl.cancel). If there is no cancellation, the AR root is set equal to unity
(i.e. the differencing order changes).
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automdl.mixed a logical. This variable controls whether ARIMA models with non-
seasonal AR and MA terms or seasonal AR and MA terms will be considered in
the automatic model identification procedure. If FALSE, a model with AR and MA
terms in both the seasonal and non-seasonal parts of the model can be accept-
able, provided there are no AR or MA terms in either the seasonal or non-seasonal
terms.
automdl.balanced a logical. If TRUE, the automatic model identification procedure
will have a preference for balanced models (i.e. models for which the order of the
combined AR and differencing operator is equal to the order of the combined MA
operator).
automdl.armalimit the ARMA limit (numeric). It is the threshold value for t-
statistics of ARMA coefficients and constant term used for the final test of model
parsimony. If the highest order ARMA coefficient has a t-value smaller than this
value in magnitude, the order of the model is reduced. If the constant term
t-value is smaller than the ARMA limit in magnitude, it is removed from the set of
regressors.
automdl.reducecv numeric, ReduceCV. The percentage by which the outlier’s crit-
ical value will be reduced when an identified model is found to have a Ljung-Box
statistic with an unacceptable confidence coefficient. The parameter should be
between 0 and 1, and will only be active when automatic outlier identification is
enabled. The reduced critical value will be set to (1-ReduceCV)*CV, where CV is
the original critical value.
automdl.ljungboxlimit the Ljung Box limit (numeric). Acceptance criterion for the
confidence intervals of the Ljung-Box Q statistic. If the LjungBox Q statistics for
the residuals of a final model is greater than the Ljung Box limit, then the model is
rejected, the outlier critical value is reduced and model and outlier identification
(if specified) is redone with a reduced value.
automdl.ubfinal numeric, final unit root limit. The threshold value for the final unit
root test. If the magnitude of an AR root for the final model is smaller than the
final unit root limit, then a unit root is assumed, the order of the AR polynomial
is reduced by one and the appropriate order of the differencing (non-seasonal,
seasonal) is increased. The parameter value should be greater than one.
(for both options) fcst.horizon the forecasting horizon (numeric). The forecast
length generated by the Reg-ARIMA model in periods (positive values) or years
(negative values). By default, the program generates a two-year forecast
(fcst.horizon set to -2). Defaults different in GUI and R.

79



Figure 32: Setting in GUI in v2
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0.0.0.1 v2

0.0.0.2 v3

Figure 33: Setting in GUI in v3

Forecast horizon when using Tramo-Seats Is set in the decomposition part of the
specification in GUI.
Setting in R (first template, then worked example) X-13-ARIMA template in ver-
sion 2

spec_2 <- x13_spec(
spec = spec_1,
automdl.enabled = NA,
automdl.acceptdefault = NA,
automdl.cancel = NA_integer_,
automdl.ub1 = NA_integer_,
automdl.ub2 = NA_integer_,
automdl.mixed = NA,
automdl.balanced = NA,
automdl.armalimit = NA_integer_,
automdl.reducecv = NA_integer_,
automdl.ljungboxlimit = NA_integer_,
automdl.ubfinal = NA_integer_
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Figure 34: Setting in GUI in v2

Figure 35: Setting in GUI in v3
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Figure 36: Forecast horizon when using Tramo-Seats

Figure 37: Forecast horizon when using X-13-ARIMA
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)

add worked example in version 2
in version 3
add worked example in version 3

Options for setting a user-defined ARIMA model

Control variables for the non-automatic modelling of the ARIMA model (when au-
tomdl.enabled is set to FALSE):
arima.mu logical. If TRUE, the mean is considered as part of the ARIMA model.
arima.p numeric. The order of the non-seasonal autoregressive (AR) polynomial.
arima.d numeric. The regular differencing order.
arima.q numeric. The order of the non-seasonal moving average (MA) polyno-
mial.
arima.bp numeric. The order of the seasonal autoregressive (AR) polynomial.
arima.bd numeric. The seasonal differencing order.
arima.bq numeric. The order of the seasonal moving average (MA) polynomial.
Control variables for the user-defined ARMA coefficients. Coefficients can be de-
fined for the regular and seasonal autoregressive (AR) polynomials and moving
average (MA) polynomials. The model considers the coefficients only if the pro-
cedure for their estimation (arima.coefType) is provided, and the number of pro-
vided coefficients matches the sum of (regular and seasonal) AR and MA orders
(p,q,bp,bq).
arima.coefEnabled logical. If TRUE, the program uses the user-defined ARMA co-
efficients.
arima.coef a vector providing the coefficients for the regular and seasonal AR and
MA polynomials. The vector lengthmust be equal to the sum of the regular and sea-
sonal AR and MA orders. The coefficients shall be provided in the following order:
regular AR (Phi; p elements), regular MA (Theta; q elements), seasonal AR (BPhi;
bp elements) and seasonal MA (BTheta; bq elements). E.g.: arima.coef=c(0.6,0.7)
with arima.p=1, arima.q=0,arima.bp=1 and arima.bq=0.
arima.coefType a vector defining the ARMA coefficients estimation procedure. Pos-
sible procedures are: “Undefined” = no use of any user-defined input (i.e. coeffi-
cients are estimated), “Fixed” = the coefficients are fixed at the value provided by
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the user, “Initial” = the value defined by the user is used as the initial condition.
For orders for which the coefficients shall not be defined, the arima.coef can be
set to NA or 0, or the arima.coefType can be set to “Undefined”. E.g.: arima.coef
= c(-0.8,-0.6,NA), arima.coefType = c(“Fixed”,“Fixed”,“Undefined”).
Setting in GUI

Figure 38: Manual ARIMA modelling

Setting in R
X-13-ARIMA template in version 2

spec_2 <- x13_spec(
spec = spec_1,
automdl.enabled = FALSE,
arima.mu = NA,
arima.p = NA_integer_,
arima.d = NA_integer_,
arima.q = NA_integer_,
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Figure 39: Fixing coefficients

arima.bp = NA_integer_,
arima.bd = NA_integer_,
arima.bq = NA_integer_,
arima.coefEnabled = NA,
arima.coef = NA,
arima.coefType = NA,
fcst.horizon = NA_integer_

)

in version 3

Reg-ARIMA model Results and Diagnostics

Type of results (including Tramo addenda)

• all regressors used (shown above)
• regression details: explanatory variables (above)
• ARIMA model specific results
• additional diagnostics on residuals
• likelihood
• seasonality tests on residuals
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Display in GUI

Reg-ARIMA model detail with other regression results in pre-processing pane. with
number of observations.. parameters

Figure 40: Final model

More details in Pre-processing/ARIMA Node
In residual Node
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Figure 41: ARIMA details

Figure 42: Residuals
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Figure 43: Residuals

Figure 44: Residuals
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Figure 45: Residuals

Figure 46: Residuals

90



Figure 47: Residuals

Figure 48: Distribution
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Figure 49: Likelihood
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Seasonality tests on residuals in the Diagnostics NODE
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Figure 50: Residuals
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SA: X11 Decomposition

In this chapter

This chapter focuses on practical implementation of an X11 decomposition using
the graphical user interface GUI and R using R packages in version 2.x and 3.x.
More explanations on X11 algorithm can be found here.
In recent years X11 has been tailored in JDemetra+ to handle high-frequency (infra-
monthly) data, which is described here with more methodological details here.
The sections below will describe

• specifications needed to run X11
• generated output
• series
• diagnostics
• final parameters
• user-defined parameters

Context of use

X11 algorithm is generally the second (decomposition) step in a seasonal ad-
justment processing with X-13-ARIMA, once a pre-treatment phase has been
performed. In this case X11 will decompose the linearized series using iteratively
different moving averages. The effects of pre-treatment will be reallocated at the
end the the relevant components. X11 can also be used without pre-treatment,
choosing and will decompose the raw series.
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Tools for X11 decomposition

Algorithm
Access in GUI (v2
and v3) Access in R (v2) Access in R (v3)

X-13-ARIMA ✔ RJDemetra rjd3x13
X12plus v3 only ——- rjd3x11plus
X11 decomposition
only

✔ RJDemetra rjd3x13

Available frequencies in version 2 and version 3

Version GUI and R
v 2.x 𝑝 = 12, 4, 2
v 3.x 𝑝 = 12, 6, 4, 3, 2

Default specifications

The default specifications for X11 must be chosen at the start of the SA process-
ing, one of the options available there is to run a X11 decomposition without pre-
treatment.
They are detailed in the chapter on pre-treatment.

Quick Launch

From GUI

With a workspace open, an SAProcessing created and an open data provider: (link
to GUI general process)

• choose a default specification
• drop your data and press green arrow
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In R

In version 2 using

RJDemetra

library("RJDemetra")
# the input series has to be a Time Series (TS) object
# specification RSA5c including pre-treatment
model_sa_v2 <- x13(raw_series, spec = "RSA5c")
# specification X11 without pre-treatment
model_sa_v2 <- x13(raw_series, spec = "X11")

Full documentation of ‘RJDemetra::x13’ function can be found here
The model_sa_v2 R object (list of lists) contains all parameters and results. Its
structure is detailed here. It can be printed giving access to selected parameters,
series and diagnostics.

print(model_sa_v2)

In version 3 using rjd3x13

library("rjd3toolkit")
library("rjd3x13")
# the input series has to be a Time Series (TS) object
model_sa_v3 <- rjd3x13::x13(y_raw, spec = "RSA5")

Full documentation of ‘rjd3x13::x13’ function can be found here and of
‘rjd3x13::X11’ here.
The model_sa_v3 R object (list of lists) contains all parameters and results. Its
structure is detailed here.
It can be printed giving access to selected parameters, series and diagnostics.

print(model_sa_v3)

97

https://rjdverse.github.io/rjdemetra/
https://rjdverse.github.io/rjdemetra/reference/x13.html
https://rjdverse.github.io/rjd3x13/
https://rjdverse.github.io/rjd3x13/reference/x13.html
https://rjdverse.github.io/rjd3x13/reference/x11.html


Retrieve series

All series used as an input or generated by X11 are stored into Tables A, B, C, D
(and D final in v3) and E.
Detailed series names are described here in the Methods part.

Display in GUI

Final components from the SA Processing are displayed in node Main results >
Table. They contain the re-allocated effects of outliers or external regressors. The
final seasonal component contains the calendar effects, if any.

Figure 51: Final components in GUI

(forecasts are added at the end of the series, values in italic)
Detailed results from decomposition are displayed in Decomposition (X11) node.
In version 3

• D-Table contains the final components stemming from the decomposition of
the linearized series (B1 or ylin in Pre-processing > Pre-adjustment series
node )

• D-Final-Table contains the final components including pre-adjustment effects
(equal to the series contained in node Main results > Table )

In version 2:

• In D-table series D10, D10a, D11, D11a, D12, D12a, D13 are the final com-
ponents including pre-adjustment effects (equal to the series contained in in
node Main results > Table )
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Figure 52: Detailed results

Output series can be exported out of GUI by two means:

• generating output files directly with interactive menus
• running the cruncher to generate those files as described here

Retrieve in R

In version 2

model_sa <- x13(raw_series, spec = "RSA3") # user's spec choice
# final components
model_sa$final$series
# final forecasts y_f sa_f s_f t_f i_f
model_sa$final$forecasts

Detailed X11 tables have to be pre-specified from the user-defined output list.

# display the list of available objects (series, diagnostics, parameters)
user_defined_variables("X-13-ARIMA")
# add selected object to estimation
sa_x13_v2 <- RJDemetra::x13(myseries, myspec,

userdefined = c("decomposition.c20", "decomposition.d1")
)
# retrieve in the user-defined sub-list
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sa_x13_v2$user_defined

In version 3

# final components
model_sa$final$series
# final forecasts y_f sa_f s_f t_f i_f
model_sa$final$forecasts
# from user defined output

Diagnostics

X11 produces the following type diagnostics or quality measures

SI-ratios

Display in GUI

NODE Main Results > SI-Ratios

Figure 53: S-I Ratio

For each period (month, quarter) the final value of the seasonal factors (without
calendar factors, Table D10) is plotted (blue line). The dots represent 𝑆 + 𝐼 or
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𝑆 ∗ 𝐼 in the multiplicative case (Series D8). The red straight line is the average of
the factors over the decomposition (estimation) span.
In GUI all values cannot be retrieved.

Retrieve in R

All the values and the same plot as described above can be generated in R, the
span can be customized.
In version 2

# data frame with values
model_sa_v2$decomposition$si_ratio

# customizable plot
plot(mysa2$decomposition)

plot(model_sa, type = "cal-seas-irr", first_date = c(2015, 1))

In version 3

# data frame with values
model_sa_v2$decomposition$si_ratio

# customizable plot
plot(mysa2$decomposition)

plot(model_sa, type = "cal-seas-irr", first_date = c(2015, 1))

M-statistics

X11 algorithm provides quality measures of the decomposition called “M statistics”
(detailed here

• 11 statistics (M1 to M11)
• 2 summary indicators (Q et Q-M2)
• by design 0 < 𝑀𝑥 < 3 and acceptance region is 𝑀𝑥 ≤ 1

101



0.0.0.0.1 * Display in GUI
To display results in GUI, expand NODE
Decomposition(X11) > Quality Measures > Summary
Results displayed in red indicate that the test failed.

Figure 54: Summary of the quality measures

0.0.0.0.2 * Retrieve in R
In version 2

# this code snippet is not self-sufficient
model_sa$decomposition$mstats

In version 3

# this code snippet is not self-sufficient
model_sa$decomposition$mstats

Detailed Quality measures

In GUI all the diagnostics below can be displayed expanding the NODE
Decomposition(X11) > Quality Measures > Details
They are detailed in the X11 method chapter
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Retrieve final filters

The following parameters are automatically chosen by the software as a result of
the estimation process. They have no default value but can be set by the user.

• Final trend filter: length of Henderson filter applied for final trend estima-
tion (in the second part of the D step).

• Final seasonal filer: length of final seasonal filter for seasonal component
estimation (in the second part of the D step).

Display in GUI

Node Decomposition(X11) > Final Filters

Figure 55: Table of final filters

Retrieve in R

In version 2

library("RJDemetra")
model_sa_v2 <- x13(raw_seriesa, spec = "RSA5c")
model_sa$decomposition$s_filter
model_sa$decomposition$t_filter

In version 3
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library("rjd3toolkit")
library("rjd3x13")
model_sa_v3 <- rjd3x13::x13(y_raw, spec = "RSA5")
model_sa_v3$result$decomposition$final_seasonal
model_sa_v3$result$decomposition$final_henderson

User-defined parameters

The following parameters have default values, which will not be changed in the
estimation process. They can be set by the user in a given range of admissible
values.

General settings

• Mode

- Undefined: automatically chosen between Multiplicative and Additive Options available only if no pre-processing:
- Additive: $Y=T+S+I$, $SA =Y-S=T+I$
- Multiplicative $Y=T*S*I$, $SA =Y/S=T*I$
- LogAdditive $Log(Y) = T + S + I$, $SA=exp(T+I)=Y/exp(S)$
- PseudoAdditive $Y=T*(S+I-1)$, $SA=T*I$

If X11 decomposition comes after a pre-processing,mode is set to undefined and
will correspond to decomposition choice made in the pre-treatment: multiplicative
if series log- transformed, additive otherwise.

• Seasonal component

Option available only if no pre-processing: - yes (default), decomposition into 𝑆,
𝑇 , 𝐼 - no, decomposition into 𝑆, 𝑇 , 𝐼
• Forecasts horizon

Length of the forecasts generated by the Reg-ARIMA model - in months (positive
values) - years (negative values) - if set to is set to 0, the X11 procedure does not
use any model-based forecasts but the original X11 type forecasts for one year. -
default value: -1, thus one year from the ARIMA model

• Backcasts horizon

Length of the backcasts generated by the Reg-ARIMA model - in months (positive
values) - years (negative values) - default value: 0
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0.0.0.0.1 * Irregular correction

• LSigma

– sets lower sigma (standard deviation) limit used to down-weight the ex-
treme irregular values in the internal seasonal adjustment iterations

– values in [0, 𝑈𝑠𝑖𝑔𝑚𝑎]
– default value is 1.5

• USigma

– sets upper sigma (standard deviation)
– values in [𝐿𝑠𝑖𝑔𝑚𝑎,+∞]
– default value is 2.5

• Calendarsigma

Allows to set different LSigma and USigma for each period - None (default) -
All: standard errors used for the extreme values detection and adjustment com-
puted separately for each calendar month/quarter - Signif: groups determined by
Cochran test (check) - Sigmavec: set two customized groups of periods

• Excludeforecasts

– ticked: forecasts and backcasts from the Reg-ARIMA model not used in
Irregular Correction

– unticked (default): forecasts and backcasts used

0.0.0.0.2 * Seasonality extraction filters choice

• Seasonal filter

Specifies which filters will be used to estimate the seasonal factors for the entire
series.

• default value: MSR Moving seasonality ratio, automatic choice of final sea-
sonal filter, initial filters are 3 × 3

• choices: 3 × 1, 3 × 3, 3 × 5, 3 × 9, 3 × 15 or Stable
• “Stable”: constant factor for each calendar period (simple moving average of
a all 𝑆 + 𝐼 values for each period)

User choices will be applied to final phase D step.
The seasonal filters can be selected for the entire series, or for a particular month
or quarter.

105



• Details on seasonal filters

Sets different seasonal filters by period in order to account for seasonal het-
eroskedasticity

• default value: empty, same filter for all periods

0.0.0.0.3 * Trend estimation filters

• Automatic Henderson filter or user-defined

– default: length 13
– unticked: user-defined length choice

• Henderson filter length choice

– values: odd number in [3, 101]
– default value: 13

Check: will user choice be applied to all steps or only to final phase D step

Parameter setting in GUI

All the parameters above can be set with in the specification box

Figure 56: Text

Setting details on seasonal filters
Previously set values are displayed for each type of period, here they are all to
default MSR choice.
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Figure 57: Seasonnal filters

Click on the right top button (show on image)
Another window appears in the top-left corner allowing to chose the filter period
by period.

Parameter setting in R packages

In version 2 using RJDemetra

current_sa_model <- x13(raw_series, spec = current_spec)
# Creating a modified specification, customizing all available X11 parameters
modified_spec <- x13_spec(current_sa_model,

X11.mode = NA,
X11.seasonalComp = NA,
X11.fcasts = -2,
X11.bcasts = -1,
X11.lsigma = 1.2,
X11.usigma = 2.8,
X11.calendarSigma = NA,
X11.sigmaVector = NA,
X11.excludeFcasts = NA,
# filters
X11.trendAuto = NA,
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Figure 58: Text

X11.trendma = 23,
X11.seasonalma = "S3X9"

)

# New SA estimation: apply modified_spec
modified_sa_model <- x13(raw_series, modified_spec)

In version 3 using rjd3x13

# Creating a modified specification, customizing all available X11 parameters
library("RJDemetra")
model_sa_v2 <- x13(raw_series, spec = "RSA5c")
# Creating a modified specification from the current estimation model
# Customizing all available X11 parameters
modified_spec <- x13_spec(model_sa_v2,

X11.fcasts = -2,
X11.bcasts = -1,
X11.lsigma = 1.2,
X11.usigma = 2.8,
X11.calendarSigma = NA,
X11.sigmaVector = NA,
X11.excludeFcasts = NA,
# filters
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X11.trendAuto = NA,
X11.trendma = 23,
X11.seasonalma = "S3X9"

)

# New SA estimation: apply modified_spec

modified_sa_model <- x13(raw_series, modified_spec)

# For options available only in X11 mode
modified_spec <- x13_spec(model_sa_v2,

# X11.mode="?",
# X11.seasonalComp = "?",
X11.fcasts = -2

)

Retrieving Parameters

How to see what parameters have actually been used.
In GUI: just open the specification box and navigate the options.
In R, print your model or navigate its elements.
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SA: Seats Decomposition

In this chapter

This chapter focuses on practical implementation of a Seats decomposition using
the graphical user interface GUI and R using R packages in version 2.x and 3.x.
More explanations on Seats algorithm can be found here.
In recent years Seats has been tailored in JDemetra+ to handle high-frequency
(infra-monthly) data, which is described here with more methodological details
here.
The sections below will describe

• specifications needed to run Seats
• generated output
• series
• diagnostics
• final parameters
• user-defined parameters

Context

Seats is the second (decomposition) step in a seasonal adjustment processing
with Tramo-Seats, once a pre-treatment with Tramo has been performed. Seats is
an ARIMA Model Based (AMB) algorithm and will decompose the linearized series
using the ARIMA model fit in Tramo.

Tools for Seats decomposition
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Algorithm Access in GUI Access in R (v2) Access in R v3
Tramo-Seats ✔ RJDemetra rjd3tramoseats
Tramo only ✔ RJDemetra rjd3tramoseats

Available frequencies in version 2 and version 3

Version GUI and R
v 2.x 𝑝 = 12, 6, 4, 2
v 3.x 𝑝 = 12, 6, 4, 3, 2

Seats Decomposition

Seats algorithm will decompose the linearized series, in level or in logarithm, using
the ARIMA model fitted by Tramo in the pre-treatment phase. {#a-sa-seats-q-
start}

Quick Launch

Default specifications

The default specifications for Seats must be chosen at the starting of the SA pro-
cessing. Starting point for Tramo-Seats, detailed here

Using GUI

With a workspace open, an SAProcessing created and open data provider:

• choose a default specification (link)
• drop your data and press green arrow (link)
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In R

In version 2 using RJDemetra

library("RJDemetra")
# the input series has to be a Time Series (TS) object
# specification RSAfull including pre-treatment
model_sa_v2 <- tramoseats(raw_series, spec = "RSAfull")

Full documentation of ‘RJDemetra::tramoseats’ function can be found here
The model_sa_v2 R object (list of lists) contains all parameters and results. Its
structure is detailed here. It can be printed giving access to selected parameters,
series and diagnostics.

print(model_sa_v2)

In version 3 using rjd3tramoseats

library("rjd3tramoseats")
model_sa_v3 <- tramoseats(raw_series, spec = "RSAfull")
# the input series has to be a Time Series (TS) object

Full documentation of ‘rjd3tramoseats::tramoseats’ function can be found here.
The model_sa_v3 R object (list of lists) contains all parameters and results. Its
structure is detailed here.
It can be printed giving access to selected parameters, series and diagnostics.

print(model_sa_v3)

Retrieve Series

This section outlines how to retrieve the different kinds of output series from GUI
or in R.

• final components (including reallocation of pre-adjustment effects)
• components in level
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• components in level or log

Stochastic series

Decomposition of the linearized series or of its logarithm (in case of amultiplicative
model)
y_lin is split into components: t_lin, s_lin, i_lin
suffixes: - _f stands for forecast - _e stands for - _ef stands for

Display in GUI

NODE Decomposition>Stochastic series - Table with series and its standard error
image

• Plot of Trend with confidence interval image
• Plot of Seasonal component with confidence interval image

Retrieve from GUI

Generating output from GUI (link) or from Cruncher (link), stochastic series, their
standard errors, forecasts and forecasts errors can be accessed with the following
names

Series Name Meaning
decomposition.y_lin
decomposition.y_lin_f
decomposition.y_lin_ef
decomposition.t_lin
decomposition.t_lin_f
decomposition.t_lin_e
decomposition.t_lin_f
decomposition.sa_lin
decomposition.sa_lin_f
decomposition.sa_lin_e
decomposition.sa_lin_ef
decomposition.s_lin
decomposition.s_lin_f
decomposition.s_lin_e
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Series Name Meaning
decomposition.s_lin_ef
decomposition.i_lin
decomposition.i_lin_f
decomposition.i_lin_e
decomposition.i_lin_ef

Retrieve in R

In version 2

library("RJDemetra")
# list of additional output objects
user_defined_variables("Tramo-Seats")
# specify additional objects in estimation
m <- tramoseats(

series = y,
spec = "RSAfull",
userdefined = c(

"decomposition.y_lin", "ycal",
"variancedecomposition.seasonality"

)
)
# retrieve objects
m$user_defined$decomposition.y_lin
m$user_defined$ycal
m$user_defined$variancedecomposition.seasonality

In version 3

library("rjd3tramoseats")
# list of additional output objects
userdefined_variables_tramoseats("tramoseats")
# specify additional objects in estimation
m <- tramoseats(

ts = y,
spec = "RSAfull",
userdefined = c(

"decomposition.y_lin", "ycal",
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"variancedecomposition.seasonality"
)

)
# retrieve objects
m$user_defined$decomposition.y_lin
m$user_defined$ycal
m$user_defined$variancedecomposition.seasonality

Components (Level)

Decomposition of the linearized series, back to level in case of a multiplicative
model.
y_lin is split into components: t_lin, s_lin, i_lin
suffixes: - _f stands for forecast - _e stands for - _ef stands for

Displayed in GUI

NODE Decomposition>Components - Table with series and its standard error im-
age

Retrieve from GUI

Generating output from GUI (link) or from Cruncher (link), component series, their
standard errors, forecasts and forecasts errors can be accessed with the following
names

Series Name Meaning
decomposition.y_cmp
decomposition.y_cmp_f
decomposition.y_cmp_ef
decomposition.t_cmp
decomposition.t_cmp_f
decomposition.t_cmp_e
decomposition.t_cmp_f
decomposition.sa_cmp
decomposition.sa_cmp_f
decomposition.sa_cmp_e
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Series Name Meaning
decomposition.sa_cmp_ef
decomposition.s_cmp
decomposition.s_cmp_f
decomposition.s_cmp_e
decomposition.s_cmp_ef
decomposition.i_cmp
decomposition.i_cmp_f
decomposition.i_cmp_e
decomposition.i_cmp_ef

Retrieve in R

Same procedure as for stochastic series.

Bias correction

to be added

Final series

Series
Final Seats
components Final Results

Reallocation of
pre-adjustment
effects

Raw series
(forecasts)

y (y_f)

Linearized series none
Final seasonal
component

s (s_f)

Final trend t (t_f)
Final irregular i (i_f)
Calendar
component
Seasonal without
calendar

(to be added: reallocation of outliers effects)
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Display in GUI

Final results are displayed for each series in the NODE MAIN>Table

Figure 59: Table of final results

Forecasts are glued at the end it italic

Retrieve from GUI

Generating output from GUI (link) or from Cruncher (link), component series, their
standard errors, forecasts and forecasts errors can be accessed with the following
names

Series Name Meaning
y
y_f
t
t_f
sa
sa_f
s
s_f
i
i_f

Retrieve in R

In version 2
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library("RJDemetra")
sa_model <- RJDemetra::tramoseats(y, "RSAfull")
sa_model$final$series
sa_model$final$forecasts
# for additional results call user-defined output as explained above

In version 3

library("rjd3tramoseats")
sa_model <- tramoseats(y, spec = "RSAfull")
# final series can be accessed here
sa$result$final$sa
# for additional results call user-defined output as explained above

Retrieve Diagnostics

• WK analysis

components final estimators

• Error analysis autocorrelation of the errors (sa, trend) revisions of the errors
• Growth rates
• Model based tests
• Significant seasonality
• Stationary variance decomposition

Retrieve Final Parameters

Relevant if parameters not setmanually, or any parameters automatically selected
by the software without having a fixed default value. (The rest of the parameters
is set in the specification) To manually set those parameters and see all the fixed
default values see Specifications / parameters section
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ARIMA Models for components

Display in GUI

Click on the Decomposition NODE

Figure 60: Decomposition Node

Retrieve from GUI

(add names for output and cruncher)

Display in R

(display or retrieve)
version 2
version 3
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Other final parameters

Final parameters which can be fine-tuned be the user are described in User-defined
specifications section below

Setting user-defined parameters

The section below explains how the user can fine-tune some Seats parameters,
which are put in context in the corresponding method chapter.the default value is
indicated in ().

• Prediction length

Forecast span used in the decomposition default: one year (-1) (years are set in
negative values, positive values indicate number of periods)

• Approximation Mode

Modification type for inadmissible models None (default) Legacy Noisy

• MA unit root boundary

Modulus threshold for resetteing MA “near-unit” roots [0,1] default (0.95)

• Trend Boundary Modulus threshold for assigning positive real AR Roots [0,1]
default (0.5)

• Seasonal Tolerance Degree threshold for assigning complex AR roots [0,10]
default (2)

• Seasonal Boundary (unique) Modulus threshold for assigning negative real
AR roots [0,1] default (0.8)

• Seasonal Boundary (unique) Same modulus threshold unique seasonal AR
roots [0,1] default (0.8)

• Method

Algorithm used for estimation of unobserved components
Burman (default)
KalmanSmoother
McEllroyMatrix
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Seting parameters in GUI

In specification window corresponding to a given series:

Figure 61: TramoSeatsSpec Seats part

Set in R

version 2 (RJDemetra)

tramoseats_spec(
spec = c("RSAfull", "RSA0", "RSA1", "RSA2", "RSA3", "RSA4", "RSA5"),
fcst.horizon = NA_integer_,
seats.predictionLength = NA_integer_,
seats.approx = c(NA_character_, "None", "Legacy", "Noisy"),
seats.trendBoundary = NA_integer_,
seats.seasdBoundary = NA_integer_,
seats.seasdBoundary1 = NA_integer_,
seats.seasTol = NA_integer_,
seats.maBoundary = NA_integer_,
seats.method = c(NA_character_, "Burman", "KalmanSmoother", "McElroyMatrix")

)

121



in version 3 with {rjd3tramoseats} (to be added)
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SA: Revision policies

In this chapter

The sections below describe:

• how to update seasonally adjusted series when new data is available
• what is a revision policy in a seasonal adjustment context
• the description of all the revision policies available in JDemetra+
• how to implement a revision policy using the Graphical User Interface, R or
the Cruncher.

Revision Policies

Definition and context

When raw data has been modified (extended and/or revised), the previous sea-
sonal adjustment estimation needs updating. It can be redone from scratch (com-
plete re-estimation) or update keeping fixed a predefined set of parameters al-
ready estimated. Eurostat’s Guidelines on seasonal adjustment (2015) recom-
mend not to perform a complete re-estimation of the parameters on an infra-
annual basis. The set of constraints on the parameters is called “revision policy”
or “refresh policy”.

Overview

In X-13-ARIMA and Tramo-Seats revision policies are ways to impose constraints
on the pre-adjustment phase, while the decomposition phase (X-11 or Seats) will
be entirely re-run on new data. The changes induced by X-11 re-estimation stem
only from a revised linerarized series, while in Seats they are also induced by the
ARIMA model possible coefficient and/ or order changes.
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The table below lists the available policies as well as their name for implementation
with the graphical user interface (GUI), the cruncher or rjd3x13 ans rjd3tramoseats
packages.

Implementation in GUI

To refresh results from previous estimation open your workspace, then SAprocess-
ing click on a series to highlight it (or select several series), then right-click and
choose Refresh, the following panel is displayed.
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Display in results panel

Sections below detail, though an example, the changes in results display brought
about by the use of a given revision policy.

Concurrent

Concurrent adjustment means that the model, filters, outliers, regression param-
eters and transformation type are all re-identified and the respective parameters
and factors re-estimated every time new observations are available. This option
in JDemetra+ means that a completely new model is identified, and the previous
results are not taken into account, excepted for the user-defined parameters.
The picture below presents the initial model (on the left) and the results of the
refreshment procedure with the Concurrent adjustment option (on the right). The
transformation type has changed from none to log. The ARIMA model has been
re-identified (it has changed from (0,1,1)(1,1,0) to (1,1,0)(0,1,1)). In contrast to
the initial model, in the updated model trading day effects and a leap year effect
are no longer included. Also the automatically identified outliers are not the same
in both models.
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Partial concurrent adjustment → Fixed model

The Partial concurrent adjustment → Fixed model strategy means that the ARIMA
model, outliers and other regression parameters are not re-identified and the val-
ues of the parameters are fixed. In particular, no new outliers or calendar variables
are added to the model as well as no changes neither in the calendar variables nor
in the outliers’ types are allowed. The transformation type remains unchanged.
The picture below presents the initial model (on the left) and the results of the
refreshment procedure with the Partial concurrent adjustment → Fixed model op-
tion (on the right). The parameters of the ARIMA part are not estimated and their
values are the same as before. The trading days and outliers are fixed too and no
new regression effects are identified.

127



Partial concurrent adjustment → Estimate regression coefficients

The Partial current adjustment → Estimate regression coefficients option means
that the ARIMA model, outliers and other regression parameters are not re-
identified. The coefficients of the ARIMA model are fixed, other coefficients are
re-estimated. In particular, no new outliers or calendar variables are added to the
model as well as no changes neither in the calendar variables nor in the outliers’
types are allowed. The transformation type remains unchanged.
The picture below presents the initial model (on the left) and the results of the
refreshment procedure with the Partial concurrent adjustment → Estimate regres-
sion coefficients option (on the right). The number of estimated parameters is
16 in the initial model and 14 in the revised model (the parameters of the ARIMA
model are not estimated.
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The Partial concurrent adjustment→ Estimate regression coefficients re-
vision policy results
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Partial concurrent adjustment → Estimate regression coefficients + ARIMA parameters

The Partial concurrent adjustment → Estimate regression coefficients + ARIMA pa-
rameters strategy means that the ARIMA model, outliers and other regression pa-
rameters are not re-identified. All parameters of the Reg-ARIMA model are re-
estimated but the explanatory variables remain the same. The transformation
type remains unchanged.
The picture below presents the initial model (on the left) and the results of the
refreshment procedure with the Partial concurrent adjustment → Estimate regres-
sion coefficient + ARIMA parameters option (on the right). The parameters of the
ARIMA part have been re-estimated and their values have been updated. Also
regression coefficients have been re-estimated and the number of estimated coef-
ficients in the revised model is the same as in the initial model (i.e. 16 estimated
coefficients). The structure of the model remains unchanged while all coefficients
have been updated.

130



Partial concurrent adjustment → Estimate regression coefficients + outliers

The Partial concurrent adjustment → Estimate regression coefficients + outliers op-
tion means that the ARIMA model and regression parameters, except outliers, are
not re-identified. The parameters of these variables, however, are re-estimated.
All outliers are re-identified, i.e. the previous outcome of the outlier detection pro-
cedure is not taken into account and all outliers are identified and estimated once
again. The transformation type remains unchanged.
The picture below presents the initial model (on the left) and the results of the
refreshment procedure with the Partial concurrent adjustment → Estimate regres-
sion coefficients + outliers option (on the right). The parameters of the ARIMA part
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have been re-estimated and their values have been updated. Also regression co-
efficients for the calendar variables have been re-estimated. In the revised model
there is no Prespecified outliers section. Instead, the outliers were re-identified.
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Partial concurrent adjustment → Estimate regression coefficients + ARIMA model

The Partial concurrent adjustment → Estimate regression coefficients + ARIMA
model option means that the ARIMA model, outliers and regression variables (ex-
cept the calendar variables) are re-identified. All parameters are re-estimated.
The transformation type remains unchanged.
The picture below presents the initial model (on the left) and the results of the
refreshment procedure with the Partial concurrent adjustment → Estimate regres-
sion coefficients + ARIMA model option (on the right). The ARIMA part has been
re-identified (a change from (2,1,0)(0,1,1) to (0,1,1)(1,1,1)). Also the regression
coefficients for the calendar variables have been re-estimated. In the revised
model there is no Prespecified outliers section. Therefore, the outliers were re-
identified.
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Partial concurrent adjustment → Estimate regression coefficients + Last outliers

The Partial concurrent adjustment → Estimate regression coefficients + Last out-
liers strategy means that the ARIMA model, outliers (except for the last year of the
sample) and other regression parameters are not re-identified. All parameters of
the Reg-ARIMA model are re-estimated. The software tests for outliers in the last
year of the data span and will include in the model those which are statistically
significant. The transformation type remains unchanged.
The picture below presents the initial model (on the left) and the results of the
refreshment procedure with the Partial concurrent adjustment → Estimate regres-
sion coefficients + Last outliers option (on the right). The parameters of the ARIMA
part have been re-estimated and their values have been updated. Also the regres-
sion coefficients have been re-estimated. The number of estimated coefficients
in the revised model is larger than the initial model because an additional outlier
has been identified in the last year of the data span.
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Implementation with the cruncher

In a production process, it might be suitable to use the cruncher in order to
automatically update workspaces. When using an R package (rjwsacruncher``
orJDCruncheR‘) to do so, you will just need to specify the policy’s name as shown
below. Available policies and names are detailed in the #Overview section.

cruncher_and_param(
workspace = "D:/my_folder/my_ws.xml",
rename_multi_documents = FALSE,
policy = "stochastic", # name of the revision policy
log = my_log_file.txt

)

Implementation in R

Implementing refresh policies is a new v3.x feature. Two options are available

• using rjd3x13 or rjd3tramoseats directly on TS objects in R
• refreshing a workspace with rjd3workspace

When performing seasonal adjustment directly in R with rjd3x13 or rjd3tramoseats,
you will need to refresh the “result_spec” yielded by the previous estimation with
the selected policy.
Available policies and names are detailed in here.
More explanations and full documentation of

• rjd3x13::x13_refresh function can be found here
• rjd3tramoseats::tramoseats_refresh function can be found here
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SA of high-frequency data

In this chapter

The sections below provide guidance on seasonal adjustment of infra-monthly, or
high-frequency (HF), time-series data with JDemetra+ tailored algorithms.
Currently available topics:

• description of HF data specificities
• R functions for pre-treatment, extended X-11 and extended Seats

Up coming content:

• Graphical User Interface 3.x functionalities for HF data
• STL functions
• State space framework

Data specificities

HF data often display multiple seasonal patterns with potentially non-integer pe-
riodicities which cannot be modeled with classical SA algorithms. JD+ provides
tailored versions of these algorithms.

Table 15: Periodicities (number of observations per cycle)

Data Day Week Month Quarter Year
quarterly 4
monthly 3 12
weekly 4.3481 13.0443 52.1775
daily 7 30.4368 91.3106 365.2425
hourly 24 168 730.485 2191.4550 8765.82
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Tailored algorithms in JDemetra+

Col1 Algorithm GUI v 3.x R package
Pre-treatment Extended Airline Model ✔ rjd3highfreq
Decomposition Extended Seats Extended Airline

Model
✔ rjd3highfreq

Extended X-11 ✔ rjd3x11plus
Extended STL ✖ rjd3stl

One-Step SSF Framework ✖ rjd3sts

SA algorithms extended for high-frequency data

All algorithms are available via an R package and will be available in GUI (in target
v 3.x version)

• Extended Airline estimation, reg-ARIMA like (rjd3highfreq and GUI )
• Extended Airline Decomposition, Seats like (rjd3highfreq and GUI )
• MX12+ (rjd3x11plus, GUI upcoming)
• MSTL+ (rjd3stl and in GUI)
• MSTS (rjd3sts, GUI upcoming)

Data frequencies and seasonal patterns

In the Graphical User Interface (display constraints)
Input data: daily, weekly
Seasonal patterns: weekly (𝑝 = 7) or yearly (𝑝 = 365.25 or 𝑝 = 52.18 )
In corresponding R packages:

• no constraint on data input as no TS structure (numeric vector)
• any seasonal patters, positive numbers
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Unobserved Components

Raw series decomposition

Figure 62: Decomposition diagram

Multiple seasonal patterns

HF data often contain multiple seasonal patterns. For example, daily economic
time series often display strong infra-weekly and infra-yearly seasonality. An infra-
monthly seasonal pattern may also be present, but its strength is usually less pro-
nounced in practice. In theory, the full decomposition of the seasonal component
in daily data is given by:

𝑆𝑡 = 𝑆𝑡,7 ∘ 𝑆𝑡,30.44 ∘ 𝑆𝑡,365.25

The decomposition is done iteratively periodicity by periodicity starting with the
smallest one (highest frequency) as:

• highest frequencies usually display the biggest and most stable variations
• cycles of highest frequencies can mix up with lower ones
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Identifying seasonal patterns

JDemetra+ provides the Canova-Hansen test in the rjd3toolkit package.

Pre-adjustment

In classical X-13-ARIMA and Tramo-Seats, a pre-adjustment step is performed to
remove deterministic effects, such as outliers and calendar effects, with a Reg-
ARIMA model. In the extended version for HF data, it is also the case with an
extended Airline model.
A general Reg-ARIMA model is written as follows:

(𝑌𝑡 − ∑𝛼𝑖𝑋𝑖𝑡) ∼ 𝐴𝑅𝐼𝑀𝐴(𝑝, 𝑑, 𝑞)(𝑃 , 𝐷, 𝑄)

These models contain seasonal backshift operators𝐵𝑠(𝑦𝑡) = 𝑦𝑡−𝑠. Here 𝑠 can be
non-integer. JDemetra+ will rely on a modified version of a frequently used ARIMA
model: the “Airline” model:

(1 − 𝐵)(1 − 𝐵𝑠)𝑦𝑡 = (1 − 𝜃1𝐵)(1 − 𝜃2𝐵𝑠)𝜖𝑡 𝜖𝑡 ∼ NID(0, 𝜎2
𝜖 )

For HF data, the potentially non-integer periodicity 𝑠 will be written: 𝑠 = 𝑠′ + 𝛼,
with 𝛼 ∈ [0, 1) (for example 52.18 = 52+0.18 is the yearly periodicity for weekly
data)
Taylor series development around 1 of 𝑓(𝑥) = 𝑥𝛼

𝑥𝛼 = 1 + 𝛼(𝑥 − 1) + 𝛼(𝛼+1)
2! (𝑥 − 1)2 + 𝛼(𝛼+1)(𝛼+2)

3! (𝑥 − 1)3 + ⋯
𝐵𝛼 ≅ (1 − 𝛼) + 𝛼𝐵

Approximation of 𝐵𝑠+𝛼 in an extended Airline model

𝐵𝑠+𝛼 ≅ (1 − 𝛼)𝐵𝑠 + 𝛼𝐵𝑠+1

Example for a daily series displaying infra-weekly (𝑝1 = 7) and infra-yearly (𝑝2 =
365.25) seasonality:
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(1−𝐵)(1−𝐵7)(1−𝐵365.25)(𝑌𝑡−∑ 𝛼𝑖𝑋𝑖𝑡) = (1−𝜃1𝐵)(1−𝜃2𝐵7)(1−𝜃3𝐵365.25)𝜖𝑡

𝜖𝑡
𝑖𝑖𝑑∼ N(0, 𝜎2

𝜖 )
with

1 − 𝐵365.25 = 1 − (0.75𝐵365 + 0.25𝐵366)

Calendar correction

Calendar regressors can be defined with the rjd3toolkit package and added to pre-
treatment function as a matrix.

# Create a calendar with rjd3toolkit
# Define a national calendar
frenchCalendar <- national_calendar(days = list(

fixed_day(7, 14), # Bastille Day
fixed_day(5, 8, validity = list(start = "1982-05-08")), # Victory Day
special_day("NEWYEAR"),
special_day("CHRISTMAS"),
special_day("MAYDAY"),
special_day("EASTERMONDAY"),
special_day("ASCENSION"),
special_day("WHITMONDAY"),
special_day("ASSUMPTION"),
special_day("ALLSAINTSDAY"),
special_day("ARMISTICE")

))
# Generrate calendar regressors
q <- holidays(

calendar = frenchCalendar,
start = "1968-01-01",
length = length(df_daily$births),
type = "All",
nonworking = 7L

)

# Argument type = All : taking all holidays into account
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# Argument type = Skip : taking into account only the holidays falling on a week day

Outliers and intervention variables

Outliers detection is available in the pre-treatment function. Detected outliers are
AO, LS and WO. Critical value can be computed by the algorithm or user-defined.

Linearization

Example using rjd3highfreq::fractionalAirlineEstimation function:

pre_adjustment <- rjd3highfreq::fractionalAirlineEstimation(y_raw,
x = q, # q = daily calendar regressors
periods = c(7, 365.25),
ndiff = 2, ar = FALSE, mean = FALSE,
outliers = c("ao", "ls", "wo"),
criticalValue = 0, # computed in the algorithm
precision = 1e-9, approximateHessian = TRUE

)

“pre_adjustment” R object is a list of lists in which the user can retrieve input series,
parameters and output series. For more details see chapter on R packages and
rjd3highfreq help pages R, where all parameters are listed.

Decomposition

Extended X-11

X-11 is the decomposition module of X-13-ARIMA, the linearized series from the
pre-adjustment step is split into seasonal (𝑆), trend (𝑇 ) and irregular (𝐼) com-
ponents. In case of multiple periodicities the decomposition is done periodicity
by periodicity starting with the smallest one. Global structure of the iterations
is the same as in “classical” X-11 but modifications were introduced for tackling
non-integer periodicities. They rely on the Taylor approximation for the seasonal
backshift operator:

𝐵𝑠+𝛼 ≅ (1 − 𝛼)𝐵𝑠 + 𝛼𝐵𝑠+1
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Modification of the first trend filter for removing seasonality

The first trend estimation is thanks to a generalization of the centred and symmet-
rical moving averages with an order equal to the periodicity 𝑝.
• filter length 𝑙: smallest odd integer greater than 𝑝
• examples: 𝑝 = 7 → 𝑙 = 7, 𝑝 = 12 → 𝑙 = 13, 𝑝 = 365.25 → 𝑙 = 367,

𝑝 = 52.18 → 𝑙 = 53
• central coefficients 1/𝑝 (1/12,1/7, 1/365.25)
• end-point coefficients 𝕀{𝐸(𝑝) even} + (𝑝 − 𝐸(𝑝))/2𝑝
• example for 𝑝 = 12: (1/12 and 1/24) (we fall back on𝑀2×12 of the monthly
case

• example for 𝑝 = 365.25: (1/365.25 and 0.25/(2 ∗ 365.25))

Modification of seasonality extraction filters

Computation is done on a given period
Example 𝑀3×3

𝑀3×3𝑋 = 1
9(𝑋𝑡−2𝑝) + 2

9(𝑋𝑡−𝑝) + 3
9(𝑋𝑡) + 2

9(𝑋𝑡+𝑝) + 1
9(𝑋𝑡+2𝑝)

if 𝑝 integer: no changes needed
if 𝑝 non-integer: Taylor approximation of the backshift operator

Modification of final trend estimation filter

As seasonality has been removed in the first step, there is no non-integer periodic-
ity issue in the final trend estimation, but extended X-11 offers additional features
vs classic X-11, in which final trend is estimated with Henderson filters and Mus-
grave asymmetrical surrogates. In extended X-11, a generalization of this method
with local polynomial approximation is available.
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Example of decomposition

Here the raw series is daily and displays two periodicities 𝑝 = 7 and 𝑝 = 365.25
# extraction of day-of-the-week pattern (dow)
x11.dow <- rjd3x11plus::x11plus(y_linearized,

period = 7, # DOW pattern
mul = TRUE,
trend.horizon = 9, # 1/2 Filter length : not too long vs p
trend.degree = 3, # Polynomial degree
trend.kernel = "Henderson", # Kernel function
trend.asymmetric = "CutAndNormalize", # Truncation method
seas.s0 = "S3X9", seas.s1 = "S3X9", # Seasonal filters
extreme.lsig = 1.5, extreme.usig = 2.5

) # Sigma-limits

# extraction of day-of-the-week pattern (doy)
x11.doy <- rjd3x11plus::x11plus(x11.dow$decomposition$sa, # previous sa

period = 365.2425, # DOY pattern
mul = TRUE,
trend.horizon = 371, # 1/2 final filter length
trend.degree = 3,
trend.kernel = "Henderson",
trend.asymmetric = "CutAndNormalize",
seas.s0 = "S3X15", seas.s1 = "S3X5",
extreme.lsig = 1.5, extreme.usig = 2.5

)

ARIMA Model Based (AMB) Decomposition (Extended Seats)

Example

# extracting DOY pattern
amb.doy <- rjd3highfreq::fractionalAirlineDecomposition(

amb.dow$decomposition$sa, # DOW-adjusted linearised data
period = 365.2425, # DOY pattern
sn = FALSE, # Signal (SA)-noise decomposition
stde = FALSE, # Calculate standard deviations
nbcasts = 0, nfcasts = 0

) # Numbers of back- and forecasts
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Summary of the process

For the time being, seasonal adjustment processing in rjd3highfreq cannot be en-
compassed by one function like for lower frequency, e.g rjd3x13::x13(y_raw)
The user has to run the steps one by one, here is an example with 𝑝 = 7 and
𝑝 = 365.25
• computation of the linearized series 𝑌𝑙𝑖𝑛 = 𝐸𝑥𝑡𝑒𝑛𝑑𝑒𝑑𝐴𝑖𝑟𝑙𝑖𝑛𝑒(𝑌 )
• computation of the calendar corrected series 𝑌𝑐𝑎𝑙
• computation of 𝑆7 by decomposition of the linearized series
• computation of 𝑆365.25 by decomposition of the seasonally adjusted series
with 𝑝 = 7

• finally adjusted series 𝑠𝑎𝑓𝑖𝑛𝑎𝑙 = 𝑌𝑐𝑎𝑙/𝑆7/𝑆365.25 (if multiplicative model)

STL decomposition

Not currently available. Under construction.

State Space framework

Not currently available. Under construction.

Quality assessment

Residual seasonality

JDemetra+ provides the Canova-Hansen test in rjd3toolkit package which allows
to check for any remaining seasonal pattern in the final SA data.
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SA: X12+ and MX12+

In this chapter

Additional SA algorithms available only in v3.x.

• X12+: Airline based pre-adjustment and extended X11 decomposition
• MX12+: Extended Airline Estimation and Extended X11 Decomposition

Up coming content.
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SA: STL+ and MSTL+

STL is a Loess (Weighted local regression) based decomposition algorithm used on
linearized data, no integrated pre-adjustment.

In this Chapter

We will cover how to use classic STL JDemetra+. M-STL functions for tackling multi-
ple periodicities (with rounded frequencies) in infra-monthly data will be described
in the high-frequency data related chapter.
More methodological details will be provided here

Tools for access

In JDemetra+ STL is only available through rjd3stl package.
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SA: STS and MSTS

Basic Structural models (BSM) allow to decompose a time series with explicit mod-
els for its components (𝑆,𝑇 ,𝐼) while running pre-treatment in one single step. It
also allows to integrate time varying trading-day correction.

In this Chapter

We will cover how to perform seasonal adjustment using BSM in JDemetra+.
How to tackle multiple periodicities (with rounded frequencies) in infra-monthly
data will be described in the high-frequency data related chapter.
More methodological details will be provided here

Tools for access

In JDemetra+ Basic Structural Models are only available through rjd3sts pack-
age.
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Outlier detection and external regressors

In this chapter

The following sections describe

• how to generate useful external regressors for improving seasonal adjust-
ment or Reg-ARIMA modelling

• JDemetra+ solutions for outlier detection and in a time series.

These routines can be used stand alone or as part of a seasonal adjustment pro-
cess. They can be accessed via the Graphical User Interface (GUI) or R pack-
ages((#t-r-packs).
How to use the generated regressors, or any user-defined variable, in a seasonal
adjustment or Reg-ARIMA modelling process is discussed in the pre-treatment
chapter for classic SA and SA of High-frequency chapter for infra-monthly data.
There you will also find out how to fix the corresponding coefficients and how to
allocate the effects to the selected component.
The external regressors described exclude calendar correction which is detailed
here

Generating external regressors

Outliers

Types

The following outliers are available for automatic detection
ADD: - specifics for HF data (wo outiler)
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Figure 63: Outliers type

Figure 64: Seasonal outlier
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Pre-specifying outliers

Outliers are well-defined types of auxiliary variables, therefore when they are used
(Reg-ARIMA or Tramo modelling) they don’t need to be explicitly generated before-
hand. Pre-specifying outliers is detailed in chapters on pre-treatment in SA and SA
of High-frequency data.

Generating regressors for outliers

Nevertheless, explicit regressors corresponding to outliers can be generated with
rjd3toolkit functions for independent use. Further details rjd3toolkit help pages.

library("rjd3toolkit")

# Outliers in February 2002, for monthly data
ao <- ao_variable(frequency = 12, c(2000, 1), length = 12 * 4, date = "2002-02-01")
ls <- ls_variable(12, c(2000, 1), length = 12 * 4, date = "2002-02-01")
tc <- tc_variable(12, c(2000, 1), length = 12 * 4, date = "2002-02-01")
so <- so_variable(12, c(2000, 1), length = 12 * 4, date = "2002-02-01")

Ramps

A ramp effect means a linear increase or decrease in the level of the series over a
specified time interval 𝑡0 to 𝑡1. Ramps can overlap other ramps, additive outliers
and level shifts. In seasonal adjustment their effected will be allocated to the
trend.
Adding ramps to a seasonal adjustment (or Reg-ARIMA / Tramo) specification hap-
pens in one step in GUI as well as in R, where ramp regressors can nevertheless
be independently generated.

Adding ramps in GUI

In the specification window
The effect of the ramps is stored in reg_t pre-adjustment series.
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Figure 65: Add ramp in GUI

154



Adding ramps in R

Use the function add_ramp

# create a specification from a default specification
init_spec <- rjd3x13::spec_x13("RSA5c")

# add ramp on year 2012
new_spec <- rjd3toolkit::add_ramp(init_spec, start = "2012-01-01", end = "2012-12-01")

Generating ramp regressors in R

Use ramp_variable function in rjd3toolkit:

?ramp_variable
# Ramp variable from January 2001 to September 2001 for a monthly series
rp <- ramp_variable(frequency = 12, c(2000, 1), length = 12 * 4, range = c(13, 21))
# Or equivalently
rp <- ramp_variable(12, c(2000, 1), length = 12 * 4, range = c("2001-01-01", "2001-09-02"))
plot.ts(rp)

More details rjd3toolkit pages.

Intervention variables

Intervention variables are modelled as any possible sequence of ones and zeros,
on which differencing (regular and seasonal) can be applied.
Adding intervention variables to a seasonal adjustment (or Reg-ARIMA / Tramo)
specification happens in one step when using the GUI, whereas two steps are re-
quired in R: generating the regressors and the adding them as an user-defined
variable.

Adding intervention variables in GUI

step 1:
Step 2:
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Generating intervention variables in R

Using intervention_variable function in rjd3toolkit

library("rjd3toolkit")
?intervention_variable
iv <- intervention_variable(

frequency = 12, start = c(2000, 1), length = 60,
starts = "2001-01-01", ends = "2001-12-01"

)
iv
plot(iv)

iv <- intervention_variable(12, c(2000, 1), 60,
starts = "2001-01-01", ends = "2001-12-01", delta = 1

)
iv
plot(iv)

iv <- intervention_variable(12, c(2000, 1), 60,
starts = "2001-01-01", ends = "2001-12-01",
delta = 0, seasonaldelta = 1

)
iv
plot(iv)

More details rjd3toolkit help pages.

Adding intervention variables in R

Intervention variables can be added to a specification like any other external re-
gressor using the add_usrdefvar. They also need to be declared in a “context”
using the modelling_context function.

# creating one or several external regressors (TS objects),
# which will be gathered in one or several groups
iv1 <- intervention_variable(12, c(2000, 1), 60,

starts = "2001-01-01", ends = "2001-12-01"
)
iv2 <- intervention_variable(12, c(2000, 1), 60,

starts = "2001-01-01", ends = "2001-12-01", delta = 1
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)
# regressors as a list of two groups (lists) reg1 and reg2
vars <- list(reg1 = list(iv1 = iv1), reg2 = list(iv2 = iv2))
# to use those regressors, input : name=reg1.iv1 and name=reg2.iv2 in add_usrdefvar function
# creating the modelling context
my_context <- modelling_context(variables = vars)
# customize a default specification
init_spec <- rjd3x13::spec_x13("RSA5c")
# regressors have to be added one by one
new_spec <- add_usrdefvar(init_spec, name = "reg1.iv1", regeffect = "Trend")
new_spec <- add_usrdefvar(new_spec, name = "reg2.iv2", regeffect = "Trend", coef = 0.7)
# modelling context is needed for the estimation phase
# raw series
y <- rjd3toolkit::ABS$X0.2.09.10.M
sa_x13 <- rjd3x13::x13(y, new_spec, context = my_context)

Periodic dummies and contrasts

Generating regressors in R

dummies :as many time series as type of periods in a year (4,12)

## periodic dummies : add explanations and examples
p <- periodic.dummies(4, c(2000, 1), 60)
head(p)
class(p)
q <- periodic.contrasts(4, c(2000, 1), 60)
q[1:9, ]

Trigonometric variables

Correction for stable seasonality.
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Generating in R

User-defined variables

User defined variables are simply time series used as explanatory regressors in
the Reg-ARIMA and the Tramo models. Although JDemetra+ allows the user to
indicate any time series as a variable to avoid misleading or erroneous results,
the following rules should be kept:

• User-defined regression variables are used for measuring abnormalities and
therefore they should not contain a seasonal pattern.

• JDemetra+ assumes that user-defined regressors are already in an appropri-
ately centred form.

Therefore the mean of each user-defined regressor needs to be subtracted from
the regressor or means for each calendar period (month or quarter) need to be
subtracted from each of the user-defined regressors.
JDemetra+ considers two kinds of user-defined regression variables:

• Static variables, usually imported directly from external software (by
drag/drop or copy/paste). The observations for static variables cannot be
changed. The only way to update static series is to remove them from the
list and to re-import them with the same names.

• Dynamic variables that are imported into the Variables panel by dragging
and dropping series from a browser of the application, available in the
Providers window. Dynamic variables are automatically updated each time
the application is re-opened. Therefore, it is a convenient solution for
creating user-defined variables.

In GUI

To create a dynamic variable first right-click on the Variables node in the
Workspace window and chose the option New.
Next, double click on the newly created Vars-1 item to display it in the Results
panel. By default, JDemetra+ uses the conventions Vars_#number to name the
tabs under the Variables node.
Then, go to Providers window and open your file that contains external variables.
Drag and drop your external regressors from the Providers window to the Vars-1
window.
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Figure 66: Creating an empty dataset for the user-defined variables

Figure 67: Activation of an empty dataset for the user-defined variables
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Figure 68: Importing the user-defined variables to JDemetra+

The original name of the series is recorded in the Description column of the Vari-
ables window.

Figure 69: Assigning regressors from the Providers window to the user-
defined variables

In order to rename the series in the Variables window, right click on the series and
chose Rename.
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Figure 70: A local menu for the user-defined variables

In R

Outlier Detection

With Reg ARIMA models

Within an SA processing

In a seasonal adjustment estimation or Reg-ARIMA modelling outliers are detected
by default. This process can be customized by selecting the type of outliers to be
taken into account and the critical values to be used for selection. See the relevant
chapters on SA and SA of High-frequency data

Stand alone

In version 3;x, R packages rjd3x13 and rjd3tramoseats provide functions for de-
tecting outliers with Reg-ARIMA (tramo) algorithms.
Example using regarima_outliersin rjd3x13:

library(rjd3x13)
?regarima_outliers
regarima_outliers(rjd3toolkit::ABS$X0.2.09.10.M,

order = c(1, 1, 1), seasonal = c(0, 1, 1),
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mean = FALSE,
X = NULL, X.td = NULL,
ao = TRUE, ls = FALSE, tc = TRUE, so = TRUE, cv = 4

)

Example wit rjd3tramoseats::tramo_outliers

library(rjd3tramoseats)
?tramo_outliers
tramo_outliers(rjd3toolkit::ABS$X0.2.09.10.M,

order = c(1, 1, 1), seasonal = c(0, 1, 1),
mean = FALSE,
X = NULL, X.td = NULL,
ao = TRUE, ls = FALSE, tc = TRUE, so = TRUE, cv = 4

)

Specific TERROR tool

Up coming content

With structural models (BSM)

Up coming content
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Calendar correction

In this chapter, the calendar correction used in JDemetra+ is discussed.
This chapter is divided in two parts. The first one (theory) outlines the rationale
for calendar correction and the underlying modelling. The second part (practice)
describes how relevant regressors for calendar correction are built in JDemetra+.
As calendar effects are deterministic, they can be corrected with a regression
model. In the algorithms X-13-ARIMA and Tramo-Seats it boils down to adding
suitable regressors to the pre-treatment phase). This chapter will describe how to
generate a set of regressors corresponding to the desired correction, which will
happen according to the following steps:

• step 1: generate a calendar (usually national calendar of interest). If this
step is skipped a default calendar, not taking into account country-specific
holidays will be used.

• step 2: generate regressors based on the above defined calendar

Regressors will have the same frequency as the raw data, thus an aggregation
process will be defined unless the data is daily.

• step 2b: a specific variable for modelling the easter effect (or any other mov-
ing holiday effect like ramadan) can also be defined

Most of the functions are designed for quarterly and monthly data. What applies
to daily and weekly data will be highlighted.
Regressors are corrected for deterministic seasonality through a long-term mean
correction

• step 3: these regressors have to be plugged-in in pre-adjustment phase of
a seasonal adjustment estimation. How to do this is detailed in chapters on
pre-treatment and SA of High-Frenquency data.

How to generate other types of regressors is described here and how to plug them
into Reg-ARIMA models is detailed here
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Rationale for Calendar correction

A calendar is heterogeneous, it at least composed of:

• trading days: days usually worked, taking into account the company’s sector.
(Most frequently Mondays through Fridays when not bank holidays).

• week-ends
• bank holidays

For a given year as well as throughout the years, every month doesn’t have the
same number of days per day-type, which implies that all months/quarters aren’t
“equal”, even for a given type of month or quarter. This causes calendar effects
which have to be removed to allow sounder comparisons following the same prin-
ciple as seasonality correction.
Two types of effects result from this heterogeneity:

• length of period (month/quarter) (leap-year or direct correction)
• composition of period (type of day)

This second effect is also relevant for daily (and weekly) data.
An additional easter effect can bemodelled, as for some series, variations linked to
Easter can be seen over a few days prior or following Easter. For example, flowers
and chocolate sales might rise significantly as Easter approaches. (in practice this
effect is very rare, it is better to deactivate by default detection)

Modelling calendar effects

Regression Model for type of days

For each period 𝑡, the days are divided in 𝐾 groups {𝐷𝑡1,… , 𝐷𝑡𝐾}.
The groups of days can be anything (trading days, working days, Sundays + holi-
days assimilated to Sundays…) ADD

We write 𝑁𝑡 = ∑𝐾
1 𝐷𝑡𝑖, the number of days of the period 𝑡

Two terms appear:

• the specific effect of a type of day 𝑖 as a contrast between the number of
days 𝑖 and the number of Sundays and bank holidays
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• the effect of the month’s (or period’s) length.

Once seasonally adjusted, this term comes down to the leap year effect:

• for all months except Februaries ̄𝑁𝑡 = 𝑁𝑡
• for Februaries ̄𝑁𝑡 = 28.25 and 𝑁𝑡 = 28 or 𝑁𝑡 = 29

The effect of one day of the group 𝑖 is measured by 𝛼𝑖, so that the global effect of
the group 𝑖 for the period 𝑡 is 𝛼𝑖𝐷𝑡𝑖
The global effect of all the days for the period 𝑡 is

𝐾
∑
𝑖=1

𝛼𝑖𝐷𝑡𝑖 = ̄𝛼𝑁𝑡 +
𝐾

∑
𝑖=1

(𝛼𝑖 − ̄𝛼)𝐷𝑡𝑖

where ̄𝛼 = ∑𝐾
𝑖=1 𝑤𝑖𝛼𝑖 with ∑𝐾

𝑖=1 𝑤𝑖 = 1
So,

𝐾
∑
𝑖=1

(𝛼𝑖 − ̄𝛼)𝑤𝑖 =
𝐾

∑
𝑖=1

𝛼𝑖𝑤𝑖 − ̄𝛼
𝐾

∑
𝑖=1

𝑤𝑖 = 0

LEAP YEAR part to comment

We focus now on ∑𝐾
𝑖=1 (𝛼𝑖 − ̄𝛼)𝐷𝑡𝑖, the actual trading days effects (excluding

the length of period effect).

Writing 𝛼𝑖 − ̄𝛼 = 𝛽𝑖 and using that ∑
𝐾
𝑖=1 𝛽𝑖𝑤𝑖 = 0, we have that

𝐾
∑
𝑖=1

𝛽𝑖𝐷𝑡𝑖 =
𝐾

∑
𝑖=1

𝛽𝑖(𝐷𝑡𝑖 − 𝑤𝑖
𝑤𝐾

𝐷𝑡𝐾) =
𝐾−1
∑
𝑖=1

𝛽𝑖(𝐷𝑡𝑖 − 𝑤𝑖
𝑤𝐾

𝐷𝑡𝐾)

Note that the relationship is valid for any set of weights 𝑤𝑖. It is also clear that the
contrasting group of days can be any group:

𝐾−1
∑
𝑖=1

𝛽𝑖(𝐷𝑡𝑖 − 𝑤𝑖
𝑤𝐾

𝐷𝑡𝐾) =
𝐾,𝑖≠𝐽
∑
𝑖=1

𝛽𝑖(𝐷𝑡𝑖 − 𝑤𝑖
𝑤𝐽

𝐷𝑡𝐽)

The “missing” coefficient is easily derived from the others:
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𝛽𝐾 = − 1
𝑤𝐾

𝐾−1
∑
𝑖=1

𝛽𝑖𝑤𝑖

Correction for deterministic seasonality

In the case of seasonal adjustment, we further impose that the regression vari-
ables don’t contain deterministic seasonality. That is achieved by removing from
each type of period (month, quarter…) its long term average. We write ̄𝐷𝑦

𝑖 the
long term average of the yearly number of days in the group 𝑖 and ̄𝐷𝑦

𝑖,𝐽 the long
term average of the number of days in the group 𝑖 for the periods 𝐽 (for instance,
average number of Mondays in January…).
The corrected contrast for the time t belonging to the period J is:

𝐶𝑡𝑖 = 𝐷𝑡𝑖 − ̄𝐷𝑦
𝑖,𝐽 − 𝑤𝑖

𝑤𝐾
(𝐷𝑡𝐾 − ̄𝐷𝑦

𝐾,𝐽)

How is the long term mean computed? Probabilistic approach (more on this
soon)

Weights for different groups of days

We can define different sets of weights. The usual one consists in giving the same
weight to each type of days. 𝑤𝑖 is just proportional to the number of days in the
group 𝑖. In the case of “week days”, 𝑤0 = 5

7 (weeks) and 𝑤1 = 2
7 (week-ends). In

the case of “trading days”, 𝑤𝑖 = 1
7 … Another approach consists in using the long

term yearly averages, taking into account the actual holidays. We get now that
𝑤𝑖 = ̄𝐷𝑦

𝑖
365.25 .

After the removal of the deterministic seasonality, the variables computed using
the two sets of weights considered above are very similar. In the case of the
“trading days”, the difference for the time 𝑡, belonging to the period 𝐽 , and for
the day 𝑖 with contrast 𝐾 is (1 − 𝑤𝑖

𝑤𝐾
)(𝐷𝑡𝐾 − ̄𝐷𝑦

𝐾,𝐽), which is usually small. By
default, JD+ uses the first approach, which is simpler. The second approach is
implemented in the algorithmic modules, but not available through the graphical
interface.
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Use in Reg-ARIMA models

In the context of Reg-ARIMA modelling, we can also observe that the global effect
of the trading days doesn’t depend neither on the used weights (we project on
the same space) nor on the contrasting group (see above) nor on the long term
corrections (removed by differencing).
The estimated coefficients slightly change if we use different weights (not if we use
a different contrasting group). It must also be noted that the choices affect the
T-Stat of the different coefficients (not the joint F-Test), which can lead to other so-
lutions when those T-Stats are used for selecting the regression variables (Tramo).
Considering that the leap year/length of period variable is nearly independent of
the other variables, the test on that variable is not very sensitive to the various
specifications.

Interpretation

The use of different specifications of the trading days doesn’t impact the final
results (except through some automatic selection procedure). It just (slightly)
changes the way we interpret the estimated coefficients.

Easter effect

Stock series

Generating Regressors for calendar correction

The following parts details how to build customized regressors for calendar correc-
tion using

• graphical user interface (GUI)
• rjd3toolkit package.

To take specific holidays into account a calendar has to be defined, regressors will
be built subsequently.
As regressors have the same data frequency as the input series, several cases:

• for daily series : regressors are dummies representing each holidays
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• for weekly, monthly and quarterly series regressors are aggregated indica-
tors, the way of grouping different types of days and holidays has to be spec-
ified.

In GUI

Creating calendars

The customized calendar can be directly linked to the calendar correction option
in GUI while specifying a seasonal adjustment process. See chapters on SA or SA
of HF data.

0.0.0.0.1 * Default Calendar
In the graphical user interface, calendars in are stored in the Workspace window
in the Utilities section. In the default calendar, country-specific national holidays
are not taken into account, it reflects only the usual composition of the weeks in
the calendar periods.

Figure 71: Text

To view the details of the default calendar: double click on it
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Figure 72: Text

0.0.0.0.2 * Set Properties
In the Properties panel the user can set:

• Frequency (monthly, quarterly..)
• Trading days or working days regressors

Trading days: 6 contrast variables
number of Mondays - number of Sundays
and one regressor for the leap year effect.
Working Days: 1 contrast variable (𝑛𝑢𝑚𝑏𝑒𝑟 𝑜𝑓 𝑤𝑜𝑟𝑘𝑖𝑛𝑔𝑑𝑎𝑦𝑠(𝑚𝑜𝑛𝑑𝑎𝑦𝑡𝑜𝑓𝑟𝑖𝑑𝑎𝑦)−
𝑛𝑢𝑚𝑏𝑒𝑟 𝑜𝑓 𝑆𝑎𝑡𝑢𝑟𝑑𝑎𝑦𝑠𝑎𝑛𝑑𝑆𝑢𝑛𝑑𝑎𝑦𝑠,…) and one regressor for the leap year
effect.
Modification of the initial settings for the Default calendar

0.0.0.0.3 * Spectrum visualization
The top-right panel displays the spectrum for the given calendar variable. By de-
fault, the first variable from the table is shown.

• To change it, click on the calendar variable header.
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Figure 73: Text

Calendar variables shouldn’t have a peak neither at a zero frequency (trend) nor
the seasonal frequencies.

Modify an existing Calendar

• click the option Edit from the context menu
• the list of holidays defined for this calendar is displayed

• To add a holiday unfold the + menu
• To remove a holiday click on it and choose the - button

0.0.0.0.1 * Creating a new calendar
An appropriate calendar, containing the required national holidays, needs to be
created to adjust a series for country-specific calendar effects.

• right click on the Calendar item from theWorkspace window and choose Add

Three options are available:

• National calendars: allows to include country-specific holidays
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Figure 74: Text

• Composite calendars : creates calendar as a weighted sum of several national
calendars

• Chained calendars : allows to chain two national calendars before and after
a break

0.0.0.0.2 * National Calendar
To define a national calendar: right click on Calendar item in the Utility panel of
the workspace window

• To add a holiday unfold the + menu
• To remove a holiday from the list click on it and choose the - button.

Four options are available here:

- **Fixed** : holiday occurring at the same date

- **Easter Related**: holiday that depends on Easter Sunday date

- **Fixed Week**: fixed holiday that always falls in a specific week of a given month

- **Special Day**: choose a holiday from a list of pre-defined holidays (link to table)
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Figure 75: Edit a calendar window
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Figure 76: Removing a holiday from the calendar

Figure 77: Text
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Figure 78: Text

Figure 79: Text
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Figure 80: Text
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• to use Julian Easter

Figure 81: Text

To add a holiday from this list to the national calendar, choose the Special day item
from the Special days list.
By default, when the Special Days option is selected, JDemetra+ always adds
Christmas to the list of selected holidays. The user can change this initial choice
by specifying the settings in the panel on the right and clicking OK. The settings
that can be changed include:

• Start: starting date for the holiday (expecting yyyy-mm-dd) Default is the
starting date of the calendar (empty cell).

• End: same as start
• Weight : specifies the impact of the holiday on the series. The default weight
is 1 (full weight) assuming that the influence of the holiday is the same as a
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Figure 82: Adding a pre-defined holiday to the calendar
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regular Sunday. If less the a value between 0 and 1 can be assigned.
• Day event: a list of pre-defined holidays (link to table)
• Offset: allows to set a holiday as related to a pre-specified holiday by spec-
ifying the distance in days (e.g Easter Sunday). Default offset is 1. It can
be positive or negative. Positive offset: defines a holiday following the pre-
specified holiday. Negative offset: defines a holiday preceding the selected
pre-specified.

Figure 83: Choosing a pre-defined holiday from the list

• To define a fixed holiday not included in the list of pre-defined holidays:

– choose Fixed from the Special days list: by default January, 1 is displayed.
Specify the settings:

• Start: starting date for the holiday (expecting yyyy-mm-dd) Default is the
starting date of the calendar (empty cell).
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• End: same as start
• Weight : specifies the impact of the holiday on the series. The default weight
is 1 (full weight) assuming that the influence of the holiday is the same as a
regular Sunday. If less the a value between 0 and 1 can be assigned.

• Day: day of month when the fixed holiday is celebrated.
• Month: month, in which the fixed holiday is celebrated.

Figure 84: Options for a fixed holiday

• Add Corpus Christi: example of an Easter related holiday not included in the
special day list(link to table). It is is a moving holiday celebrated 60 days
after Easter

– choose the Easter related item from the Special days list.
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By
default Easter + 1 is displayed. Setting can be changed :

• Start: starting date for the holiday (expecting yyyy-mm-dd) Default is the
starting date of the calendar (empty cell).

• End: same as start
• Weight : specifies the impact of the holiday on the series. The default weight
is 1 (full weight) assuming that the influence of the holiday is the same as a
regular Sunday. If less the a value between 0 and 1 can be assigned.

• Offset: To define Corpus Christi enter 60, as it is celebrated 60 days after
Easter Sunday.

• Fixed week option: when dealing with holidays occurring on the same week
of a given month. Example: Labour Day in the USA and Canada, celebrated
on the first Monday of September in Canada

– choose Fixed Week from the Special days list.
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Figure 85: Text
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Figure 86: Text

182



Available settings are:

• Start: starting date for the holiday (expecting yyyy-mm-dd) Default is the
starting date of the calendar (empty cell).

• End: same as start
• Weight : specifies the impact of the holiday on the series. The default weight
is 1 (full weight) assuming that the influence of the holiday is the same as a
regular Sunday. If less the a value between 0 and 1 can be assigned

• Day of Week: day of week when the holiday is celebrated each year
• Month: month, in which the holiday is celebrated each year
• Week: number denoting the place of the week in the month: between 1 and
5

Figure 87: Text

183



The list of the holidays should contain only unique entries. Otherwise, a warning,
as shown in the picture below, will be displayed.

Figure 88: Text

A calendar without a name cannot be saved. Fill the Name box before saving the
calendar.
Example : final view of a properly defined calendar for Poland
The calendar is visible in the Workspace window

• To display the available options right-click on it

A national calendar can be edited, duplicated (to create another calendar) and/or
analysed (double click to display it in the panel on the right) or deleted.

0.0.0.0.3 * Chained Calendar
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Figure 89: Text
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Figure 90: Text
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Creating a chained calendar is relevant when a major break occurs in the definition
of the country-specific holidays.
First define the 2 (or 𝑁 ) national calendars corresponding to each regime as ex-
plained in the section above.
To define a chained calendar: right click on Calendar item in the Utility panel of
the workspace window

Figure 91: Text

In the Properties panel specify:

• first and the second calendar
• break date

0.0.0.0.4 * Composite Calendar
Creating a composite calendar is relevant when correcting series which include
data from more than one country/region. This option can be used, for example, to
create the calendar for the European Union or to create the national calendar for
a country, in which regional holidays are celebrated.
First define the relevant national calendars corresponding to each member
state/region as explained above.
To define a chained calendar: right click on Calendar item in the Utility panel of
the workspace window

• Fill the name box
• Mark the regional calendars to be used
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Figure 92: Text

Figure 93: Text
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• Assign a weight to each calendar.

Figure 94: Text

0.0.0.0.5 * Importing an existing calendar from a file
Right click on the Calendar item from the Workspace window and choose the Im-
port item from the menu.

• choose the appropriate file and open it

JDemetra+ adds it to the calendars list

0.0.0.0.6 * Example of a calendar file
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Figure 95: Importing a calendar to JDemetra+

Figure 96: Choosing the file
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Figure 97: A list of calendars with a newly imported calendar

####
Generating regressors
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0.0.0.0.7 * Type of days

0.0.0.0.8 * Leap year

0.0.0.0.9 * Length of Period
(adjust param)

0.0.0.0.10 * Easter

0.0.0.0.11 * stock TD

In R with rjd3toolkit

Version 3 of JDemetra+ allows to build calendar regressors using the rjd3toolkit
package.
The underlying concepts are identical to those available in the graphical user in-
terface (GUI) as described above. R functions replicate the same process and all
arguments and outputs are detailed in rjd3toolkit help pages. The sections below
provide basic examples.
Note that, RJDemetra package based on version 2 of JDemetra+, doesn’t allow to
build calendars and generate regressors. Thus, two approaches are possible when
using version 2

• use built in regressors (“working days” or “trading days”) not taking into ac-
count national holidays

• import user defined calendar regressors

Creating calendars

0.0.0.0.1 * National Calendar
Creating a national calendar with rjd3toolkit.

## French calendar
frenchCalendar <- national_calendar(days = list(

192



fixed_day(7, 14), # Bastille Day
fixed_day(5, 8, validity = list(start = "1982-05-08")), # End of 2nd WW
special_day("NEWYEAR"),
special_day("CHRISTMAS"),
special_day("MAYDAY"),
special_day("EASTERMONDAY"),
special_day("ASCENSION"), #
special_day("WHITMONDAY"),
special_day("ASSUMPTION"),
special_day("ALLSAINTSDAY"),
special_day("ARMISTICE")

))

Holidays can be created with the following ways:

• as fixed days (falling on the exact same date every year)

day <- fixed_day(
month = 12,
day = 25,
weight = 0.9,
validity = list(start = "1968-02-01", end = "2010-01-01")

)
day # December 25th, with weight=0.9, from February 1968 until January 2010

• as special days, when on the list of common holidays, which is available in
the function’s halp page.

# Get the list
?special_day
# To define a holiday for the day after Christmas, with validity and weight
special_day("CHRISTMAS",

offset = 1, weight = 0.8,
validity = list(start = "2000-01-01", end = "2020-12-01")

)

• as a fixed week day

fixed_week_day(7, 2, 3) # second Wednesday of July

• as an easter related holiday
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easter_day(1) # Easter Monday
easter_day(-2) # Good Friday

An example of calendar bringing together all options

MyCalendar <- national_calendar(list(
fixed_day(7, 21),
special_day("NEWYEAR"),
special_day("CHRISTMAS"),
fixed_week_day(7, 2, 3), # second Wednesday of July
special_day("MAYDAY"),
easter_day(1), # Easter Monday
easter_day(-2), # Good Friday
fixed_day(5, 8, validity = list(start = "1982-05-08")), # End of 2nd WW
single_day("2001-09-11"), # appearing once
special_day("ASCENSION"),
easter_day( # Corpus Christi

offset = 60,
julian = FALSE,
weight = 0.5,
validity = list(start = "2000-01-01", end = "2020-12-01")

),
special_day("WHITMONDAY"),
special_day("ASSUMPTION"),
special_day("ALLSAINTSDAY"),
special_day("ARMISTICE")

))

For any defined calendar, it is possible to retrieve the long term-mean correction
values which would be applied on a given set of regressors.

### Long-term means of a calendar
BE <- national_calendar(list(

fixed_day(7, 21),
special_day("NEWYEAR"),
special_day("CHRISTMAS"),
special_day("MAYDAY"),
special_day("EASTERMONDAY"),
special_day("ASCENSION"),
special_day("WHITMONDAY"),
special_day("ASSUMPTION"),
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special_day("ALLSAINTSDAY"),
special_day("ARMISTICE")

))
class(BE)
lt <- long_term_mean(BE, 12,

groups = c(1, 1, 1, 1, 1, 0, 0),
holiday = 7

)

0.0.0.0.2 * Chained Calendar
Creating a chained calendar is relevant when a major break occurs in the definition
of the country-specific holidays.
First define the 2 (or 𝑁 ) national calendars corresponding to each regime as ex-
plained in the section above.

Belgium <- national_calendar(list(special_day("NEWYEAR"), fixed_day(7, 21)))
France <- national_calendar(list(special_day("NEWYEAR"), fixed_day(7, 14)))
chained_cal <- chained_calendar(France, Belgium, "2000-01-01")

0.0.0.0.3 * Composite Calendar
Creating a composite calendar is relevant when correcting series which include
data from more than one country/region. This option can be used, for example, to
create the calendar for the European Union or to create the national calendar for
a country, in which regional holidays are celebrated.

Belgium <- national_calendar(list(special_day("NEWYEAR"), fixed_day(7, 21)))
France <- national_calendar(list(special_day("NEWYEAR"), fixed_day(7, 14)))
composite_calendar <- weighted_calendar(list(France, Belgium), weights = c(1, 2))

Generating regressors

First for monthly, Q, bi monthly…(set this right)
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0.0.0.0.1 * Type of days
This section describes how to generate regressors to correct for type of days ef-
fects. They can be based on a default calendar (no specific holidays taken into
account) or on a customized calendar.

0.0.0.0.1.1 * Trading day regressors without holidays using rjd3toolkit::td function

# Monthly regressors for Trading Days: each type of day is different
# contrasts to Sundays (6 series)
?td
regs_td <- td(frequency = 12, c(2020, 1), 60, groups = c(1, 2, 3, 4, 5, 6, 0), contrasts = TRUE)

The groups argument allows to build groups of days, as daus belonging to the same
group will be identified by the same number, and to set a reference for contrasts
with the number 0.

0.0.0.0.1.2 * Trading day regressors with pre-defined holidays using rjd3toolkit::calendar_td
function
The rjd3toolkit::calendar_td function

?calendar_td
# first define a calendar
BE <- national_calendar(list(

fixed_day(7, 21),
special_day("NEWYEAR"),
special_day("CHRISTMAS"),
special_day("MAYDAY"),
special_day("EASTERMONDAY"),
special_day("ASCENSION"),
special_day("WHITMONDAY"),
special_day("ASSUMPTION"),
special_day("ALLSAINTSDAY"),
special_day("ARMISTICE")

))
# generate regressors
calendar_td(BE,

frequency = 12, c(1980, 1), 240, holiday = 7, groups = c(1, 1, 1, 2, 2, 3, 0),
contrasts = FALSE
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)
# here three groups and one reference are defined
# Mondays = Tuesdays= Wednesdays (`1`)
# Thursdays= Fridays (`2`)
# Saturdays (`3`)
# Sundays and all holidays (`0`)

0.0.0.0.2 * Leap year

0.0.0.0.3 * Length of Period
adjust param

0.0.0.0.4 * Easter Regressor
Create a regressor for modelling the easter effect:

# Monthly regressor, five-year long, duration 8 days, effect finishing on Easter Monday
ee <- easter_variable(frequency = 12, c(2020, 1), length = 5 * 12, duration = 8, endpos = 1)

Display Easter Sunday dates in given period
The function below allows to display the date of Easter Sunday for each year, in
the defined period. Dates are displayed in “YYYY-MM-DD” format and as a number
of days since January 1st 1970.

# Dates from 2018(included) to 2023 (included)
easter_dates(2018, 2023)

0.0.0.0.5 * stock TD

0.0.0.0.6 * Daily data (dummies)

## dummies corresponding to holidays
q <- holidays(BE, "2020-01-01", 365.25, type = "All")
tail(q)
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0.0.0.0.6.1 * Weekly data

Test for Residual Calendar effects

(To be added: where exactly to find the tests in GUI and R)
We consider below tests on the seasonally adjusted series (𝑠𝑎𝑡) or on the irregular
component (𝑖𝑟𝑟𝑡). When the reasoning applies on both components, we will use𝑦𝑡. The functions 𝑠𝑡𝑑𝑒𝑣 stands for “standard deviation” and 𝑟𝑚𝑠 for “root mean
squares”
The tests are computed on the log-transformed components in the case of multi-
plicative decomposition.
TD are the usual contrasts of trading days, 6 variables (no specific calendar).

Non significant irregular

When 𝑖𝑟𝑟𝑡 is not significant, we don’t compute the test on it, to avoid irrelevant
results. We consider that 𝑖𝑟𝑟𝑡 is significant if 𝑠𝑡𝑑𝑒𝑣(𝑖𝑟𝑟𝑡) > 0.01 (multiplicative
case) or if 𝑠𝑡𝑑𝑒𝑣(𝑖𝑟𝑟𝑡)/𝑟𝑚𝑠(𝑠𝑎𝑡) > 0.01 (additive case).

F test

The test is the usual joint F-test on the TD coefficients, computed on the following
models:

0.0.0.0.1 * Autoregressive model (AR modelling option)
We compute by OLS:

𝑦𝑡 = 𝜇 + 𝛼𝑦𝑡−1 + 𝛽𝑇𝐷𝑡 + 𝜖𝑡
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0.0.0.0.2 * Difference model
We compute by OLS:

Δ𝑦𝑡 − Δ𝑦𝑡 = 𝛽𝑇𝐷𝑡 + 𝜖𝑡

So, the latter model is a restriction of the first one (𝛼 = 1, 𝜇 = 𝜇 = Δ𝑦𝑡)

The tests are the usual joint F-tests on 𝛽 (𝐻0 ∶ 𝛽 = 0).
By default, we compute the tests on the 8 last years of the components, so that
they might highlight moving calendar effects.
Remark:
In Tramo, a similar test is computed on the residuals of the ARIMA model. More
exactly, the F-test is computed on 𝑒𝑡 = 𝛽𝑇𝐷𝑡 + 𝜖𝑡, where 𝑒𝑡 are the one-step-
ahead forecast errors.
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Benchmarking and temporal disagreggation

In this chapter

The sections below provide guidance on how to implement algorithms on

• Benchmarking of seasonally adjusted data
• Benchmarking high to low frequency data
• Temporal Disaggregation

Using the GUI with a plug-in or rjd3bench package package.

Algorithms overview

Benchmarking

Method
GUI Plug-in for V
2.x

GUI Plug-in for V
3.x In R rjd3bench

Denton ✔ ✔ ✔
Cholette ✔ ✔ ✔
Cholette Multi-variate ✔ ✖ ✔
Cubic Splines ✖ ✔ ✔
GRP (Growth Rate
Preservation)

✖ ✔ ✔

Calendarization ✔ ✖ ✔

Temporal Disaggregation
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Method
GUI Plug-in for
V 2.x

GUI Plug-in for
V 3.x In R rjd3bench

Regression Models* ✔ ✔ ✔
Model-based Denton ✖ ✔ ✔
ADL (Autoregressive
Distributed Lag Models)

✖ ✖ ✔

*Regression models: several structures of residuals

• Ar1: Chow-Lin
• Rw: Fernandez
• RwAr1: Litterman

Benchmarking seasonally adjusted data

The goal here is to enforce identical annual totals on the seasonally adjusted series
as on the raw or calendar adjusted series.

Using the GUI

When running a seasonal adjustment process

1. With the pre-defined specifications the benchmarking functionality is not ap-
plied by default following the ESS Guidelines on Seasonal Adjustment (2024)
recommendations. It means that once the user has seasonally adjusted the
series with a pre-defined specification the Benchmarking node is empty. To
execute benchmarking click on the Specifications button and activate the
checkbox in the Benchmarking section.
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2. Three parameters can be set here. Target specifies the target variable for the
benchmarking procedure. It can be either the Original (the raw time series)
or the Calendar Adjusted (the time series adjusted for calendar effects). Rho
is a value of the AR(1) parameter (set between 0 and 1). By default it is set to
1. Finally, Lambda is a parameter that relates to the weights in the regression
equation. It is typically equal to 0 (for an additive decomposition), 0.5 (for
a proportional decomposition) or 1 (for a multiplicative decomposition). The
default value is 1.

3. To launch the benchmarking procedure click on the Apply button. The re-
sults are displayed in four panels. The top-left one compares the original
output from the seasonal adjustment procedure with the result from applying
a benchmarking to the seasonal adjustment. The bottom-left panel highlights
the differences between these two results. The outcomes are also presented
in a table in the top-right panel. The relevant statistics concerning relative
differences are presented in the bottom-right panel.
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4. Both pictures and the table can be copied the usual way

5. To export the result of the benchmarking procedure (benchmarking.result)
and the target data (benchmarking.target) one needs to once execute the
seasonal adjustment with benchmarking
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6. Expand the “+” menu and choose an appropriate data format (here Excel has
been chosen). It is possible to save the results in .txt, .xls, .csv, and .csv
matrix formats. Note that the available content of the output depends on the
output type.

7. Chose the output items that refer to the results from the benchmarking pro-
cedure, move them to the window on the right and click OK.
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In R with rjd3x13 and rjd3tramoseats

When performing seasonal adjustment with rjd3x13 and rjd3tramoseats, the
current (or default) specification has to be customized using the function
rjd3toolkit::set_benchmarking documented on this GitHub page

init_spec <- rjd3x13::spec_x13("RSA5c")
new_spec <- set_benchmarking(

init_spec,
enabled = TRUE,
target = "Normal",
rho = 0.8,
lambda = 0.5,
forecast = FALSE,
bias = "None"

)

More information on R packages for JDemetra+ and installation procedures is pro-
vided in this chapter
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Benchmarking with different frequencies

These methods provide a high-frequency series (input series) modified so that it
fulfils a linear relationship, with another series of low frequency (benchmark), both
series measure the same target variable. An example of the relation to be fulfilled
could be that the low frequency series (quarterly frequency) coincides with the
quarterly sum of the high frequency series (monthly frequency).
Multivariate benchmarking also forces contemporary linear relations between high
frequency series. If these relations do not exist, benchmarking could be carried
out for each series separately. Normally contemporary relations are linear and
the relations of aggregation are also linear and the same for all series, so the
contemporary relations between low frequency series are fulfilled.
The benchmarking methods available in the benchmarking and time disaggrega-
tion plug-in are: Denton, Cholette, and Cholette multivariate.

Using the plug-in for GUI (version 2.x)

Download the plug-in for GUI as explained here and install it as detailed here
Once the plugin is installed, two more options appear in the Workspace window:
Benchmarking and Temporal Disaggregation.

Figure 98: Text

206



Univariate: Denton and Cholette

To run Denton univariate case select:
Statistical Methods → Benchmarking → Denton or Cholette

Figure 99: Benchmarking tab

In both cases, a new window is displayed to launch one of the methods with the
series selected. In the upper left side, drag the high frequency series from the
Providers window and drop it in Drop Series here and the low frequency series
in Drop Constraint here.

Denton

In the top right of the screen, select the Specifications button to set the specifi-
cations to apply each method. See below for a description of the available options
on Denton method:

1. Type: Aggregation function (Sum, Average, Last or First). This forces the
low-frequency series to match the aggregation function selected of the high
frequency series.

2. Multiplicative: if the checkbox is selected, the proportional Denton method
is applied. Otherwise, additive Denton is applied.

3. Modified Denton: if the checkbox is selected, the modified Denton method
is applied. Otherwise, original Denton is applied. It is recommended to select
it; as original Denton perform a special treatment on the first observation.

4. Differencing: Number of regular differences. By default 1.
5. Default frequency: periodicity of the low frequency data. The options are:
Yearly, HalfYearly, QuadriMonthly, Quarterly, Bimonthly and Monthly.
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Figure 100: Denton Specifications

Cholette

See below for a description of the available options on Cholette method:

1. Type: Aggregation function (Sum, Average, Last or First). This forces the
low-frequency series to match the aggregation function selected of the high
frequency series.

2. Aggregation frequency: periodicity of the low frequency data. The options
are: Yearly, HalfYearly, QuadriMonthly, Quarterly, Bimonthly and Monthly.

3. Rho: value between −1 and 1. It is the coefficient of an AR(1) model that
follows the error term. The default value is 1, equivalent to applying Denton.

4. Lambda: value between 0 and 1. It is the parameter 𝜆 of the following
function to be minimized in Cholette method:

∑
𝑡

(𝑥𝑡 − 𝑧𝑡
|𝑧𝑡|

𝜆 − 𝜌𝑥𝑡−1 − 𝑧𝑡−1
|𝑧𝑡−1|

𝜆 )
2

Usually lambda is 0 or 1 equivalent to applying additive benchmarking and
proportional benchmarking method respectively.

In both cases, Denton and Cholette methods, the output is a graph with the original
series and the benchmarked series. There is no table with the results, but it is very
easy to create one from the graph. Select the graph and select copy, then paste
the values in excel (control-V).
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Figure 101: Cholette Specifications

Figure 102: Denton output
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Multi-variate Cholette

The only multi-variate benchmarking method available for the version 2 plugin, is
multi-variate Cholette.
The input for this method are a set of time series with different frequencies and a
set of constraints, both contemporary and intertemporal. The output is a new set
of time series, that corresponds to the former, now fulfilling the constraints.
To run multi-variate Cholette select Statistical methods→ Benchmarking→ Multi-
variate Cholette. Then, a box appears, where we can drop time series.

Figure 103: Multi-variate Cholette input

The specification properties can be set by selecting Window → Properties. There
are only three elements in the form: Rho, Lambda and Constraints. The two first
are analogous to their univariate Cholette counterparts. The third one allows to
set constraints, both contemporary and intertemporal.
Clicking the three dots button from Constraints, opens the constraints list box.
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Figure 104: Multi-variate Cholette specification
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Figure 105: Constraints list

From this box, the set of constraints can be added, just typing the constraint inside
item and clicking Add button. The constraints must be written as follows:

• 𝑦 = 𝑎1 ∗ 𝑥1 + ⋯ + 𝑎𝑛 ∗ 𝑥𝑛 where 𝑦, 𝑥1,… , 𝑥𝑛 are same frequency time
series and 𝑎1,… , 𝑎𝑛 are constant.

• 𝑐 = 𝑎1 ∗ 𝑥1 + ⋯ + 𝑎𝑛 ∗ 𝑥𝑛 where 𝑥1,… , 𝑥𝑛 are same frequency time series
and 𝑐, 𝑎1,… , 𝑎𝑛 are constant.

• 𝑐 = 𝑥1 + ⋯ + 𝑥𝑛 can be shortened as 𝑐 = 𝑥?.
• 𝑆 = sum(𝑠) where 𝑆 is low-frequency and 𝑠 is high-frequency.

Note that any time series put on the left hand side can’t appear on the right hand
side of any other constraint. This is because left hand side quantities are fixed
while right hand side quantities are adjusted so the equality holds.
The output are the benchmarked high-frequency time series, that can be found in
Details → Benchmarked series.

Using the plug-in for GUI (version 3.x)

Practical use of the plug-in for v 3.x is quasi identical to the one in v2.x described
above. Some methods are not available yet in v 3.x but the latter which contains
Model
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Figure 106: Output multi-variate Cholette

Based Denton not included in v2.x, as stated here

In R with rjd3bench

Use the [rjd3bench](https://github.com/rjdverse/rjd3bench) package and see its
documentation pages. Browse its documentation on this GitHub page.
To get started browse the vignette
More information on R packages for JDemetra+ and installation procedures is pro-
vided in this chapter

Temporal Disaggregation

These methods are used to disaggregate a series from low frequency to high fre-
quency. Temporal disaggregation methods developed in the plug-in are Chow-Lin,
Fernández and Litterman.
When there are high frequency related indicators, these methods provide high
frequency estimations for a series whose sums, averages, first or last values are
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consistent with the observed low frequency series, applying a regression model
where it is assumed that the high frequency series to be estimated follows a mul-
tiple regression with p related series (indicators).
See Methods→Temporal disaggregation for more theoretical detail.

Using the plug-in for GUI

Temporal disaggregation in the GUI is available with the same plug-in as bench-
marking (described in the sections above)
To run Temporal Disaggregation methods select Temporal disaggregation→ Re-
gression Model:

Figure 107: Temporal Disggregation

A new window is displayed to launch one of the methods with the series selected.
In the upper left side drag the low frequency series from the Providers window and
drop it in Y box and the proxy series or indicator with high frequency series in X
box.
In the top right of the screen, select Specifications to set the specifications to
apply each method. Here is a description of the available options on Temporal
Disaggregation methods:

1. Estimation span: Specifies the span (data interval) of the time series to be
used in the temporal disaggregation process. The user can restrict the span.
The common settings are:

Option Description (expected format)
All default
From first observation included (yyyy-mm-dd)
To last observation included (yyyy-mm-dd)
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Option Description (expected format)
Between interval [from ; to] included (yyyy-mm-dd to

yyyy-mm-dd)
First number of observtions from the beginning of the series

included (dynamic) (integer)
Last number of observations from the end of the series

(dynamic)(integer)
Excluding excluding N first observation and P last observation

from the computation,dynamic) (integer)
Preliminary
check

check to exclude highly problematic series e.g. the
series with a number of identical observations and/or
missing values above pre-specified threshold values.
(True/False)

2. Error: determines the method to be applied and it refers to the model that
follows the error term.

Option Description
Ar1 Chow-Lin method (default)
Wn Classical Regression model
Rw Fernández
RwAr1 Litterman
I2 Integrated order 2
I3 Integrated order 3

3. Parameter: Coefficient of the AR(1) of the innovations model. It has a value
between -1 and 1. This parameter exists only if RWar1 or Ar1 is selected in
the error parameter.

4. Constant: a constant is included in the model if it is selected.
5. Trend: a linear trend is included in the model if it is selected.
6. Type: Aggregation function (Sum, Average, Last or First). This forces the
low-frequency series to match the aggregation function selected of the high
frequency series.

7. Default frequency: it is the frequency of the output series.
8. Advanced options: These parameters are related to state space model and
the algorithm used to obtain the estimations.
8.1. Diffuse regression coefficient: Indicates if the coefficients of the re-
gression model are diffuse (T) or fixed unknown (F, default).
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Figure 108: Temporal Disggregation

Here are the results:
Select Model→Summary to see the estimation of 𝑟ℎ𝑜 (coefficient of the AR(1)
model) and the coefficient of the regression model. Additionally the BIC, AIC and
AICC. It is also showed the variance decomposition in Indicators and Smoothing.
Ideally, if the indicator adequately approximates the aggregate in the observable
domain (low frequency model), the residuals of the low frequency model will be
small and the indicator term will dominate. \
To confirm that the model works well, select Model→Residuals→Statistics and
see the tests on the residuals of the model:
Select MainResults→Table to obtain the disaggregated series and standard devia-
tion.
Select MainResults→Chart to see a graph of the disaggregated series and the
confidence interval.

In R with rjd3bench

Use the [rjd3bench](https://github.com/rjdverse/rjd3bench) package and see its
documentation pages. Browse its documentation on this GitHub page.
To get started browse the vignette
More information on R packages for JDemetra+ and installation procedures is pro-
vided in this chapter
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Figure 109: Temporal Disggregation
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Figure 110: Temporal Disaggregation

Figure 111: Temporal Disggregation
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Figure 112: Temporal Disggregation

Temporal Disaggregation

To perform Temporal Disaggregation methods use the function temporaldisag-
gregation:

output <- rjd3bench::temporaldisaggregation(
series = y, indicators = x, model = "Rw", freq = 12,
conversion = "Average", diffuse.algorithm = "Diffuse"

)

The input parameters are the same as in the GUI, see the R Documentation of the
rjd3bench package for the description.
The output is a list containing 3 elements:

1. Regression: contains information about:

• Type of method applied:

output$regression$type

• The model (coefficient estimation, standard deviation and T-statistic):
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output$regression$model

• Conversion:Aggregation function (Sum, Average, Last or First):

output$regression$conversion

2. Estimation: contains information about:

• The disaggregated series:

output$estimation$disagg

• The standard deviation of the disaggregated series:

output$estimation$edisagg

• The regressor effect:

output$estimation$regeffect

• The smoothing part:

output$estimation$smoothingpart

• The 𝑟ℎ𝑜 estimation (coefficient of the AR(1) model): This parameter ex-
ists only if RWar1 or Ar1 is selected in the model.

output$estimation$parameter

• The standard deviation of the AR(1) coefficient:

output$estimation$eparameter

3. Likelihood: Contains information about the loglikelihood(ll), sum of squares
of the residuals of the model (ssq), number of observations (nobs), number of
parameters to be estimated (nparams), degrees of freedom (df), Akaike Infor-
mation Criteria (aic), Akaike Information Criteria Corrected (aicc), Bayesian
Information Criteria (bic), Bayesian Information Criteria Corrected (bic2).
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Trend-cycle estimation

In this Chapter

This chapter will cover the implementation of trend estimation methods available
in JDemetra+ v 3.
More methodological details will be provided here

Tools for access

For the time being this algorithms are available in two R packages.

rjd3filters

rjd3filters is available here, with useful information in the Readme file and function
documentation.

rjd3x11plus

rjd3x11plus is available here, with (up coming) useful information in the Readme
file and function documentation.
(Up coming content)
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Revision Analysis

Tool

rjd3revisions package allows to perform revision analysis.
More information is available directly in the package documentation and vi-
gnette.

library("rjd3revisions")
browseVignettes("rjd3revisions")

Up coming content.
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Nowcasting

Nowcasting is often defined as the prediction of the present, the very near future
and the very recent past. The plug-in developed at the National Bank of Belgium
helps to operationalize the process of nowcasting. It can be used to specify and
estimate dynamic factor models and visualize how the real-time dataflow updates
expectations, as for instance in Banbura and Modugno (2010). The software can
also be used to perform pseudo out-of-sample forecasting evaluations that con-
sider the calendar of data releases, contributing to the formalization of the now-
casting problem originally proposed by Giannone, et al. (2008) or Evans (2005).
In the meantime the user can refer to the documentation provided with the now-
casting plug-in for version 2.2 and later.
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Part II

Tools
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This part describes the tools allowing to access JDemetra+ algorithms: Graphical
User Interface (GUI) extended with Plug-ins, Cruncher and R packages.
Practical guidance on algorithms per se is provided here and methodological de-
tails on each algorithm can be found in the here.
In this part:
Graphical User Interface (GUI)

• Overview
• Data visualization and time series tools
• Seasonal Adjustement and Modelling features
• Output: series, parameters and diagnostics

GUI extensions

• Plug-ins for GUI

Production Module

• Cruncher and quality report

R ecosystem:

• R packages

225



Graphical User Interface (GUI): Overview

In this chapter

This chapter provides general information about using the Graphical User Interface
(GUI). Specific indications related to a given algorithm (X-13-ARIMA, Tramo-Seats,
Benchmarking…) are displayed in the relevant chapters, listed here.
Contents:

• Available algorithms
• Installation and launch
• Importing data
• General window and menu structure

Additional chapters related to GUI features, provide information on:

• Data visualization and generic time series tools
• Specific Seasonal Adjustement and Modelling features
• Output: series, parameters and diagnostics

Available algorithms

0.0.0.1 v2

The Graphical User Interface in the 2.x family gives access to:

• Seasonal adjustment (SA) algorithms

– X-13-ARIMA
– Tramo-Seats
– Direct-indirect SA comparisons

• Outlier detection (TERROR)
• Benchmarking
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0.0.0.2 v3

The Graphical User Interface in the 3.x family gives access in addition to extended
SA algorithms for high-frequency data (HF).
The Graphical User Interface in the 2.x family gives access to:

• Seasonal adjustment (SA) algorithms

– X-13-ARIMA
– Tramo-Seats
– Direct-indirect SA comparisons

• Outlier detection (TERROR)
• Benchmarking

The Graphical User Interface in the 3.x family gives access in addition to extended
SA algorithms for high-frequency data (HF).

Available Time Series tools

The Graphical User Interface in the 2.x and 3.x family give access to generic time
series tools:

• Graphics

– time domain
– spectral analysis

• Tests

– seasonality tests
– autocorrelation, normality, randomness tests

Installation Procedure

The installation procedure is detailed here in the introductory chapter of this book.
Should you need more configuration details you will find specific Sheets in the
JD-Tutorials GitHub repository
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Launching JDemetra+

To open an application, double click on nbdemetra.exe or nbdemetra64.exe de-
pending on the system version (nbdemetra.exe for the 32-bit system version and
nbdemetra64.exe for the 64-bit system version).

Figure 113: Launching JDemetra+

If the launching of JDemetra+ fails, you can try the following operations:

• Check if Java SE Runtime Environment (JRE) is properly installed by typing in
the following command in a terminal:

java --version

• Check the logs in your home directory:

– %appdata%/.nbdemetra/dev/var/log/ for Windows;
– ~/.nbdemetra/dev/var/log/‘ for Linux and Solaris;
– ~/Library/Application Support/.nbdemetra/dev/var/log/ for Mac OS X.

In order to remove a previously installed JDemetra+ version, the user should delete
an appropriate JDemetra+ folder.
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Starting Window

Figure 114: JDemetra+ default window

By default, on the left hand side of the window two panels are visible:

• TheWorkspace panel stores the results generated by the software as well as
settings used to create them;

• The Providers panel organises the imported raw data within each data
provider;

The other key parts of the user interface are:

• The application menu.
• A central empty zone for presenting the actual analyses further called the
Results panel.

Providers window

By default, JDemetra+ supports the following data sources:

• JDBC;
• ODBC;
• SDMX;
• Excel spreadsheets;
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Figure 115: The Providers window

• TSW (input files for the Tramo-Seats-Windows application by the Bank of
Spain);

• .txt;
• USCB (input files for the X-13-ARIMA-Seats application by the U.S. Census
Bureau);

• .xml.

All standard databases (Oracle, SQLServer, DB2, MySQL) are supported by JDeme-
tra+ via JDBC, which is a generic interface to many relational databases. Other
providers can be added by users by creating plugins (see Plugins section in the
Tools menu).

Import data

To import data from a given data source:

• click on this data source in the Providers window shown below
• choose Open option and specify the import details, such as a path to a data
file.

These details vary according to data providers.
https://www.youtube.com/watch?v=KYBcKx1e8ys&pp=ygUUaW1wb3J0IGRhdG
EgamRlbWV0cmE%3D

0.0.0.1 Spreadsheet

The example below show how to import the data from an Excel file.

230

https://www.bde.es/bde/en/secciones/servicios/Profesionales/Programas_estadi/Programas.html
https://www.census.gov/data/software/x13as.html
https://www.youtube.com/watch?v=KYBcKx1e8ys&pp=ygUUaW1wb3J0IGRhdGEgamRlbWV0cmE%3D
https://www.youtube.com/watch?v=KYBcKx1e8ys&pp=ygUUaW1wb3J0IGRhdGEgamRlbWV0cmE%3D


1. From the Providers window right-click on the Spreadsheets branch and
choose Open option.

2. The Open data source window contains the following options:

• Spreadsheet file – a path to access the Excel file.
• Data format (or Observartion format in v3) – the data format used
to read dates and values. It includes three fields: locale (country), date
pattern (data format, e.g. yyyy-mm-dd), number pattern (a metaformat
of numeric value, e.g. 0.## represents two digit number).

• Frequency – time series frequency. This can be undefined, yearly, half-
yearly, four-monthly, quarterly, bi-monthly, or monthly. When the fre-
quency is set to undefined, JDemetra+ determines the time series fre-
quency by analysing the sequence of dates in the file.

• Aggregation type – the type of aggregation (over time for each time se-
ries in the dataset) for the imported time series. This can be None, Sum,
Average, First, Last, Min or Max. The aggregation can be performed only
if the frequency parameter is specified. For example, when frequency is
set to Quarterly and aggregation type is set to Average, a monthly time
series is transformed to quarterly one with values that are equal to the
one third of the sum of the monthly values that belong to the correspond-
ing calendar quarter.

• Clean missing – erases missing values at the start of the series.

Next, in the Source section click the grey “…” button to open the file.

231



3. Choose a file and click OK.

4. The user may specify Data format, Frequency and Aggregation type, however
this step is not compulsory. When these options are specified JDemetra+ is
able to convert the time series frequency. Otherwise, the functionality that
enables the time series frequency to be converted will not be available.
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5. The data are organized in a tree structure.
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Once imported, your s is visible as a “node” structure

Figure 116: A structure of a dataset

Accepted formats

In v2, the formats .xls and .xlsx are accepted.
In v3, only the format .xlsx is accepted (.xls files are no longer supported).

How to set-up your spreadsheet

• Dates in Excel date format, in the first column (or in the first row)
• Titles of the series in the corresponding cell of the first row (or in the
first column)

• Top-left cell 𝐴1 can include text or it can be left empty
• Empty cells are interpreted by JDemetra+ as missing values
• If empty cells are at the beginning of the series they can be ignored using
the option clean-missing.
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Figure 117: Example of an Excel spreadsheet that can be imported to
JDemetra+

In Excel files, series are identified by their names (colnames) in the file.

0.0.0.2 .txt or .csv file

The example below show how to import the data from an Excel file.

1. From the Providers window right-click on the Txt files branch and choose
Open option.
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2. The Open data source window contains the following options:

• .txt file – a path to access the file.
• Charset – the encoding used to encode the file
• Lines to skip – the number of lines to skip before reading the data
• Delimiter – the character used to separate fields in the file
• Text qualifier – the characters used to retrieve text fileds
• Has header – check tu use the first line as header
• Data format (or Observartion format in v3) – the data format used
to read dates and values. It includes three fields: locale (country), date
pattern (data format, e.g. yyyy-mm-dd), number pattern (a metaformat
of numeric value, e.g. 0.## represents two digit number).

• Frequency – time series frequency. This can be undefined, yearly, half-
yearly, four-monthly, quarterly, bi-monthly, or monthly. When the fre-
quency is set to undefined, JDemetra+ determines the time series fre-
quency by analysing the sequence of dates in the file.

• Aggregation type – the type of aggregation (over time for each time se-
ries in the dataset) for the imported time series. This can be None, Sum,
Average, First, Last, Min or Max. The aggregation can be performed only
if the frequency parameter is specified. For example, when frequency is
set to Quarterly and aggregation type is set to Average, a monthly time
series is transformed to quarterly one with values that are equal to the
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one third of the sum of the monthly values that belong to the correspond-
ing calendar quarter.

• Clean missing – erases the missing values of the series.
• Partial aggregation – Allow partial aggregation (only with average and
sum aggregation).

Next, in the Source section click the grey “…” button to open the file.

3. Choose a file and click OK.
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4. The data are organized in a tree structure.

How to set up you .txt or .csv file

• Dates in Excel date format, in the first column (or in the first row)
• Titles of the series in the corresponding cell of the first row (or in the
first column)

• Top-left cell 𝐴1 can include text or it can be left empty
• Empty cells are interpreted by JDemetra+ as missing values
• If empty cells are at the beginning of the series they can be ignored using
the option clean-missing.
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Figure 118: Example of an Excel spreadsheet that can be imported to
JDemetra+

In text files, series are identified by their position in the file.

Spreadsheet

The example below show how to import the data from an Excel file.

1. From the Providers window right-click on the Spreadsheets branch and
choose Open option.

239



2. The Open data source window contains the following options:

• Spreadsheet file – a path to access the Excel file.
• Data format (or Observartion format in v3) – the data format used
to read dates and values. It includes three fields: locale (country), date
pattern (data format, e.g. yyyy-mm-dd), number pattern (a metaformat
of numeric value, e.g. 0.## represents two digit number).

• Frequency – time series frequency. This can be undefined, yearly, half-
yearly, four-monthly, quarterly, bi-monthly, or monthly. When the fre-
quency is set to undefined, JDemetra+ determines the time series fre-
quency by analysing the sequence of dates in the file.

• Aggregation type – the type of aggregation (over time for each time se-
ries in the dataset) for the imported time series. This can be None, Sum,
Average, First, Last, Min or Max. The aggregation can be performed only
if the frequency parameter is specified. For example, when frequency is
set to Quarterly and aggregation type is set to Average, a monthly time
series is transformed to quarterly one with values that are equal to the
one third of the sum of the monthly values that belong to the correspond-
ing calendar quarter.

• Clean missing – erases the missing values of the series.

Next, in the Source section click the grey “…” button to open the file.
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3. Choose a file and click OK.

4. The user may specify Data format, Frequency and Aggregation type, however
this step is not compulsory. When these options are specified JDemetra+ is
able to convert the time series frequency. Otherwise, the functionality that
enables the time series frequency to be converted will not be available.
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5. The data are organized in a tree structure.
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Once imported, your spreadsheet is visible as a “node” structure

Figure 119: A structure of a dataset

Accepted formats

In v2, the formats .xls and .xlsx are accepted.
In v3, only the format .xlsx is accepted. .xls files are no longer supported.

How to set-up your spreadsheet

• Dates in Excel date format, in the first column (or in the first row)
• Titles of the series in the corresponding cell of the first row (or in the
first column)

• Top-left cell 𝐴1 can include text or it can be left empty
• Empty cells are interpreted by JDemetra+ as missing values
• If empty cells are at the beginning of the series they can be ignored using
the option clean-missing.
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Figure 120: Example of an Excel spreadsheet that can be imported to
JDemetra+

In Excel files, series are identified by their names (colnames) in the file.

.txt or .csv file

The example below show how to import the data from an Excel file.

1. From the Providers window right-click on the Txt files branch and choose
Open option.
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2. The Open data source window contains the following options:

• Text file – a path to access the file.
• Charset – the encoding used to encode the file
• Lines to skip – the number of lines to skip before reading the data
• Delimiter – the character used to separate fields in the file
• Text qualifier – the characters used to retrieve text fileds
• Has header – check tu use the first line as header
• Data format (or Observartion format in v3) – the data format used
to read dates and values. It includes three fields: locale (country), date
pattern (data format, e.g. yyyy-mm-dd), number pattern (a metaformat
of numeric value, e.g. 0.## represents two digit number).

• Frequency – time series frequency. This can be undefined, yearly, half-
yearly, four-monthly, quarterly, bi-monthly, or monthly. When the fre-
quency is set to undefined, JDemetra+ determines the time series fre-
quency by analysing the sequence of dates in the file.

• Aggregation type – the type of aggregation (over time for each time se-
ries in the dataset) for the imported time series. This can be None, Sum,
Average, First, Last, Min or Max. The aggregation can be performed only
if the frequency parameter is specified. For example, when frequency is
set to Quarterly and aggregation type is set to Average, a monthly time
series is transformed to quarterly one with values that are equal to the
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one third of the sum of the monthly values that belong to the correspond-
ing calendar quarter.

• Clean missing – erases the missing values of the series.
• Partial aggregation – Allow partial aggregation (only with average and
sum aggregation).

Next, in the Source section click the grey “…” button to open the file.

3. Choose a file and click OK.
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4. The data are organized in a tree structure.

How to set up you .txt or .csv file

• Dates in Excel date format, in the first column (or in the first row)
• Titles of the series in the corresponding cell of the first row (or in the
first column)

• Top-left cell 𝐴1 can include text or it can be left empty
• Empty cells are interpreted by JDemetra+ as missing values
• If empty cells are at the beginning of the series they can be ignored using
the option clean-missing.
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Figure 121: Example of an Excel spreadsheet that can be imported to
JDemetra+

In text files, series are identified by their position in the file.

Wrangling data

Series uploaded to the Providers window can be

• Displayed,
• Modified
• Tested for seasonality / white noise

or used in any available algorithm (link to list)

• Modelled Modelling
• Seasonnally adjusted
• Benchmarked

248



Behaviour options

Restoring data sources

The data sources can be restored after re-starting the application so that there
is no need to get them again. This functionality can be set in the Behaviour tab
available at the Option item from the Tools menu.

Add Star

You can also favorite files to find them each time you open the software.
To favorite a file:

• right-click on the file
• click on Add star

Figure 122: Create a new favorite
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Figure 123: Example of a favorite file

A favorite file will have a little star on top right of the logo:
To remove a favorite:

• right-click on the file
• click on Remove star

Workspace Structure

The workspace is the main data structure used by JDemetra+.
The workspace saved by JDemetra+ includes:

• Main folder containing several folders that correspond to the different types
of items created by the user and;

• The .xml file that enables the user to import the workspace to the application
and to display its content.

The workspace can be shared with other users, which eases the burden of work
with defining specifications, modelling and seasonal adjustment processes.
The main folder contains:

• a folder SAProcessing with all the result of the SA
• folders TramoSeatsSpec and/or X-13Spec with the custom specifications
• a folder Variables for external regressor and variables
• a folder Calendars with the calendars used to correct the trading days effect
• a folder Output contains all the generated output from the GUI
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Figure 124: Remove a favorite
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Figure 125: Example of a workspace created by JDemetra+.

Workspace window

The workspace window displays the characteristics of a workspace but ALSO
gives access to other peripheric routines, the results of which won’t be stored in a
workspace (as data structure).
You can find:

• Modelling (contains the default and user-defined specifications for modelling;
and the output from the modelling process)

• Seasonal adjustment (contains the default and user-defined specifications for
seasonal adjustment and the output from the seasonal adjustment process),

• Utilities (calendars and user defined variables).

Results Panel

Results Panel of seasonal adjustment will be presented in another chapter
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Figure 126: Structure of a workspace
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Figure 127: The Workspace window
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Top Bar Menu and options

Figure 128: The Top bar menus

Themajority of functionalities are available from themain application menu, which
is situated at the very top of the main window. If the user moves the cursor to an
entry in the main menu and clicks on the left mouse button, a drop-down menu
will appear. Clicking on an entry in the drop-down menu selects the highlighted
item.

Figure 129: The main menu with selected drop-down menu

The functions available in the main application menu are:

• File
• Statistical methods
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• View
• Tools
• Window
• Help
• RegARIMADoc
• X-13Doc
• TramoDoc
• TramoSeatsDoc
• SAProcessingDoc

File

The File menu is intended for working with workspaces and data sources. It offers
the following functions:

• NewWorkspace – creates a newworkspace and displays it in theWorkspace
window with a default name (Workspace_#number);

• Open Workspace – opens a dialog window, which enables the user to select
and open an existing workspace;

• Open Recent Workspace – presents a list of workspaces recently created
by the user and enables the user to open one of them;

• Save Workspace – saves the project file named by the system under the de-
fault name (Workspace_#number) and in a default location. The workspace
can be re-opened at a later time;

• Save Workspace As… – saves the current workspace under the name cho-
sen by the user in the chosen location. The workspace can be re-opened at
a later time;

• Open Recent – presents a list of datasets recently used and enables the user
to open one of them;

• Exit – closes an application.

Statistical Methods

Here just a hint and link to relevant chapters
The Statistical methods menu includes functionalities for modelling, analysis and
the seasonal adjustment of a time series. They are divided into three groups:
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Figure 130: The content of the File menu
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• Anomaly Detection – allows for a purely automatic identification of regression
effects;

Figure 131: The Anomaly detection tab.

• Modelling – enables time series modelling using the Tramo and Reg-ARIMA
models;

Figure 132: The Modelling tab.

• Seasonal adjustment – intended for the seasonal adjustment of a time series
with the Tramo-Seats and X-13ARIMA-Seats methods.

By default, the Seasonal adjustment tab has 3 sub-tabs:

• Multiprocessing,
• Single Analysis,
• and Tools.

Figure 133: The Seasonal adjustment tab in v2
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0.0.0.1 v2

In v2, the Tools sub-tabs contains 2 functionalities:

• Seasonality Tests
• Direct-Indirect Seasonal Adjustment

Figure 134: The Seasonal adjustment tab in v2

0.0.0.2 v3

In v3, the Tools sub-tabs contains 2 functionalities:

• Seasonality Tests
• CanovaHansen

But no direct-indirect analysis.

Figure 135: The Seasonal adjustment tab in v3

In v2, the Tools sub-tabs contains 2 functionalities:

• Seasonality Tests
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• Direct-Indirect Seasonal Adjustment

Figure 136: The Seasonal adjustment tab in v2

In v3, the Tools sub-tabs contains 2 functionalities:

• Seasonality Tests
• CanovaHansen

But no direct-indirect analysis.

Figure 137: The Seasonal adjustment tab in v3

Tools menu

The following functionalities are available from the Tools menu:

• Container – includes several tools for displaying data in a time domain;
• Spectral analysis – contains tools for the analysis of a time series in a fre-
quency domain;

• Aggregation – enables the user to investigate a graph of the sum of multiple
time series;
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Figure 138: The Tools menu

• Differencing – allows for the inspection of the first regular differences of the
time series;

• Spreadsheet profiler – offers an Excel-type view of the .xls file imported to
JDemetra+.

• Plugins – allows for the installation and activation of plugins, which extend
JDemetra+ functionalities.

• Options – presents the default interface settings and allows for their modifi-
cation.

Container

Container includes basic tools to display the data. The following items are avail-
able: Chart, Grid, Growth Chart and List.
detailed in data visualization part (link to set up)

Spectral analysis

The Spectral analysis section provides three spectral graphs that allows an in-
depth analysis of a time series in the frequency domain. These graphs are the
Auto-regressive Spectrum, the Periodogram and the Tukey Spectrum.
For more information the user may refer to the spectral analysis chapter and to
the sprectral graphs section.
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Figure 139: The Container menu

Figure 140: Tools for spectral analysis
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Aggregation

Aggregation calculates the sum of the selected series and provides basic informa-
tion about the selected time series, including the start and end date, the number
of observations and a sketch of the data graph.
link to data visu chap

Differencing

The Differencing window displays the first regular differences for the selected time
series together with the corresponding periodogram and the PACF function.
link to data visu chap

Spreadsheet profiler

The Spreadsheet profiler offers an Excel-type view of the .xls file imported to
JDemetra+. To use this functionality drag the file name from the Providers window
and drop it to the empty Spreadsheet profiler window.

Figure 141: The Spreadsheet Profiler window
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Plugins

Installation an functionalities of plugins are described in the related chapter.

View

The View menu contains functionalities that enable the user to modify how JDeme-
tra+ is viewed. It offers the following items:

• Split – the function is not operational in the current version of the software.
• Toolbars – displays selected toolbars under the main menu. The File toolbar
contains the Save all icon. The Performance toolbar includes two icons: one
to show the performance of the application, the other to stop the application
profiling and taking a snapshot. The Other toolbar determines the default
behaviour of the program when the user double clicks on the data. It may be
useful to plot the data, visualise it on a grid, or to perform any pre-specified
action, e.g. execute a seasonal adjustment procedure.

• Show Only Editor – displays only the Results panel and hides other windows
(e.g. Workspace and Providers).

• Full Screen – displays the current JDemetra+ view in full screen.

Figure 142: The View menu
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Window menu

The Window menu offers several functions that facilitate the analysis of data and
enables the user to adjust the interface view to the user’s needs.

Figure 143: The Window menu

• Preview Time Series – opens a window that plots any of the series the user
selects from Providers.

• Debug – opens a Preview Time Series window that enables a fast display of
the graphs for time series from a large dataset. To display the graph click on
the series in the Providers window.

• Providers – opens (if closed) and activates the Providers window.
• Variables – opens (if closed) and activates the Variable window.
• Workspace – opens (if closed) and activates the Workspace window.
• Output – a generic window to display outputs in the form of text; useful with
certain plug-ins (e.g. tutorial descriptive statistics).
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• Editor – activates the editor panel (and update the main menu conse-
quently).

• Configure Window – enables the user to change the way that the window
is displayed (maximise, float, float group, minimise, minimise group). This
option is active when some window is displayed in the JD+ interface.

• Properties – opens the Properties window and displays the properties of the
marked item (e.g. time series, data source).

• Reset Windows – restores the default JDemetra+ view.
• Close Window – closes all windows that are open.
• Close All Documents – closes all documents that are open.
• Close Other Documents – closes all open documents except for the one
that is active (which is the last activated one).

• Document Groups – enables the user to create and manage document
groups.

• Documents – lists all active documents.

Help menu

All TS&view

Search option

Options

The Options window includes five main panels:

• Demetra,
• General,
• Keymap,
• Appearance
• and Miscellaneous.

They are visible in the very top of the Options window.
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Figure 144: Main sections of the Options window

Demetra panel

0.0.0.1 v2

By default, the Demetra panel is shown. It is divided into seven tabs:

• Behaviour,
• Demetra UI,
• Statistics,
• Data transfer,
• Demetra Paths,
• ProcDocumentItems,
• and Interchange.

0.0.0.2 v3

By default, the Demetra panel is shown. It is divided into three tabs::

• Common UI,
• Behaviour,
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Figure 145: Demetra panel in v2
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• and Demetra Paths.

Figure 146: Demetra panel in v3

By default, in v2, the Demetra panel is shown. It is divided into seven tabs:

• Behaviour,
• Demetra UI,
• Statistics,
• Data transfer,
• Demetra Paths,
• ProcDocumentItems,
• and Interchange.

In v3, you will just find three tabs:

• Common UI,
• Behaviour,
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Figure 147: Demetra panel in v2
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• and Demetra Paths.

Figure 148: Demetra panel in v3

Behaviour tab

The tab Behaviour defines the default reaction of JDemetra+ to some of the actions
performed by the user.

• Providers – an option to show only the data providers that are currently
available.

• Persistence – an option to restore the data sources after re-starting the ap-
plication so that there is no need to fetch them again (Persist opened Data-
Sources) and an option to restore all the content of the chart and grid tools
(Persist tools content).

271



Figure 149: The content of the Behavior tab

Figure 150: The option Providers

Figure 151: The option Persistence
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• Threading – defines how resources are allocated to the computation (Batch
Pool Size controls the number of cores used in parallel computation and
Batch Priority defines the priority of computation over other processes).
Changing these values might improve computation speed but also reduce
user interface responsiveness.

Figure 152: The option Threading

• Time Series – determines the default behaviour of the program when the
user double clicks on the data. It may be useful to plot the data, visualise
it on a grid, or to perform any pre-specified action, e.g. execute a seasonal
adjustment procedure.

Figure 153: The option Time Series

Low-level options

In v3, the option Show low-level options unable the user to access more
settings in the specification.
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Figure 154: Low level options on ARIMA specification

Demetra UI / CommonUI tab

0.0.0.3 v2

In v2, this panel is called Demetra UI.

0.0.0.4 v3

In v3, this panel is called CommonUI.
In v2, this panel is called Demetra UI.
In v3, this panel is called CommonUI.
The Demetra UI tab enables the setting of:

• A default colour scheme for the graphs (Color scheme).

• The data format (uses MS Excel conventions). For example, ###,###.####
implies the numbers in the tables and the y-axis of the graphs will be rounded
up to four decimals after the decimal point (Data format (or Observation
format in v3)).

• The default number of last years of the time series displayed in charts repre-
senting growth rates (Growth rates).
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Figure 155: The content of the Demetra UI tab
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Figure 156: CommonUI tab in v3
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Figure 157: The content of the Demetra UI tab in v2
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Figure 158: CommonUI tab in v3
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Figure 159: The option Charts

Figure 160: The option Data format

Figure 161: The option Growth rates
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• The control of the view of the window for adding pre-specified outliers. (Pre-
specified Outliers).

Figure 162: The option Pre-specified Outliers

• The visibility of the icons in the context menus (Context Menus).

Figure 163: The option Context Menus

Demetra path tab

Demetra Paths allows the user to specify the relative location of the folders where
the data can be found. In this way, the application can access data from different
computers. Otherwise, the user would need to have access to the exact path
where the data is located. To add a location, select the data provider, click the “+”
button and specify the location.
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Figure 164: The content of the Demetra Paths tab in v2
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Figure 165: The content of the Demetra Paths tab in v3
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0.0.0.5 v2

0.0.0.6 v3
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Figure 166: Statistics tab in v2
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Figure 167: SA panel
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Statistics tab

0.0.0.7 v2

0.0.0.8 v3
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The Statistics tab includes options to control:

• The number of years used for spectral analysis and for model stability
(Default Number of Last Years);

0.0.0.9 v2

Figure 168: Default Number of Last Years option in v2

0.0.0.10 v3

Figure 169: Default Number of Last Years option in v3

• The default pre-defined specification for seasonal adjustment (Seasonal Ad-
justment);

• The type of the analysis of revision history (Revision History):
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Figure 170: Seasonal Adjustment option

– FreeParameters – the Reg-ARIMA model parameters and regression coef-
ficients of the Reg-ARIMA model will be re-estimated each time the end
point of the data is changed. This argument is ignored if no Reg-ARIMA
model is fit to the series.

– Complete – the whole Reg-ARIMA model together with regressors will
be re-identified and re-estimated each time the end point of the data is
changed. This argument is ignored if no Reg-ARIMA model is fitted to the
series.

– None – the ARIMA parameters and regression coefficients of the Reg-
ARIMA model will be fixed throughout the analysis at the values esti-
mated from the entire series (or model span).

Figure 171: Revision History option in v2

• The settings for the quality measures and tests used in a diagnostic proce-
dure:

– Default components – a list of series and diagnostics that are displayed
in the SAProcessing \(→\) Output window. The list of default items can
be modified with the respective Select button (see figure below)

Figure 172: The Default components section on the Statistics tab

– Diagnostics – a list of diagnostics tests, where the user can modify the
default settings (see figure “The panel for modification of the settings for
the tests in the Basic checks section” below).
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0.0.0.11 v2

Figure 173: The Diagnostics section in v2

0.0.0.12 v3

In v3, you can find this settings in the SA panel in the tabs TramoSeats and X-13:
In v3, you can find this settings in the SA panel in the tabs TramoSeats and X-13:
To modify the settings for a particular measure, double click on a selected row (se-
lect the test’s name from the list and click on the working tools button), introduce
changes in the pop-up window and click the OK button.
To reset the default settings for a given test, select this test from the list and click
on the backspace button situated below the working tools button. The description
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Figure 174: Settings for the quality measures and tests in Tramoseats in
v3
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Figure 175: Settings for the quality measures and tests in X-13 in v3
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Figure 176: The Diagnostics section in v2
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Figure 177: Settings for the quality measures and tests in Tramoseats in
v3
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Figure 178: Settings for the quality measures and tests in X-13 in v3
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of the parameters for each quality measure and test used in a diagnostic proce-
dure can be found in the output from modelling and the output from seasonal
adjustment nodes.

Figure 179: The panel for modification of the settings for the tests in the
Basic checks section

The users can customize the diagnostics and they can specify the default settings
for different outputs. Their preferences are saved between different sessions of
JDemetra+. This new feature is accessible in the Statistics tab of the Options
panel.
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Figure 180: The settings of the output files
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Data Transfer tab

0.0.0.13 v2

The Data Transfer tab contains multiple options that define the behaviour of the
drag and drop and copy-paste actions. To change the default settings, double click
on the selected item. Once the modifications are introduced, confirm them with
the OK button.

Figure 181: The content of the Data Transfer tab in v2

0.0.0.14 v3

In v3, there is no equivalent of the Data Transfer tab.
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In v2, the Data Transfer tab contains multiple options that define the behaviour of
the drag and drop and copy-paste actions. To change the default settings, double
click on the selected item. Once the modifications are introduced, confirm them
with the OK button.

Figure 182: The content of the Data Transfer tab in v2

In v3, there is no equivalent of the Data Transfer tab.

ProcDocumentItems tab

0.0.0.15 v2

ProcDocumentItems includes a list of all reports available for processed documents
like seasonal adjustment.
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Figure 183: The content of the ProcDocumentItems tab in v2
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0.0.0.16 v3

In v3, there is no equivalent of the ProcDocumentItems tab.
In v2, ProcDocumentItems includes a list of all reports available for processed
documents like seasonal adjustment.
In v3, there is no equivalent of the ProcDocumentItems tab.

Interchange tab

0.0.0.17 v2

The Interchange tab lists the protocols that can be used to export/import infor-
mation like calendars, specifications, etc.. For the time being, the user cannot
customize the way the standard exchanges are done. However, such features
could be implemented in plug-ins.

0.0.0.18 v3

In v3, there is no equivalent of the Interchange tab.
In v2, the Interchange tab lists the protocols that can be used to export/import
information like calendars, specifications, etc.. For the time being, the user cannot
customize the way the standard exchanges are done. However, such features
could be implemented in plug-ins.
In v3, there is no equivalent of the Interchange tab.

General panel

The next section, General, allows for the customisation of the proxy settings. A
proxy is an intermediate server that allows an application to access the Internet.
It is typically used inside a corporate network where Internet access is restricted.
In JDemetra+, the proxy is used to get time series from remote servers like .Stat.

Keymap panel

Keymap provides a list of default key shortcuts to access some of the functionali-
ties and it allows the user to edit them and to define additional shortcuts.
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Figure 184: The content of the ProcDocumentItems tab in v2
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Figure 185: The content of the Interchange tab in v2
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Figure 186: The content of the Interchange tab in v2

Figure 187: The General tab
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0.0.0.1 v2

Figure 188: The Keymap tab in v2
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Figure 189: The Keymap tab in v3
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0.0.0.2 v3

SA panel

The SA panel is only available in v3.

General tab

The General tab correspond to the Statistics tab from the Demetra panel in v2.

TramoSeats and X-13 tabs

The TramoSeats and X-13 tabs correspond to the settings for the quality measures
and tests used in a diagnostic procedure in v2.
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Figure 190: SA panel
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Figure 191: Tramoseats tab
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Other panels

The Appearance and Miscellaneous panels are tabs automatically provided by the
Netbeans platform. They are not used by JDemetra+.
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GUI: data visualization and time series tools

In this chapter

This chapter describes time series generic tools available in the Graphical User
Interface:

• data visualization
• spectral analysis tools
• aggregation
• differencing
• tests

Additional chapters related to GUI features, provide information on:

• Overview
• Specific Seasonal Adjustment and Modelling features
• Output: series, parameters and diagnostics

Data visualization

Container includes basic tools to display the data. The following items are avail-
able: Chart, Grid, Growth Chart and List.
Several containers can be opened at the same time. Each of them may include
multiple time series.
Chart plots the time series as a graph. This function opens an empty window. To
display a given series drag and drop the series from the Providers window into the
empty window. More than one series can be displayed on one graph. The chart is
automatically rescaled after adding a new series.
The series to be viewed can be also dragged from the other windows (e.g. from
the Variables window) or directly from the windows that display the results of the
estimation procedure.
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Figure 192: ** Container menu**

Figure 193: Launching the Chart functionality
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Figure 194: Displaying the seasonally adjusted series on a separate chart
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To adjust the view of the chart and save it to a given location use the local menu,
which is displayed after right-clicking on the chart. The explanation of the func-
tions available for the local menu is given below.

Figure 195: Local menu basic options for the time series graph

To display the time series value at a given date, hover over it with the cursor. Once
the time series is selected by clicking on it with the right mouse button, the options
dedicated to this series are available.
A list of possible actions includes:

• Open – opens selected time series in a new window that contains Chart and
Grid panels.

• Open with – opens the time series in a separate window according to the
user choice (Chart & grid or Simple chart). The All ts views option is not
currently available.

• Save – saves the marked series in a spreadsheet file or in a text file.
• Rename – enables the user to change the time series name.
• Freeze – disables modifications of the chart.
• Copy – copies the series and allows it to be pasted to another application
e.g. into Excel.

• Paste – pastes the time series previously marked.
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Figure 196: Local menu options for chart
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• Split into yearly components – opens a window that presents the analysed
series data split by year. This chart is useful to investigate the differences in
time series values caused by the seasonal factors as it gives some information
on the existence and size of the deterministic and stochastic seasonality in
data.

• Remove – removes a time series from the chart.
• Select all – selects all the time series presented in the graph.
• Show title – option is not currently available.
• Show legend – displays the names of all the time series presented on the
graph.

• Edit format – enables the user to change the data format.
• Color scheme – allows the colour scheme used in the graph to be changed.
• Lines thickness – allows the user to choose between thin and thick lines to
be used for a graph.

• Clear – removes all the time series from the chart.
• Show all – this option is not currently available.
• Export image to – allows the graph to be sent to the printer and saved in
the clipboard or as a file in a jpg format.

• Configure – enables the user to customize the chart and series display.

Grid enables the user to display the selected time series as a table. This function
opens an empty window. To display a given series drag and drop the series from the
Providers window into the empty window. More than one series can be displayed
in one table.
To display options available for a given time series, left click on any time series’
observation.
The options available in Grid are:

• Transpose – changes the orientation of the table from horizontal to vertical.
• Reverse chronology – displays the series from the last to the first observa-
tion.

• Single time series – removes from the table all time series apart from the
selected one.

• Use color scheme – allows the series to be displayed in colour.
• Show bars – presents values in a table as horizontal bars.
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Figure 197: Launching the Grid functionality

Figure 198: Local menu options for the Grid view
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• Show crosshair – highlights an active cell.
• Zoom – option for modifying the chart size.

When none of the series is selected, the local menu offers a reduced list of options.
The explanation of the other options can be found below in the ‘Local menu options
for chart’ figure in the Container section.

Figure 199: A reduced list of options for Grid

The Growth chart tab opens an empty window. Once a given series is dropped into
it, Growth chart presents the year-over-year or period-over-period growth rates for
the selected time series. More than one series can be displayed in a table. The
growth chart is automatically rescaled after adding a new series.
A left click displays a local menu with the available options. Those that are char-
acteristic for the Growth chart are:

• Kind – displays m/m (or q/q) and y/y growth rates for all time series in the
chart (previous period and previous year options respectively). By default,
the period-over-period growth rates are shown.

• Edit last year – for clarity and readability purposes, only five of the last
years of observations are shown by default. This setting can be adjusted in
the Options section, if required.
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Figure 200: The Growth chart view with a local menu

The explanation of other options can be found below in the ‘Local menu options
for chart’ figure in the Container section.
The List tab provides basic information about the chosen time series, such as; the
start and end date, the number of observations and a sketch of the data graph.
This function opens an empty window. To display information, drag and drop the
series from the Providers window into the List window. A right click displays the
local menu with all available options. Apart from the standard options, the lo-
cal menu for List enables marking the series that match the selected frequency
(yearly, half-yearly, quarterly, monthly) by using the Select by frequency option.
An explanation of other options can be found below in the ‘Local menu options for
chart’ figure in the Container section.
For a selected series a local menu offers an extended list of options. The explana-
tion of the functions available for the local menu is given below in the ‘Local menu
options for chart’ figure in the Container section.

Spectral Analysis

Spectral graphs are available from: Tools → *Spectral analysis.
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Figure 201: A view of a list of series

Figure 202: Options available for a selected series from the list
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Figure 203: Tools for spectral analysis

Figure 204: Tools for spectral analysis
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Auto-regressive spectrum

When the first option is chosen JDemetra+ displays an empty Auto-regressive spec-
trum window. To start an analysis drag a single time series from the Providers
window and drop it into the Drop data here area.

Figure 205: Launching an auto-regressive spectrum

When displaying an Auto-regressive spectrum the number of observations, data
transformations and other options such as the specification of the frequency grid
and the order of the autoregressive polynomial (30 by default) can be specified by
opening the Window → Properties from the main menu.
The Auto-regressive-Properties window contains the following options:

• Log - log transformation of a time series;
• Differencing-transforms a data by calculating a regular (order 1,2..) or sea-
sonal (order 4, 12, depending on the time series frequency) differences;

• Differencing lag-the number of lags that the program will use to take dif-
ferences. For example, if Differencing lag=3 then the differencing filter does
not apply to the first lag (default) but to the third lag.

• Last years-a number of years at the end of the time series taken to produce
autoregressive spectrum. By default, it is 0, which means that the whole time
series is considered.

• Auto-regressive polynomial order-the number of lags in the AR model
that is used to estimate the spectral density. By default, the order of the
autoregressive polynomial is set to 30 lags.
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Figure 206: Auto-regressive spectrum’s properties
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• Resolution-the value 1 plots the spectral density estimate for the frequen-
cies 𝜔𝑗 = 2𝜋𝑗

𝑛 , where 𝑛 ∈ (−𝜋; 𝜋) is the size of the sample used to estimate
the AR model. Increasing this value, which is set to 5 by default, will increase
the precision of this grid.

Periodogram

Choose Tools →Spectral analysis → Periodogram and drag and drop a series from
the Providers window to the empty Periodogram window.

![Launching a periodogram](All_images/image5_342.jpeg)

The sample size and data transformations can be specified by opening theWindow
→ Properties, in the main menu. The Periodogram- Properties window contains the
following options:

• Log - log transformation of a time series;
• Differencing-transforms the data by calculating regular (order 1,2..) or sea-
sonal (order 4, 12, depending on the time series frequency) differences;

• Differencing lag-the number of lags that you will use to take differences.
For example, if Differencing lag=3 then the differencing filter does not apply
to the first lag (default) but to the third lag.

• Last years-the number of years at the end of the time series taken to pro-
duce periodogram. By default it is 0, which means that the whole time series
is considered.

Tukey spectrum

Choose Tools → Spectral analysis → Tukey spectrum and drag and drop a single
series from the Providers window to the empty Periodogram window.

![Launching a Tukey spectrum](All_images//image8_342.jpeg)

The Tukey spectrum estimates the spectral density by smoothing the peri-
odogram.

![An example of a Tukey spectrum](All_images/image9_342.jpeg)
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Figure 207: Example of a periodogram

Figure 208: Periodogram’s properties
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Options for the Tuckey window can be specified by opening the Window → Prop-
erties from the main menu. The Periodogram- Properties window contains the
following options:

• Log - log transformation of a time series.
• Differencing -transforms the data by calculating regular (order 1, 2..) or
seasonal (order 4, 12, depending on the time series frequency) differences.

• Differencing lag-the number of lags that you will use to take differences.
For example, if Differencing lag=3 then the differencing filter does not apply
to the first lag (default) but to the third lag.

• Taper part–parameter larger than 0 and smaller or equal to one that shapes
the curvature of the smoothing function that is applied to the auto-covariance
function.

• Window length–the size of the window that is used to smooth the auto-
covariance function. A value of zero includes the whole series.

• Window type–it refers to the weighting scheme that it is used to smooth
the auto-covariance function. Available windows types are: Square, Welch,
Tukey, Barlett, Hamming and Parzen.

Aggregation

Aggregation calculates the sum of the selected series and provides basic informa-
tion about the selected time series, including the start and end date, the number
of observations and a sketch of the data graph, in the same way as in the List func-
tionality. Aggregation opens an empty window. To sum the selected series, drag
and drop them from the Providers window into the Aggregation window. Right
click displays the local menu with the available options. The content of the local
menu depends on the panel chosen (the panel on the left that contains the list
of the series and the panel on the right that presents the graph of an aggregate).
The local menu for the list of series offers the option Select by frequency, which
marks all the series on the list that are yearly, half-yearly, quarterly or monthly
(depending on the user’s choice). The explanation of the other options can be
found below in the ‘Local menu options for chart’ figure in the Container section.
The local menu for the panel on the left offers functionalities that are analogous to
the ones that are available for the List functionalities, while the options available
for the local menu in the panel on the left are the same as the ones available in
Chart (see Container).
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Figure 209: Tukey spectrum’s properties

Figure 210: The Aggregation tool
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Differencing

The Differencing window displays the first regular differences for the selected time
series together with the corresponding periodogram and the PACF function. By
default, the window presents the results for non-seasonally and seasonally differ-
enced series (( 𝑑 = 1, 𝐷 = 1)). These settings can be changed through the
Properties window (Tools → Properties). A description of a periodogram and the
PACF function can be found here.

Figure 211: The properties of the Differencing tool

Typical results are shown below. The bottom left graph presents the partial auto-
correlation coefficients (vertical bars) and the confidence intervals. The right-click
local menu offers several functionalities for a differenced series. An explanation
of the available options can be found below in the “Local menu options for chart”
figure in the Container section.
For the Partial autocorrelation and the Periodogram panels the right-button menu
offers “a copy series” option that allows data to be exported to another application
and a graph to be printed and saved to a clipboard or as a .jpg file.

Tests

Here we describe describe the GUI access to and display of tests. The underlying
methods are detailed in this chapter
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Figure 212: The *Differencing tool

Seasonality Tests

QS test

The test can be applied directly to any series by selecting the option Statistical
Methods » Seasonal Adjustment » Tools » Seasonality Tests. This is an example of
how results are displayed for the case of a monthly series:

Figure 213: qs

It is also visible in Main results panel and in Diagnostics node when an SA process-
ing has been carried out.

Friedman test for stable seasonality

The test can be applied directly to any series by selecting the option Statistical
Methods » Seasonal Adjustment » Tools » Seasonality Tests. This is an example of
how results are displayed for the case of a monthly series:
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Figure 214: friedman

If the null hypothesis of no stable seasonality is rejected at the 1% significance
level, then the series is considered to be seasonal and the outcome of the test is
displayed in green.
It is also visible in Diagnostics node when an SA processing has been carried out.

Identification of spectral peaks

0.0.0.0.1 * In a Tukey spectrum
The test can be applied directly to any series by selecting the option Statistical
Methods » Seasonal Adjustment » Tools » Seasonality Tests. This is an example of
how results are displayed for the case of a monthly series:

Figure 215: tktest

JDemetra+ considers critical values for 𝛼 = 1% (code “T”) and 𝛼 = 5% (code “t”)
at each one of the seasonal frequencies represented in the table below, e.g. fre-
quencies 𝜋

6 ,  𝜋
3 ,  𝜋

2 ,  2𝜋
3 and

5𝜋
6 corresponding to 1, 2, 3, 4, 5 and 6 cycles per year

in this example, since we are dealing with monthly data.

0.0.0.0.2 * In an AR Spectrum
The test can be applied directly to any series by selecting the option Statistical
Methods » Seasonal Adjustment » Tools » Seasonality Tests. This is an example of
how results are displayed for the case of a monthly series:
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Figure 216: artest

JDemetra+ considers critical values for 𝛼 = 1% (code “A”) and 𝛼 = 5% (code “a”)
at each one of the seasonal frequencies represented in the table below, e.g. fre-
quencies 𝜋

6 ,  𝜋
3 ,  𝜋

2 ,  2𝜋
3 and 5𝜋

6 corresponding to 1, 2, 3, 4, 5 and 6 cycles per year
in this example, since we are dealing with monthly data.

0.0.0.0.3 * In a Periodogram
The test can be applied directly to any series by selecting the option Statistical
Methods » Seasonal Adjustment » Tools » Seasonality Tests.

Figure 217: periodtest
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GUI: SA and Modelling Features

In this chapter

This chapter covers specific Seasonal Adjustment and Modelling features. Mod-
elling refers to reg-ARIMA or Tramo when used stand alone and not as the first
(pre-adjustment) step in seasonal adjustment.
Note that the menu and window structure as well as options and results are almost
identical in both cases.
Important TOPICS

• creating a workspace
• defining and applying specifications

Additional chapters related to GUI features, provide information on:

• Overview
• Data visualization and generic time series tools
• Output: series, parameters and diagnostics

How to create a Workspace?

When you open a new session of the GUI JDemetra, a new workspace called
Workspace_1 is created.

Figure 218: Initial Workspace_1
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To create a Workspace:

1. Click on the File button
2. Then, click on New Workspace

A new Workspace called Workspace_2 is created.

Figure 219: Initial Workspace_1

Workspace Window

The workspace window displays the characteristics of a workspace but gives also
access to other peripheric routines, the results of which won’t be stored in a
workspace (as data structure)
Content of Workspace window, divided into three sections:

• Modelling (contains the default and user-defined specifications for modelling;
and the output from the modelling process)

• Seasonal adjustment (contains the default and user-defined specifications for
seasonal adjustment and the output from the seasonal adjustment process),

• Utilities (calendars and user defined variables).

Modelling

In the modelling section, you can create documents based on the reg-ARIMA
or Tramo only specification (which are the same as the ones used for the pre-
treatment phase of seasonal adjustment with X-13-ARIMA (Reg-ARIMA) and
Tramo-Seats (Tramo) and thus described in the SA chapter).
You can also use the extended airline algorithm with the plugin jdplus-highfreq-
desktop-plugin to do the pre-treatment of high frequency data.
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Figure 220: The Workspace window
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The specifications and output of the modelling procedure are displayed in the
Workspace window.

Figure 221: The Workspace window with the nodes for the modelling pro-
cedure marked

Seasonal adjustment

This window allows to set up and launch a seasonal adjustment process.
Some plugins give you additional features:

• jdplus-highfreq-desktop-plugin give you access to the extended airline algo-
rithm

• jdplus-x12plus-desktop give you access to the x12plus algorithm
• jdplus-sts-desktop and jdplus-stl-desktop give you access to the stlplus and
mstlplus algorithm

This section is divided into two parts:

• Specifications, which presents parameters of the seasonal adjustment proce-
dure.

• Output, which explains a typical output produced by the seasonal adjustment
procedure.

The specifications and output for the seasonal adjustment procedure are displayed
in the Workspace window under the Seasonal adjustment item.
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Figure 222: The Workspace window with the nodes for the seasonal ad-
justment procedure marked

Specifications Left Node

Output

Results panel

The blank zone in the figure above (on the right of the view) is the location where
JDemetra+ displays various windows. More than one window can be displayed at
the same time. Windows can overlap with each other with the foremost window
being the one in focus or active. The active window has a darkened title bar. The
windows in the results panel can be arranged in many different ways, depending
on the user’s needs. The example below shows one of the possible views of this
panel. The results of the user’s analysis are displayed in an accompanying window.
The picture below shows two panels – a window containing seasonal adjustment re-
sults (upper panel) and another one containing an autoregressive spectrum (lower
panel).
###Specifications Right-Box
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Figure 223: The Results panel filled with two windows

Statistical Methods Menu

• Anomaly Detection – allows for a purely automatic identification of regression
effects;

Figure 224: The Anomaly detection tab.

• Modelling – enables time series modelling using the Tramo and Reg-ARIMA
models;

• Seasonal adjustment – intended for the seasonal adjustment of a time series
with the Tramo-Seats and X-13ARIMA-Seats methods.

• Tools – provides access to:

– seasonality tests
– and to Direct-Indirect Seasonal adjustment tools
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Figure 225: The Modelling tab.

Figure 226: The Seasonal adjustment tab.

Direct-Indirect method

Context

Economic time series are often computed and reported according to a certain clas-
sification or a breakdown.
For example, in National Accounts total consumption expenditures are a sum of in-
dividual consumption expenditures and General Government & NPISHs consump-
tion expenditures. Therefore, the seasonally adjusted aggregates can be com-
puted either by aggregating the seasonally adjusted components (indirect adjust-
ment) or adjusting the aggregate and the components independently (direct ad-
justment). The point is that these two strategies result in different seasonally ad-
justed aggregates. As neither theoretical nor empirical evidence uniformly favours
one approach over the other, the choice of the seasonal adjustment strategy con-
cerning aggregated series depends on the user. Guidance in this field is given in
the Eurostat guidelines on seasonal adjustment (guidelines2015?).
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In GUI v2

JDemetra+ offers a Direct–Indirect Seasonal Adjustment functionality that facili-
tates the comparison of the results from these two strategies, which is launched
from the main menu.

Only in v2

This Direct-Indirect method is not implemented in v3.

Figure 227: The Direct-Indirect Seasonal Adjustment tool

To start the analysis drag and drop time series to the top-left panel. The panel on
the right presents the sum of selected series.
By going to the main menu and clicking on Window → Properties, one can specify
benchmarking options for direct-indirect comparison.
Be aware that the properties window displays the properties of an active item.
Therefore, first click on the time series graph in the picture below and then activate
the Properties window.
By default, the pre-defined Tramo-Seats specification is used (RSAfull) for seasonal
adjustment of a dataset. To change it, click on the button marked in the picture
below. This will provide you with the alternative specifications. Here the user
defined specification named My spec is chosen.
Next, run the process by clicking the button with the green arrow.
The bottom panel presents the detailed results. The seasonality test node presents
the outcome of the seasonality tests performed for the aggregated series adjusted
directly (Direct sa) and indirectly (Indirect sa). The reason for presenting these
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Figure 228: Choosing series for an analysis

Figure 229: The properties of the Direct - Indirect seasonal adjustment
functionality
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Figure 230: Choosing a specification for the analysis

Figure 231: Running a process
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tests here is that the presence of residual seasonality and calendar effects should
bemonitored, especially in the indirectly adjusted series (see (guidelines2015?)).
It might happen that the seasonality is successfully removed from the components
but it is still present in the aggregated series.

Figure 232: Seasonality tests’ results for a direct seasonal adjustment

The Differences node presents selected different results between the direct and
the indirect seasonal adjustment approaches. The Statistics section shows basic
statistics (average, standard deviation, minimum and maximum) for the relative
differences (%) between the direct and the indirect SA series. Chart contains the
graph of the differences, while Table includes the actual values. The Periodogram
section presents graphs for two spectral estimators – the periodogram and the
auto-regressive spectrum.
The Details node include the basic statistics for the relative differences between
the benchmarked and original series as well as the actual time series adjusted
directly (Sa series) and indirectly (Benchmarked Sa series).
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Figure 233: Graph presenting the differences between direct and indirect
seasonal adjustment results

Figure 234: Details of the differences between direct and indirect seasonal
adjustment results
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Defining and Applying Specifications

Conversion of X13-Arima-Seats specifications to JDemetra+

345



GUI: Generating output

In this chapter

This chapter describes how to generate (export) output (series, parameters, diag-
nostics) directly from the Graphical User interface:
When running a SA-processing in GUI, series, parameters, diagnostics can be also
generated without opening it, using a production module called the cruncher.
Additional chapters related to GUI features, provide information on:

• Overview
• Data visualization and generic time series tools
• Specific Seasonal Adjustement and Modelling features

Output from SA Processing

Steps

1. Once a seasonal adjustment process for the dataset is performed Go to the
TOP menu bar and follow the path: SAProcessing → Output…
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2. In the Batch output window the user can specify which output items will be
saved and the folder in which JDemetra+ saves the results. It is possible to
save the results in the .txt, .csv, .xls, and .csv matrix formats. In the first
step the user should choose the output format from the list.
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3. The user may choose more than one format as the output can be generated
in different formats at the same time.

4. To display and modify the settings click on the given output format on the list.
The available options depend on the output format.

The different ouput formats

0.0.0.1 .csv

For .csv format the following options are available:

• folder (location of the file),
• file prefix (name of the file),
• presentation (controls how the output is divided into separate files)
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• and series (series included in the file).

These options are presented in the next points of this case study.

Figure 235: Options for a .csv format

The user can define the folder in which the selected results and components will
be saved (click the folder item and choose the final destination).
With the option File Prefix the user can modify the default name of the output
saved in the .csv file.
Presentation controls how the output is divided into separate files. Expand the list
to display available options:

• HTable – the output series will be presented in the form of horizontal tables
(time series in rows).

• VTable – the output series will be presented in the form of vertical tables (time
series in columns).

• List – the output series will be presented in the form of vertical tables (time
series in rows). Apart from that, for each time series each file contains in
separate columns: the data frequency, the first year and stimation span, the
first period (month or quarter) of observation span and the number of obser-
vations. The files do not include dates.
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Figure 236: Specifying a destination folder
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Figure 237: Setting a File Prefix option

Figure 238: Layout options for a .csv format
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The option Full series name is used to use the fully qualified name of the series
(workbook + sheet + name) in the output.

Figure 239: The Full series name option

The Content section presents a list of series that will be included into a set of
output files. To modify the initial settings click on the grey button in the Content
section. The CVS-series window presents two panels:

• the panel on the left includes a list of all valuable output items
• the panel on the right presents the selected output items

Mark the series and use the arrows to change the settings. Confirm your choice
with the OK button.

0.0.0.2 .csv matrix

The .csvmatrix produces the .csv file containing information about the model and
quality diagnostics of the seasonal adjustment. The user may generate the list of
default items or create their own quality report.
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Figure 240: The generated output

The user can define the folder in which the selected results and components will
be saved (click the folder item and choose the final destination).
With the option File Name the user can modify the default name of the output
saved in the .csv file.
By default, all the available items are included in the output.
Once the output settings are selected, click the OK button.

0.0.0.3 Excel

Options available for the .xls format are the same as for the .txt format with an
exception of the Layout section.

• BySeries – all results for a given time series are placed in one sheet;
• ByComponent – results are grouped by components. Each component type
is saved in a separate sheet;

• OneSheet – all results are saved in one sheet.

If the user sets the option layout to BySeries, the output will be generated as
follows:

• Series are placed in separate sheets
• Components are placed in different columns

If the user sets the option layout to ByComponent, the output will be generated
as follows:

• Components are placed in separate sheets
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Figure 241: Specifying a content of the output file
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Figure 242: Options for a .csv matrix format

• Series are placed in different columns

The option OneSheet will produce the following .xls file:

• Components and Sheets are crossed in different columns of the same sheet

By default, the series in the Excel output files are organised vertically. When the
user unmarks the check box the horizontal orientation is used.
The option Full series name is used to use the fully qualified name of the series
(workbook + sheet + name).
This option will produce the following .xls file:
The Content section presents a list of series that will be included into a set of
output files. To modify the initial settings click on the grey button in the Content
section. The Excel-series window presents two panels:

• the panel on the left includes a list of all valuable output items
• the panel on the right presents the selected output items

Mark the series and use the arrows to change the settings. Confirm your choice
with the OK button.
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Figure 243: Specifying a destination folder
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Figure 244: Setting a File Name option

0.0.0.4 .txt (only in v2)

In the case of the .txt format the only available options are folder (location of the
file) and series (results included in the output file).

0.0.0.5 CvsArray (only in v3)

For each output JDemetra+ provides information on the status of the operation.
An example is presented below.
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Figure 245: List of items available for the .csv matrix output type
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Figure 246: Validation of the .csv matrix output

Figure 247: Layout options for an Excel format
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Figure 248: An Excel file view for the BySeries option

Figure 249: An Excel file view for the ByComponent option
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Figure 250: An Excel file view for the OneSheet option
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Figure 251: The VerticalOrientation option
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Figure 252: The Full series name option

Figure 253: The generated output
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Figure 254: Specifying a content of the output file

Figure 255: Options for the .txt output
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Figure 256: Generating output - status information (here for .csv format)
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Plug-ins (GUI extensions)

JDemetra+ Graphical User Interface can be extended with plug-ins, which are com-
ponents adding specific features to the main software.
In this chapter, we cover

• Algorithms available via plug-ins
• Utility plug-ins: data providers, data formatting
• Installation procedure which consists of downloading the appropriate “*.nbm”
file and installation it with the GUI.

Algorithms available with plug-ins

Here is an overview of the algorithms which can be added by installing additional
plug-ins to the Graphical User Interface. For all the mentioned files corresponding
number of version is denoted x.y.z.

Seasonal Adjustment of Low frequency data

For low frequency (monthly, quarterly, half-yearly, quadri-monthly) data the fol-
lowing additional algorithms are available with plug-ins. Corresponding files are
located in the Incubator (latest releases). Installation of auxiliary plug-in “jdplus-
advancedsa-desktop-plugin-x.y.z.nbm” also located in the incubator is required.

Algorithm Plugin File Name
Documentation
pages

X12+
Airline based pre-adjustment and
extended X11 decomposition

jdplus-x12plus-
desktop-plugin-
x.y.z.nbm

Usage in GUI
described here

STL+
Airline based pre-adjustment and STL
(Loess) decomposition

jdplus-stl-
desktop-plugin-
x.y.z.nbm

Usage in GUI
described here
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Algorithm Plugin File Name
Documentation
pages

STS+
Airline based pre-adjustment for outlier
detection and calendar estimation,
followed by BSM modelling

jdplus-sts-
desktop-plugin-
x.y.z.nbm

Usage in GUI
described here

Seats+
Airline based pre-adjustment and Seats
decomposition

upcoming upcoming

Seasonal Adjustment of High-Frequency data

For low frequency (monthly, quarterly, half-yearly, quadri-monthly) data the follow-
ing algorithms are available with plug-ins. Corresponding files are located in the
Incubator (latest releases ). Installation of auxiliary plug-in “jdplus-advancedsa-
desktop-plugin-x.y.z.nbm” also located in the incubator is required.

Algorithm Plugin File Name
Repo /
Comments

Extended Airline Estimation
(Reg-ARIMA Modelling)

jdplus-highfreq-desktop-
plugin-x.y.z.nbm

Usage in GUI
described here

Extended Airline Decomposition
(Extended Seats)

jdplus-highfreq-desktop-
plugin-x.y.z.nbm

Usage in GUI
described here

MX12+
Extended Airline Estimation and
Extended X11 Decomposition

upcoming upcoming

MSTL+
Extended Airline Estimation and
STL Decomposition

upcoming upcoming

MSTS
Basic Structural Models

upcoming upcoming

Advanced Seasonal adjustment features for v 2.x

SA Advanced provides some experimental seasonal adjustment methods (with
Reg-ARIMA preprocessing), basic structural models, generalized airline models
and airline + seasonal noise models (called mixed airline).
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- gairline: generalized airline model
- mairline: mixed airline model
- mixedfreq: mixed frequencies seasonal adjustment
- sssts: Seasonal specific structural time series
- sts: Structural time series

Benchmarking

The plug-in is common for benchmarking and temporal disaggregation.
In version 3.x, the plug-in file (“jdplus-benchmarking-desktop-plugin-x.y.z.nbm”)
is available here for download. Usage in GUI is described in this chapter.
In version 2.x, the plug-in file (“nbdemetra-benchmarking-2.2.2.nbm”) is available
here for download. Usage in GUI is described in this chapter.

Method Plug-in for Version 2 Plug-in for version 3
Denton ✔ ✔
Cholette ✔ ✔
Cholette Multi-variate ✔ ✖
Cubic Splines ✖ ✔
Grp ✖ ✔
Calendarization ✔ ✖

Temporal Disaggregation

The plug-in is common for benchmarking and temporal disaggregation.

Method Plug-in for Version 2 Plug-in for Version 3
Regression Models* ✔ ✔
Model-based Denton ✖ ✔

In version 3.x, the plug-in file (“jdplus-benchmarking-desktop-plugin-x.y.z.nbm”)
is available here for download. Usage in GUI is described in this chapter
In version 2.x, the plug-in file (“nbdemetra-benchmarking-2.2.2.nbm”) is available
here for download. Usage in GUI is described in this chapter
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Nowcasting

In version 3.x, nowcasting are available via the rjd3nowcasting package.
In version 2.x, the plug-in file (“nbdemetra-dfm-2.2.3.nbm”) is available here for
download. Usage in GUI is described on this wiki page

Utility plug-ins

Fetching time series from web services (SDMX)

The SDMX plug-in aloows to import time series from SDMX website to JDemetra+
by querying web services or parsing files.
Documentation (made for version 2. but quasi-identical in version 3.x) is available
on this wiki page.
In version 3.x, the plug-in file (“jdplus-sdmx-desktop-plugin-x.y.z.nbm”) is avail-
able here for download.
In version 2.x, the plug-in file (“jdplus-sdmx-desktop-plugin-x.y.z.nbm”) is avail-
able here for download.

Manual fine tuning in Seasonal Adjustment

The following plug-in was developed by the Deutsche Bundesbank (BBK). For the
moment it is only available for version 2.x.

• CompRes: The plug-in CompRes supports the controlled current adjustment
approach. It pro the storage of the current components and offers graph-
ical tools to compare forecasted and re-estimated figures. Furthermore, a
pre-defined summary of the output containing the most important quality
measures can be exported to HTML files.
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Chain linked Indices

The following plug-ins were developed by the Deutsche Bundesbank (BBK). For the
moment they are only available for version 2.x.

• KIX: The plug-in KIX (German for chain-linked index) has been designed to
facilitate the handling of this index type. It offers addition and subtraction of
two or more chain-linked time series as well as the computation of contribu-
tions of growth.

• KIX2.0: KIX 2.0 offers addition and subtraction of two or more chain-linked
time series as well as the computation of contributions of growth following
the concept of annual overlap. Contributions to growth are calculated with
the partial contribution to growth approach.

• KIXE: KIX_E offers addition and subtraction of two or more chain-linked time
series as well as the computation of contributions of growth following the
concept of one-period overlap. Contributions to growth are calculated with
the aid of the Ribe (1999) contribution to growth approach.

• KIX: The program KIX-CC offers for continuously chain-linked indices the ag-
gregation or disaggregation of two or more indices, or the calculation of con-
tributions to growth.

Calendar regressors wrangling

The following plug-in was developed by the Deutsche Bundesbank (BBK). For the
moment it is only available for version 2.x.

• TransReg: The plug-in TransReg allows the user to carry out grouping and
centring of user-defined regression variables in JD+.

Specification conversion

The following plug-in was developed by the Deutsche Bundesbank (BBK). For the
moment it is only available for version 2.x.

• Xlsx2Ws: The plug-in Xlsx2Ws allows the converting of specific workspace
information to a xlsx file and vice versa.
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Job Vacancy Survey (JVS) Quality report (version 2)

The Quality Report (QR) Eurostat plug-in is available on this GtHub page: download
the latest version of the *.nbm file and proceed with installation as indicated in this
chapter
The description of the quality report is in this same GitHub repository here
It is commonly used by Labor Cost Index (LCI) producers across eurosystem coun-
tries.

Data base access

The following plug-ins was developed by the National bank of Belgium (NBB). It is
only available for version 2.x.

• AccessThis JDemetra+ extension is a pure java library for reading time se-
ries from MS Access databases. It currently supports versions 2000-2016
read/write and 97 read-only.Being a pure Java library, you don’t need MS Ac-
cess installed in order to read Access files.

Installation procedure

Installation from GUI
menu>tools> plug-ins
The Plugins window includes five panels: Updates, Available plugins, Downloaded,
Installed and Settings, some of them however are not operational in the current
version of the software.

• The Updates panel offers the user the option to manually check if some up-
dates of the already installed plugins are available. This functionality, how-
ever, is currently not operational for the JDemetra+ plugins.

• The Available plugins panel allows the downloading of all plugins that are re-
lated to JDemetra+. This functionality, however, is currently not operational
for the JDemetra+ plugins.

• The Downloaded panel is designed for the installation of new plugins from a
local machine. This process in explained in more detail below.
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• The Settings panel is designated for adding update centres, which are the lo-
cations that hold plugins. For each centre the user can specify proxy settings
and a time interval to automatically check for any updates. At the moment
this functionality is not operational for the JDemetra+ plugins.

Installation of the new plugins from the local machine can be done from the Plugin
functionality activated from the Tools menu.

Activation of the Plugin functionality from the Tools menu
To start the process, go to the Downloaded panel and click on the Add Plugins…
option. Next the user should select the plugins from the folder in which the plugins
have been saved and click the OK button.
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The Downloaded panel

Choice of available plugins
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The new plugin is now visible in the panel.

*
A downloaded plugin
Click on it and choose the Install button to start the installation procedure.
There is a wizard that allows the user to install the marked plugin(s). In the first
step choose Next to continue or Cancel to terminate the process.
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Installation wizard window
Next, mark the terms of agreements and choose Install.

375



Initiating installation process
If you encounter a warning with the plungins unsigned. It’s normal, you can click
on Continue
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Warning with the unsigned plungins
Then the process is started.
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Installation in progress
After a while JDemetra+ will provide an update in the installation process. Click
Finish to close the window and restart JDemetra+.
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Installation completed
Once the process is finished, the newly installed plugin is automatically integrated
within the software. The picture below compares the view of the Workspace win-
dow before (on the left) and after (on the right) the installation of the NbDemetra-
ODBC plugin.
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The impact of the plugin on the interface
The list of all installed plugins is displayed in the fourth panel. Tomodify the current
settings mark the plugin (by clicking the checkbox in the Select column) and chose
an action.
The following options are available:

• Activate – activates the marked plugin if it is currently inactive. The option
is available for inactive plugins (see the picture below);

• Deactivate – deactivates the marked plugin if it is currently active. The
option is available for active plugins (see the picture below);

• Uninstall – uninstalls the marked plugin.

Inactive plugins can be activated or uninstalled.
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Active plugins can be deactivated or uninstalled
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List of plugins – deactivation
There is a wizard that allows the user to activate/deactivate/uninstall the marked
plugin(s). The example below illustrates the deactivation process. In the first step
the user is expected to confirm or cancel the deactivation.

Plugin’s deactivation process
In the second step the user should decide if the software will be restarted imme-
diately after the uninstallation is completed or not.
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The final step of the installation procedure
It is possible to delay the restart of the application, although the restart is neces-
sary to complete the process.
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Default Plugins

Default Plugins in v 3.x

Plug-ins-default-v3.png

Default Plugins in v 2.2.4

Name CategoryDescription
NbDemetra
– Anomaly
detection

SA
core
algo-
rithms

Identification of outliers

NbDemetra
– Spread-
sheet

IO (In-
put/output)

Time series providers for spreadsheet (Excel, OpenOffice)

NbDemetra
– Common

IO (In-
put/output)

Common time series providers, like .xml and .txt
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Name CategoryDescription
NbDemetra
– JDBC

IO (In-
put/output)

Time series provider for the JDBC sources

NbDemetra
– ODBC

IO (In-
put/output)

Time series provider for the ODBC sources

NbDemetra
– SDMX

IO (In-
put/output)

Time series provider for SDMX files

NbDemetra
– Core

SA
core
algo-
rithms

Encapsulation of the core algorithms

NbDemetra
– UI

SA
core
algo-
rithms

Basic graphical components

NbDemetra
– Branding

SA
core
algo-
rithms

NbDemetra
– SA

SA
core
algo-
rithms

Default SA framework, including Tramo-Seats and
X-13ARIMA-Seats. This implementation can lead to small
differences in comparison with the original programs.

This list is displayed in the Installed panel. This panel is available from the Plugin
functionality and it is activated from the Tools menu.
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Cruncher and quality report

In this chapter

The sections below describe how to

• automate a Seasonal adjustment estimation process
• update a workspace when new data is available
• export output (series, diagnostics, parameters)
• generate a quality report usable for selective editing (manual fine tuning)

Automate estimation with the cruncher

The cruncher is an additional “executable” module. It can be launched via R or
SAS for example.
Objectives of the cruncher:

• update a JDemetra+ workspace (with a selected revision policy)
• export the results (series,diagnostics and parameters)

without having to open the graphical interface and operate manually. Suitable for
a production process.

Installation procedure

• Download the cruncher

Available here https://github.com/jdemetra/jwsacruncher/releases
Click on the zip code line of the latest release

• Unzip locally (or on server)
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Help pages

Documentation is available here or click on the wiki icon on the GitHub page https:
//github.com/jdemetra/jwsacruncher/wiki

Running the cruncher in R

Two R packages are currently available

• rjwsacruncher (on CRAN): workspace update and output production
• JDCruncheR (on CRAN): adds a quality report

Installation

install.packages(c("rjwsacruncher", "JDCruncheR"))

Loading

library("rjwsacruncher")
library("JDCruncheR")

Connecting the Cruncher module

To connect the cruncher to the R package, the path to the bin directory containing
the cruncher.bat file must be specified. This directory is available once the zip
file has been unzipped. For example:

options(cruncher_bin_directory = "C:/Software/jwsacruncher-3.4.0/jdemetra-cli-3.4.0/bin")
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Updating a workspace with rjwsacruncher

Running estimations

General context: two use cases

• Run first or complete estimation of seasonally adjusted series (from raw series
and parameters contained in the workspace)

• Apply a revision policy to updated raw series

The function cruncher_and_param() allows to do that:

cruncher_and_param(
workspace = "D:/my_folder/my_ws.xml",
rename_multi_documents = FALSE,
policy = "lastoutliers", # name of the revision policy
log = my_log_file.txt

)

To use the documentation, compute help() or ?function:

?cruncher_and_param
help(cruncher_and_param)

Before running SA estimations, set the export options.

Additional options

The function cruncher_and_param() calls the cruncher with the param file created
by the function create_param_file(). So you can add arguments to this function
according to the needs of your workspace.
For example:

• paths_path to add relative paths
• v3 to specify if your workspace was created in v3
• others arguments you can find here
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Configuring output options

After updating the workspace with the selected revision policies, the cruncher gen-
erates output - series (.csv files) - diagnostics and parameters (demetra_m.csv
file)
These files will be created in the workspace’s repository, sub-repository ’Output”

path <- "My_Workspace/Output/SAProcessing"

Selecting time series to export

# returns names of the currently exported series
getOption("default_tsmatrix_series")
# example of setting this option
options(default_tsmatrix_series = c("sa", "sa_f"))
# only seasonally adjusted series ("sa") and its forecasts ("sa_f") will be exported

Selecting diagnostics and parameters to export

# returns names of the currently exported diagnostics and parameters
getOption("default_matrix_item")
# example of setting this option
options(default_matrix_item = c(

"likelihood.aic",
"likelihood.aicc",
"likelihood.bic",
"likelihood.bicc"

))

Exportable Diagnostics

x13
tramo seats
what is not relevant in each case
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Quality Report with JDCruncheR

The JDCruncheR package:

• computes a quality score from the diagnostics produced by JDemetra+
• creates a quality report

Main steps

The three main functions of the package are:

• extract_QR() to extract the quality report from the .csv file (demetra_m.csv)
that contains all JD+ diagnostics;

• compute_score() to compute a weighted score based on the diagnostics
• export_xlsx() to export the quality report.

# choose the demetra_m.csv file generated by the cruncher
QR <- extract_QR()
QR

?compute_score # to see how the score is calculated (formula)
QR <- compute_score(QR,

n_contrib_score = 3
)

QR

QR <- sort(QR, decreasing = TRUE, sort_variables = "score")
export_xlsx(QR,

file_name = "U:/quality_report.xls"
)

Piling up results

When working with several workspaces or Seasonal adjustment processings (SAP)
within a given workspace, quality reports can be piled up with the function rbind()
or by creating a mQR_matrix object with the function mQR_matrix()
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QR1 <- extract_QR()
QR2 <- extract_QR()
mQR <- mQR_matrix(QR1, QR2)
mQR
# naming each object
names(mQR) <- c("report_1", "report_2")
# Equivalent to:
mQR <- mQR_matrix(report_1 = QR1, report_2 = QR2)
mQR

# score calculation for all reports
mQR <- compute_score(mQR,

n_contrib_score = 3
)
export_xlsx(mQR,

export_dir = "U:/"
)

Conditionnal score

Missing values can be ignored and conditions can be set for indicators:

# oos_mse weight reduced to 1 when the other
# indicators are "Bad" ou "Severe"
condition1 <- list(

indicator = "oos_mse",
conditions = c(

"residuals_independency",
"residuals_homoskedasticity",
"residuals_normality"

),
conditions_modalities = c("Bad", "Severe")

)
BQ <- compute_score(BQ,

n_contrib_score = 5,
conditional_indicator = list(condition1),
na.rm = TRUE

)
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Customize the score computation

Practical steps if you want to customize the score computation (see package doc-
umentation in R)

• select your indicators of interest
• adjust “good”, “uncertain”, “bad”, “severe”
• by default good=0, uncertain=1, bad or severe=3

List of exportable series

Some available output series will be different when using X-13-ARIMA or Tramo-
Seats.
each concept : output name in outout chapter
Here: ow to get a given concetp
x13
tramo seats
what is not relevant in each case

List of exportable diagnostics and parameters

Some parameters and available diagnostics will be different when using X-13-
ARIMA or Tramo-Seats.
each concept : output name in outout chapter
Here: ow to get a given concetp
x13
tramo seats
what is not relevant in each case

options(
default_matrix_item =

c(
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"period", "span.start", "span.end", "span.n", "span.missing",
"espan.start", "espan.end", "espan.n", "log", "adjust", "regression.lp",
"regression.ntd", "regression.nmh", "regression.td-derived",
"regression.td-ftest", "regression.easter", "regression.nout",
"regression.noutao", "regression.noutls", "regression.nouttc",
"regression.noutso", "regression.td(*):4", "regression.out(*)",
"regression.user(*)", "likelihood.neffectiveobs", "likelihood.np",
"likelihood.logvalue", "likelihood.adjustedlogvalue", "likelihood.ssqerr",
"likelihood.aic", "likelihood.aicc", "likelihood.bic", "likelihood.bicc",
"residuals.ser", "residuals.ser-ml", "residuals.mean", "residuals.skewness:3",
"residuals.kurtosis:3", "residuals.dh", "residuals.lb", "residuals.lb2:3",
"residuals.seaslb", "residuals.bp", "residuals.bp2", "residuals.seasbp",
"residuals.nudruns", "residuals.ludruns", "residuals.nruns",
"residuals.lruns", "arima", "arima.mean", "arima.p", "arima.d",
"arima.q", "arima.bp", "arima.bd", "arima.bq", "arima.phi(*)",
"arima.bphi(*)", "arima.th(*)", "arima.bth(*)", "decomposition.seasonality",
"decomposition.parameters_cutoff", "decomposition.model_changed",
"decomposition.tvar-estimator", "decomposition.tvar-estimate",
"decomposition.tvar-pvalue", "decomposition.savar-estimator",
"decomposition.savar-estimate", "decomposition.savar-pvalue",
"decomposition.svar-estimator", "decomposition.svar-estimate",
"decomposition.svar-pvalue", "decomposition.ivar-estimator",
"decomposition.ivar-estimate", "decomposition.ivar-pvalue", "decomposition.tscorr-estimator",
"decomposition.tscorr-estimate", "decomposition.tscorr-pvalue",
"decomposition.ticorr-estimator", "decomposition.ticorr-estimate",
"decomposition.ticorr-pvalue", "decomposition.sicorr-estimator",
"decomposition.sicorr-estimate", "decomposition.sicorr-pvalue",
"decomposition.ar_root(*)", "decomposition.ma_root(*)", "method",
"variancedecomposition.cycle", "variancedecomposition.seasonality",
"variancedecomposition.irregular", "variancedecomposition.tdh",
"variancedecomposition.others", "variancedecomposition.total",
"diagnostics.logstat", "diagnostics.levelstat", "diagnostics.fcast-insample-mean",
"diagnostics.fcast-outsample-mean", "diagnostics.fcast-outsample-variance",
"diagnostics.seas-lin-f", "diagnostics.seas-lin-qs", "diagnostics.seas-lin-kw",
"diagnostics.seas-lin-friedman", "diagnostics.seas-lin-periodogram",
"diagnostics.seas-lin-spectralpeaks", "diagnostics.seas-si-combined",
"diagnostics.seas-si-evolutive", "diagnostics.seas-si-stable",
"diagnostics.seas-res-f", "diagnostics.seas-res-qs", "diagnostics.seas-res-kw",
"diagnostics.seas-res-friedman", "diagnostics.seas-res-periodogram",
"diagnostics.seas-res-spectralpeaks", "diagnostics.seas-res-combined",
"diagnostics.seas-res-combined3", "diagnostics.seas-res-evolutive",
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"diagnostics.seas-res-stable", "diagnostics.seas-i-f", "diagnostics.seas-i-qs",
"diagnostics.seas-i-kw", "diagnostics.seas-i-periodogram", "diagnostics.seas-i-spectralpeaks",
"diagnostics.seas-i-combined", "diagnostics.seas-i-combined3",
"diagnostics.seas-i-evolutive", "diagnostics.seas-i-stable",
"diagnostics.seas-sa-f", "diagnostics.seas-sa-qs", "diagnostics.seas-sa-kw",
"diagnostics.seas-sa-friedman", "diagnostics.seas-sa-periodogram",
"diagnostics.seas-sa-spectralpeaks", "diagnostics.seas-sa-combined",
"diagnostics.seas-sa-combined3", "diagnostics.seas-sa-evolutive",
"diagnostics.seas-sa-stable", "diagnostics.seas-sa-ac1", "diagnostics.td-sa-all",
"diagnostics.td-sa-last", "diagnostics.td-i-all", "diagnostics.td-i-last",
"diagnostics.td-res-all", "diagnostics.td-res-last", "diagnostics.ic-ratio-henderson",
"diagnostics.ic-ratio", "diagnostics.msr-global", "diagnostics.msr(*)",
"decomposition.trendfilter", "decomposition.seasfilter", "m-statistics.m1",
"m-statistics.m2", "m-statistics.m3", "m-statistics.m4", "m-statistics.m5",
"m-statistics.m6", "m-statistics.m7", "m-statistics.m8", "m-statistics.m9",
"m-statistics.m10", "m-statistics.m11", "m-statistics.q", "m-statistics.q-m2",
"diagnostics.basic checks.definition:2", "diagnostics.basic checks.annual totals:2",
"diagnostics.visual spectral analysis.spectral seas peaks", "diagnostics.visual spectral analysis.spectral td peaks",
"diagnostics.regarima residuals.normality:2", "diagnostics.regarima residuals.independence:2",
"diagnostics.regarima residuals.spectral td peaks:2", "diagnostics.regarima residuals.spectral seas peaks:2",
"diagnostics.outliers.number of outliers:2", "diagnostics.out-of-sample.mean:2",
"diagnostics.out-of-sample.mse:2", "diagnostics.m-statistics.q:2",
"diagnostics.m-statistics.q-m2:2", "diagnostics.seats.seas variance:2",
"diagnostics.seats.irregular variance:2", "diagnostics.seats.seas/irr cross-correlation:2",
"diagnostics.residual seasonality tests.qs test on sa:2", "diagnostics.residual seasonality tests.qs test on i:2",
"diagnostics.residual seasonality tests.f-test on sa (seasonal dummies):2",
"diagnostics.residual seasonality tests.f-test on i (seasonal dummies):2",
"diagnostics.combined seasonality test.combined seasonality test on sa:2",
"diagnostics.combined seasonality test.combined seasonality test on sa (last 3 years):2",
"diagnostics.combined seasonality test.combined seasonality test on irregular:2",
"diagnostics.residual trading days tests.f-test on sa (td):2",
"diagnostics.residual trading days tests.f-test on i (td):2",
"diagnostics.quality"

)
)
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R packages

In this chapter

Core JDemetra+ Java algorithms can be accessed in R. This chapter provides an
overview of the suite of R packages related to JDemetra+: rjdverse.
Readme pages, GitHub pages and sometimes vignettes relative to each package
provide a detailed description of all available functions: objectives, arguments,
output and examples. They are reachable from the rjdverse main page.
The corresponding GitHub pages are directly linked to this documentation when-
ever their use in a selected algorithm is mentioned. More details on specific func-
tions are available in the relevant chapters of the Algorithm part

Installing Packages

All R packages related to JDemetra+ (v3.x or v2.x) are available from the rjdverse
Github page.
They can be installed from - GitHub - r-universe - CRAN (for some of them)
As explained in the corresponding Readme files on Github.

Configuration needed

• To run packages based on version 3.x: Java 21 or higher: how to get a portable
Java and link it with R on your computer is explained here

• To run packages based on version 2.x: Java 8 or higher
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Algorithms available in R

Seasonal adjustment

Using JDemetra+ version 3.x

Algorithm Package Comments
X-13-ARIMA rjd3x13 Reg-ARIMA and X-11 decomposition

available independently
Extended X-11 rjd3x11plus Extended for high-frequency

(infra-monthly) data and Trend
estimation with local polynomial filters

Tramo-Seats rjd3tramoseats Tramo available independently
Extended Tramo rjd3highfreq Extended for high-frequency data
Extended Seats rjd3highfreq Extended for high-frequency data
STL+ rjd3stl Airline based preadjustment and

high-frequency data extension
Basic Structural
Models

rjd3sts State space framework

Version 3.x includes Revision Policies in X-13 and Tramo-Seats.
More details on functions parameters and retrieving output in the chapter dedi-
cated to Seasonal Adjustment

Using JDemetra+ version 2.x

Algorithm Package Comments
X-13-ARIMA RJDemetra Reg-ARIMA and X-11 decomposition

available independently
Tramo-Seats RJDemetra Tramo available independently

Filtering and Trend estimation
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Algorithm Package
Moving average functions rjd3filters
Local Polynomial Trend Estimation rjd3filters, rjd3x11plus

Benchmarking

Algorithm Package
Denton rjd3bench
Cholette rjd3bench
Cubic splines rjd3bench
GRP (Growth Rate Preservation) rjd3bench

Temporal Disaggregation:

Algorithm Package
Chow-Lin, Fernandez and Litterman rjd3bench
Model-Based Denton rjd3bench
Autoregressive Distributed Lag (ADL) models rjd3bench
Reverse regression rjd3bench

rjd3bench

Reconciliation and multivariate temporal disaggregation

Algorithm Package
Multivariate Cholette rjd3bench

Calendarization

Algorithm Package
Calendarization rjd3bench
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Nowcasting

Nowcasting with JDemetra+ is available via the rjd3nowcasting package
Documentation here

Revision analysis

Revision analysis on vintages can be performed with rjd3revision package.
Documentation here

Utility functions available in R

The packages listed below contain utility functions useful when running a seasonal
adjustment production process.

Running the cruncher and generating a quality report

JDemetra+ cruncher is an executable module designed for mass production of
seasonally adjusted series .

Package JD+ version Comments
rjwsacruncher 2.x and 3.x estimation update and output
JDCruncheR 2.x and 3.x Quality Report

Wrangling JD+ workspaces

A workspace is a specific JDemetra+ data format (.xml files) allowing to use the
graphical user interface (GUI) and the cruncher.

Package JD+ version Comments
rjd3providers 3.x manage input files, update metadata
rjd3workspace 3.x set specifications, open, create, save

merge workspaces
rjdworkspace 2.x idem
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Building a production process of SA series

rjd3production package is a wrapper with functions encompassing a whole stage
of a production process
Documentation here
More information on production processes can be found here

Generating enhanced output in SA estimation

This additional packages produce enhanced plots and diagnostic outputs.

Package JD+ version Comments
rjdmarkdown 2.x enhanced print of diagnostics
ggdemetra 2.x plots based on ggplot2
ggdemetra3 3.x plots based on ggplot2
rjdqa 2.x visual dashboard on one series
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Part III

Methods
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This part provides underlying methodological background on all the algorithms
featured in JDemetra+.
Practical guidance on how to use these algorithms can be found here, whereas
detailed description of all the available tools allowing to use them can be found in
the Tools part of this book.
In this part:

• Spectral analysis tools
• Tests for seasonality and residuals
• Reg-ARIMA modelling
• X-11: moving average based decomposition
• Seats: ARIMA model based decomposition
• STL: Loess based decomposition
• Structural time series and state space framework
• Seasonal Adjustment of High-Frequency Data
• Trend Estimation
• Benchmarking and temporal disaggregation
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Spectral Analysis Concepts and Tools

In this chapter

This chapter provides some guidance on spectral analysis in order to understand
the spectral analysis tools available in JDemetra+ Graphical User Interface.

Spectral analysis concepts

A stationary time series 𝑥𝑡 with mean 𝜇 and autocovariance 𝛾(𝑘) = 𝐸((𝑥𝑡 −
𝜇)(𝑥𝑡−𝑘 − 𝜇)) = can be described as a weighted sum of periodic trigonometric
functions: 𝑠𝑖𝑛(𝜔𝑡) and 𝑐𝑜𝑠(𝜔𝑡), where 𝜔 = 2∗𝑝𝑖

𝑇 denotes frequency. Spectral
analysis investigates this frequency domain representation of 𝑥𝑡 to determine how
important cycles of different frequencies are in accounting for the behaviour of
𝑥𝑡.

Assuming that the autocovariances 𝛾(𝑘) are absolutely summable(∑∞
𝑘=−∞ |𝛾(𝑘)| <

∞), the Auto-Covariance Generating Function is given by the following equations
(HAMILTON, J.D. (1994)).

𝑎𝑐𝑔𝑓(𝑧) =
∞
∑

𝑘=−∞
𝛾(𝑘)𝑧𝑘 (0.1)

where 𝑧 denotes a complex scalar.
Once Equation 0.54 is divided by 𝜋 and evaluated at some 𝑧= 𝑒−𝑖𝜔 = 𝑐𝑜𝑠𝜔 −
𝑖𝑠𝑖𝑛𝜔, where 𝑖 =

√
−1 and 𝜔 is a real scalar, −∞ < 𝜔 < ∞, the result of this

transformation is called a population spectrum 𝑓(𝜔)for 𝑥𝑡, given in Equation 0.25
(HAMILTON, J.D. (1994)).

𝑓(𝜔) = 1
𝜋

∞
∑

𝑘=−∞
𝑒−𝑖𝑘𝜔𝛾(𝑘) (0.2)
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Therefore, the analysis of the population spectrum in the frequency domain is
equivalent to the examination of the autocovariance function in the time domain
analysis; however it provides an alternative way of inspecting the process. Be-
cause 𝑓(𝜔)dω is interpreted as a contribution to the variance of components with
frequencies in the range (𝜔, 𝜔 + 𝑑𝜔), a peak in the spectrum indicates an impor-
tant contribution to the variance at frequencies near the value that corresponds
to this peak.

As 𝑒−𝑖𝜔 = 𝑐𝑜𝑠𝜔 − 𝑖𝑠𝑖𝑛𝜔, the spectrum can be also expressed as in Equa-
tion 0.55.

𝑓(𝜔) = 1
𝜋

∞
∑

𝑘=−∞
(𝑐𝑜𝑠𝜔𝑘 − 𝑖𝑠𝑖𝑛𝜔𝑘)𝛾(𝑘) (0.3)

Equation 0.55 can be presented as:

𝑓(𝜔) = 1
𝜋[ 𝛾(0) + 2

∞
∑
𝑘=1

𝛾(𝑘)𝑐𝑜𝑠ωk] (0.4)

This implies that if autocovariances are absolutely summable the population spec-
trum exists and is a continuous, real-valued function of 𝜔. Due to the properties
of trigonometric functions (cos(−𝜔𝑘) = cos(ωk) and cos(𝜔+2𝜋𝑗)𝑘 = 𝑐𝑜𝑠(𝜔𝑘))
the spectrum is a periodic, even function of 𝜔, symmetric around 𝜔 = 0. There-
fore, the analysis of the spectrum can be reduced to the interval (−𝜋, 𝜋). The
spectrum is non-negative for all 𝜔 ∈ (−𝜋, 𝜋).
The shortest cycle that can be distinguished in a time series lasts two periods.
The frequency which corresponds to this cycle is 𝜔 = 𝜋 and is called the Nyquist
frequency. The frequency of the longest cycles that can be observed in the time
series with 𝑛 observations is 𝜔 = 2𝜋

𝑛 and is called the fundamental (Fourier) fre-
quency.

Note that if 𝑥𝑡 is a white noise process with zero mean and variance 𝜎2, then
for all |𝑘| > 0 𝛾(𝑘) = 0 and the spectrum of 𝑥𝑡 is constant (𝑓(𝜔) = 𝜎2

𝜋 ) since
each frequency in the spectrum contributes equally to the variance of the process
(BROCKWELL, P.J., and DAVIS, R.A. (2002)).
The aim of spectral analysis is to determine how important cycles of different fre-
quencies are in accounting for the behaviour of a time series. Since spectral anal-
ysis can be used to detect the presence of periodic components, it is a natural
diagnostic tool for detecting trading day effects as well as seasonal.
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Among the tools used for spectral analysis are the autoregressive spectrum and
the periodogram.
The explanations given in the subsections of this node derive mainly from DE AN-
TONIO, D., and PALATE, J. (2015) and BROCKWELL, P.J., and DAVIS, R.A. (2006).

Spectral density of an ARIMA model

Estimation

Method 1: Periodogram

For any given frequency 𝜔 the sample periodogram is the sample analog of the
sample spectrum. In general, the periodogram is used to identify the periodic com-
ponents of unknown frequency in the time series. X-13ARIMA-Seats and Tramo-
Seats use this tool for detecting seasonality in raw time series and seasonally ad-
justed series. Apart from this it is applied for checking randomness of the residuals
from the ARIMA model.
To define a periodogram, first consider a vector of complex numbers

x =
⎡
⎢
⎢
⎢
⎣

𝑥1𝑥2.
.
.

𝑥𝑛

⎤
⎥
⎥
⎥
⎦

∈ ℂ𝑛 (0.5)

where ℂ𝑛 is the set of all column vectors with complex-valued components.
The Fourier frequencies associated with the sample size 𝑛 are defined as a set of
values 𝜔𝑗 = 2𝜋𝑗

𝑛 , 𝑗 = −[𝑛−1
2 ],… , [𝑛2 ], −𝜋 < 𝜔𝑗 ≤ 𝜋, 𝑗 ∈ 𝐹𝑛, where [𝑛] denotes

the largest integer less than or equal to 𝑛. The Fourier frequencies, which are
called harmonics, are given by integer multiples of the fundamental frequency
2𝜋
𝑛 .

Now the 𝑛 vectors 𝑒𝑗 = 𝑛−1
2 (𝑒−𝑖𝜔𝑗, 𝑒−𝑖2𝜔𝑗,… , 𝑒−𝑖𝑛𝜔𝑗)′

can be defined. Vectors
𝑒1,… , 𝑒𝑛 are orthonormal in the sense that:
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e∗
𝑗e𝑘 = 𝑛−1

𝑛
∑
𝑟=1

𝑒𝑖𝑟(𝜔𝑗−𝜔𝑘) = 1, 𝑖𝑓 𝑗 = 𝑘
0, 𝑖𝑓 𝑗 ≠ 𝑘 (0.6)

where e∗
𝑗 denotes the row vector, which 𝑘𝑡ℎ component is the complex conjugate

of the 𝑘𝑡ℎ component of e𝑗. These vectors are a basis of 𝐹𝑛, so that any x ∈ ℂ𝑛

can be expressed as a sum of 𝑛 components:

x =
[𝑛

2 ]
∑

𝑗=−[𝑛−1
2 ]

𝑎𝑗e𝑗 (0.7)

where the coefficients 𝑎𝑗 = e∗
𝑗x = 𝑛−1

2 ∑𝑛
𝑡=1 𝑥𝑡𝑒−𝑖𝑡𝜔𝑗 are derived from Equa-

tion 0.30 by multiplying the equation on the left by e∗
𝑗 and using Equation 0.28.

The sequence of {𝑎𝑗, 𝑗 ∈ 𝐹𝑛} is referred as a discrete Fourier transform of x ∈ ℂ𝑛

and the periodogram 𝐼(𝜔𝑗) of x at Fourier frequency 𝜔𝑗 = 2𝜋𝑗
𝑛 is defined as the

square of the Fourier transform {𝑎𝑗} of x:

𝐼(𝜔𝑗)=|𝑎𝑗|2 = 𝑛− 1|
𝑛

∑
𝑡=1

𝑥𝑡𝑒−𝑖𝑡𝜔𝑗|2 (0.8)

From Equation 0.29 and Equation 0.30 it can be shown that a periodogram decom-
poses the total sum of squares ∑𝑛

𝑡=1 |𝑥𝑡|2 into a sum of components associated
with the Fourier frequencies 𝜔𝑗:

𝑛
∑
𝑡=1

|𝑥𝑡|
2 =

[𝑛
2 ]

∑
𝑗=−[𝑛−1

2 ]
|𝑎𝑗|2 =

[𝑛
2 ]

∑
𝑗=−[𝑛−1

2 ]
𝐼(𝜔𝑗) (0.9)

If x ∈ 𝑅𝑛, 𝜔𝑗 and−𝜔𝑗 are both in [−𝜋, −𝜋] and 𝑎𝑗 is presented in its polar form
(i.e. 𝑎𝑗 = 𝑟𝑗 exp(𝑖𝜃𝑗)), where 𝑟𝑗 is the modulus of 𝑎𝑗, then Equation 0.30 can be
rewritten in the form:
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x = 𝑎0e0 +
[𝑛−1

2 ]
∑
𝑗=1

21/2𝑟𝑗(c𝑗 cos 𝜃𝑗−s𝑗 sin 𝜃𝑗) + 𝑎𝑛/2e𝑛/2 (0.10)

The orthonormal basis for𝑅𝑛 is {e0, c1, s1,… , c[𝑛−1
2 ], s[𝑛−1

2 ], e𝑛
2 (𝑒𝑥𝑐𝑙𝑢𝑑𝑒𝑑 𝑖𝑓 𝑛 𝑖𝑠 𝑜𝑑𝑑)},

where:
e0 is a vector composed of n elements equal to 𝑛−1/2, which implies that a0e0 =
(𝑛−1 ∑𝑛

𝑡=1 𝑥𝑡,… , 𝑛−1 ∑𝑛
𝑡=1 𝑥𝑡)

′
;

c𝑗 = (𝑛2)−1/2(cos𝜔𝑗, cos 2𝜔𝑗,… , cos𝑛𝜔𝑗)
′
, 𝑓𝑜𝑟1 ≤ 𝑗 ≤ [(𝑛 − 1)

2 ]

s𝑗 = (𝑛2)
−1/2

(sin𝜔𝑗, sin 2𝜔𝑗,… , sin𝑛𝜔𝑗)
′
, 𝑓𝑜𝑟 1 ≤ 𝑗 ≤ [(𝑛 − 1)

2 ]

e𝑛/2 = (−(𝑛−1
2 ), 𝑛−1

2 ,… , −(𝑛)−1
2 ), 𝑛−1

2 )
′

Equation 0.9 can be seen as an OLS regression of 𝑥𝑡 on a constant and the trigono-
metric terms. As the vector of explanatory variables includes 𝑛 elements, the
number of explanatory variables in Equation 0.9 is equal to the number of obser-
vations. HAMILTON, J.D. (1994) shows that the explanatory variables are linearly
independent, which implies that an OLS regression yields a perfect fit (i.e. without
an error term). The coefficients have the form of a simple OLS projection of the
data on the orthonormal basis:

̂𝑎0 = 1√𝑛
𝑛

∑
𝑡=1

𝑥𝑡 (0.11)

̂𝑎𝑛/2 = 1√𝑛
𝑛

∑
𝑡=1

(−1)𝑡𝑥𝑡(only when n is even) (0.12)

̂𝑎0 = 1√𝑛
𝑛

∑
𝑡=1

𝑥𝑡 (0.13)
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̂𝛼𝑗 = 21/2𝑟𝑗 cos 𝜃𝑗 = (𝑛2)
−1/2 𝑛

∑
𝑡=1

𝑥𝑡 cos (𝑡
2𝜋𝑗
𝑛 ), 𝑗 = 1,… , [𝑛 − 1

2 ] (0.14)

̂𝛽𝑗 = 21/2𝑟𝑗 sin 𝜃𝑗 = (𝑛2)
−1/2 𝑛

∑
𝑡=1

𝑥𝑡 sin (𝑡2𝜋𝑗
𝑛 ), 𝑗 = 1,… , [𝑛 − 1

2 ] (0.15)

With Equation 0.9 the total sum of squares ∑𝑛
𝑡=1 |𝑥𝑡|2 can be decomposed into

2 × [𝑛−1
2 ] components corresponding to c𝑗 and s𝑗, which are grouped to produce

the “frequency 𝜔𝑗” component for 1 ≥ 𝑗 ≥ [𝑛−1
2 ]. As it is shown in the table

below, the value of the periodogram at the frequency 𝜔𝑗 is the contribution of the
𝑗th harmonic to the total sum of squares ∑𝑛

𝑡=1 |𝑥𝑡|2.
Decomposition of sum of squares into components corresponding to the
harmonics

Frequency
Degrees of
freedom

Sum of squares
decomposition

𝜔0 (mean) 1 𝑎2
0 = 𝑛−1(∑𝑛

𝑡=1 𝑥𝑡)2 = 𝐼(0)
𝜔1 2 2𝑟2

1 = 2|𝑎1|
2 = 2𝐼(𝜔1)

⋮ ⋮ ⋮
𝜔𝑘 2 2𝑟2

𝑘 = 2|𝑎𝑘|
2 = 2𝐼(𝜔𝑘)

⋮ ⋮ ⋮
𝜔𝑛/2 = 𝜋 (excluded if 𝑛
is odd)

1 𝑎2
𝑛/2 = 𝐼(𝜋)

Total n ∑n
t=1 x

2
t

Source: DE ANTONIO, D., and PALATE, J. (2015).
Obviously, if series were random then each component 𝐼(𝜔𝑗)would have the same
expectation. On the contrary, when the series contains a systematic sine com-
ponent having a frequency 𝑗 and amplitude 𝐴 then the sum of squares 𝐼(𝜔𝑗)
increases with 𝐴. In practice, it is unlikely that the frequency 𝑗 of an unknown
systematic sine component would exactly match any of the frequencies, for which
periodogram have been calculated. Therefore, the periodogram would show an
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increase in intensities in the immediate vicinity of 𝑗. (BOX, G.E.P., JENKINS, G.M.,
and REINSEL, G.C. (2007).
Note that in JDemetra+ the periodogram object corresponds exactly to the contri-
bution to the sum of squares of the standardised data, since the series are divided
by their standard deviation for computational reasons.
Using the decomposition presented in table above the periodogram can be ex-
pressed as:

𝐼(𝜔𝑗)=𝑟2
𝑗 = 1

2(𝛼2
𝑗 + 𝛽2

𝑗 ) = 1
𝑛(∑𝑛

𝑡=1 𝑥𝑡 cos (𝑡2𝜋𝑗
𝑛 ) )2 + 1

𝑛(∑𝑛
𝑡=1 𝑥𝑡 sin(𝑡2𝜋𝑗

𝑛 ) )2

(0.16)
where 𝑗 = 0, … , [𝑛2 ].
Since x−x are generated by an orthonormal basis, and x=𝑎0e0 Equation 0.9 can
be rearranged to show that the sum of squares is equal to the sum of the squared
coefficients:

x − 𝑎0e0 =
[(𝑛−1)/2]

∑
𝑗=1

(𝛼𝑗c𝑗 + 𝛽𝑗s𝑗) + 𝑎𝑛/2e𝑛/2 (0.17)

Thus the sample variance of 𝑥𝑡 can be expressed as:

𝑛−1
𝑛

∑
𝑡=1

(𝑥𝑡 − 𝑥)2 = 𝑛−1(
[(𝑛−1)/2]

∑
𝑘=1

2𝑟𝑗
2 + 𝑎𝑛/2

2) (0.18)

where 𝑎2
𝑛/2 is excluded if 𝑛 is odd.

The term 2𝑟𝑗
2 in Equation 0.35 is then the contribution of the 𝑗th harmonic to the

variance and Equation 0.35 shows then how the total variance is partitioned.
The periodogram ordinate 𝐼(𝜔𝑗) and the autocovariance coefficient 𝛾(𝑘) are both
quadratic forms of 𝑥𝑡. It can be shown that the periodogram and autocovariance
function are related and the periodogram can be written in terms of the sample
autocovariance function for any non-zero Fourier frequency 𝜔𝑗 (The proof is given
in BROCKWELL, P.J., and DAVIS, R.A. (2006)).
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𝐼(𝜔𝑗) = ∑
|𝑘|<𝑛

̂𝛾(𝑘) 𝑒−𝑖𝑘𝜔𝑗 = ̂𝛾(0) + 2
𝑛−1
∑
𝑘=1

̂𝛾(𝑘) cos (𝑘𝜔𝑗) (0.19)

and for the zero frequency 𝐼(0) = 𝑛|𝑥|2.
Once comparing Equation 0.36 with an expression of the spectral density of a
stationary process:

𝑓(𝜔 ) = 1
2𝜋

∞
∑

𝑘<−∞
𝛾(𝑘) 𝑒−𝑖𝑘𝜔 = 1

2𝜋[𝛾(0) + 2(
∞
∑
𝑘=1

𝛾(𝑘) cos (𝑘𝜔 ))] (0.20)

It can be noticed that a periodogram is a sample analogue of the population spec-
trum. In fact, it can be shown that the periodogram is asymptotically unbiased
but inconsistent estimator of the population spectrum 𝑓(𝜔). Therefore, the pe-
riodogram is a wildly fluctuating, with high variance, estimate of the spectrum.
However, the consistent estimator can be achieved by applying the different lin-
ear smoothing filters to the periodogram, called lag-window estimators. The lag-
window estimators implemented in JDemetra+ includes square, Welch, Tukey, Bar-
lett, Hanning and Parzen. They are described in DE ANTONIO, D., and PALATE, J.
(2015). Alternatively, the model-based consistent estimation procedure, resulting
in autoregressive spectrum estimator, can be applied.

Method 2: Autoregressive spectrum estimation

BROCKWELL, P.J., and DAVIS, R.A. (2006) point out that for any real-valued sta-
tionary process (𝑥𝑡) with continuous spectral density 𝑓(𝜔) it is possible to find
both𝐴𝑅(𝑝) and𝑀𝐴(𝑞) processes which spectral densities are arbitrarily close to
𝑓(𝜔). For this reason, in some sense, (𝑥𝑡) can be approximated by either 𝐴𝑅(𝑝)
or 𝑀𝐴(𝑞) process. This fact is a basis of one of the methods of achieving a
consistent estimator of the spectrum, which is called an autoregressive spectrum
estimation. It is based on the approximation of the stochastic process (𝑥𝑡) by an
autoregressive process of sufficiently high order 𝑝:

𝑥𝑡 = 𝜇 + (𝜙1𝐵 + … + 𝜙𝑝𝐵𝑝)𝑥𝑡 + 𝜀𝑡 (0.21)

where 𝜀𝑡 is a white-noise variable with mean zero and a constant variance.

411



The autoregressive spectrum estimator for the series 𝑥𝑡 is defined as (Definition
from ‘X-12-ARIMA Reference Manual’ (2011)).

̂𝑠(𝜔) = 10 × log10
𝜎2

𝑥

2𝜋|1 − ∑𝑝
𝑘=1

̂𝜙𝑘𝑒−𝑖𝑘𝜔|2
(0.22)

where:

• 𝜔– frequency, 0 ≤ 𝜔 ≤ 𝜋;
• 𝜎2

𝑥 innovation variance of the sample residuals;

• ̂𝜙𝑘–AR(𝑘) coefficient estimates of the linear regression of 𝑥𝑡 −𝑥 on 𝑥𝑡−𝑘 −𝑥,
1 ≤ 𝑘 ≤ 𝑝.

The autoregressive spectrum estimator is used in the visual spectral analysis tool
for detecting significant peaks in the spectrum. The criterion of visual significance,
implemented in JDemetra+, is based on the range ̂𝑠max − ̂𝑠min of the ̂𝑠(𝜔) values,
where ̂𝑠max = max𝑘 ̂𝑠(𝜔𝑘); ̂𝑠min = min𝑘 ̂𝑠(𝜔𝑘); and ̂𝑠(𝜔𝑘) is 𝑘th value of autore-
gressive spectrum estimator.
A particular value is considered to be visually significant if, at a trading day or at
a seasonal frequency 𝜔𝑘 (other than the seasonal frequency 𝜔60 = 𝜋), ̂𝑠(𝜔𝑘) is
above the median of the plotted values of ̂𝑠(𝜔𝑘) and is larger than both neighbour-
ing values ̂𝑠(𝜔𝑘−1) and ̂𝑠(𝜔𝑘+1) by at least 6

52 times the range ̂𝑠max − ̂𝑠min.
Following the suggestion of SOUKUP, R.J., and FINDLEY, D.F. (1999), JDemetra+
uses an autoregressive model spectral estimator of model order 30. This order
yields high resolution of strong components, meaning peaks that are sharply de-
fined in the plot of ̂𝑠(𝜔)with 61 frequencies. Theminimumnumber of observations
needed to compute the spectrum is set to 𝑛 = 80 for monthly data and to 𝑛 = 60
for quarterly series while the maximum number of observations considered for the
estimation is 121. Consequently, with these settings it is possible to identify up to
30 peaks in the plot of 61 frequencies. By choosing 𝜔𝑘 = πk

60 for 𝑘 = 0, 1, ..., 60
the density estimates are calculated at exact seasonal frequencies (1, 2, 3, 4, 5
and 6 cycles per year).
The model order can also be selected based on the AIC criterion (in practice it
is much lower than 30). A lower order produces the smoother spectrum, but
the contrast between the spectral amplitudes at the trading day frequencies and
neighbouring frequencies is weaker, and therefore not as suitable for automatic
detection.
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SOUKUP, R.J., and FINDLEY, D.F. (1999) also explain that the periodogram can be
used in the visual significance test as it has as good as those of the AR(30) spec-
trum abilities to detect trading day effect, but also has a greater false alarm rate,
which is defined as the fraction of the 50 replicates for which a visually significant
spectral peak occurred at one of the trading day frequencies being considered in
the designated output spectra (SOUKUP, R.J., and FINDLEY, D.F. (1999)).

Method 3: Tukey spectrum

The Tukey spectrum belongs to the class of lag-window estimators. A lag window
estimator of the spectral density 𝑓(𝜔) = 1

2𝜋 ∑∞
𝑘<−∞ 𝛾(𝑘)𝑒𝑖𝑘𝜔 is defined as fol-

lows:

̂𝑓𝐿(𝜔) = 1
2𝜋 ∑

|ℎ|≤𝑟
𝑤(ℎ/𝑟) ̂𝛾(ℎ)𝑒𝑖ℎ𝜔

where ̂𝛾(.) is the sample autocovariance function, 𝑤(.) is the lag window, and 𝑟
is the truncation lag. |𝑤(𝑥)| is always less than or equal to one, 𝑤(0) = 1 and
𝑤(𝑥) = 0 for |𝑥| > 1. The simple idea behind this formula is to down-weight
the autocovariance function for high lags where ̂𝛾(ℎ) is more unreliable. This esti-
mator requires choosing 𝑟 as a function of the sample size such that 𝑟/𝑛𝑎𝑟𝑟𝑜𝑤0
and 𝑟 → ∞ when 𝑛𝑎𝑟𝑟𝑜𝑤∞ . These conditions guarantee that the estimator
converges to the true density.
JDemetra+ implements the so-called Blackman-Tukey (or Tukey-Hanning) estima-
tor, which is given by 𝑤(ℎ/𝑟) = 0.5(1 + 𝑐𝑜𝑠(𝜋ℎ/𝑟)) if |ℎ/𝑟| ≤ 1 and 0 other-
wise.
The choice of large truncation lags 𝑟 decreases the bias, of course, but it also
increases the variance of the spectral estimate and decreases the bandwidth.
JDemetra+ allows the user to modify all the parameters of this estimator, including
the window function.

Identification of spectral peaks

The sections below describe the test, their practical implementation in the Graph-
ical User interface can be found here
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In order to decide whether a series has a seasonal component that is predictable
(stable) enough, these tests use visual criteria and formal tests for the peri-
odogram. The periodogram is calculated using complete years, so that the set of
Fourier frequencies contains exactly all seasonal frequencies.
The tests rely on two basic principles:

• The peaks associated with seasonal frequencies should be larger than the
median spectrum for all frequencies and;

• The peaks should exceed the spectrum of the two adjacent values by more
than a critical value.

JDemetra+ performs this test on the original series. If these two requirements
are met, the test results are displayed in green. The statistical significance of
each of the seasonal peaks (i.e. frequencies 𝜋

6 , 𝜋
3 , 𝜋

2 , 2𝜋
3 and 5𝜋

6 corresponding
to 1, 2, 3, 4 and 5 cycles per year) is also displayed. The seasonal and trading
days frequencies depends on the frequency of time series. They are shown in the
table below. The symbol 𝑑 denotes a default frequency and is described below the
table.
The seasonal and trading day frequencies by time series frequency

Number of months
per period (year) Seasonal frequency

Trading day frequency
(radians)

12 𝜋
6 , 𝜋

3 , 𝜋
2 , 2𝜋

3 , 5𝜋
6 , 𝜋 𝑑,2.714

4 𝜋
2 , 𝜋 𝑑, 1.292, 1.850, 2.128

3 𝜋 𝑑
2 𝜋 𝑑

The calendar (trading day or working day) effects, related to the variation in the
number of different days of the week per period, can induce periodic patterns in
the data that can be similar to those resulting from pure seasonal effects. From
the theoretical point of view, trading day variability is mainly due to the fact that
the average number of days in the months or quarters is not equal to a multiple of
7 (the average number of days of a month in the year of 365.25 days is equal to
365.25

12 = 30.4375 days). This effect occurs 365.25
12 × 1

7 = 4.3482 times per month:
one time for each one of the four complete weeks of each month, and a residual
of 0.3482 cycles per month, i.e. 0.3482 × 2𝜋 = 2.1878 radians. This turns out
to be a fundamental frequency for the effects associated with monthly data. In
JDemetra+ the fundamental frequency corresponding to 0.3482 cycles per month
is used in place of the closest frequency πk

60 . Thus, the quantity
𝜋×42

60 is replaced
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by 𝜔42 = 0.3482×2𝜋 = 2.1878. The frequencies neighbouring 𝜔42, i.e. 𝜔41 and
𝜔43 are set to, respectively, 2.1865 − 1

60 and 2.1865 + 1
60 .

The default frequencies (𝑑) for calendar effect are: 2.188 (monthly series) and
0.280 (quarterly series). They are computed as:

𝜔ce = 2𝜋
7 (𝑛 − 7 × [𝑛7 ]) (0.23)

where 𝑛 = 365.25
𝑠 , 𝑠 = 4 for quarterly series and 𝑠 = 12 for monthly series.

Other frequencies that correspond to trading day frequencies are: 2.714 (monthly
series) and 1.292, 1.850, 2.128 (quarterly series).
In particular, the calendar frequency in monthly data (marked in red on the figure
below) is very close to the seasonal frequency corresponding to 4 cycles per year
ω40 = 2

3𝜋 = 2.0944.

Figure 257: Periodogram with seasonal (grey) and calendar (red) frequen-
cies highlighted

This implies that it may be hard to disentangle both effects using the frequency
domain techniques.

In a Tukey spectrum

Current JDemetra+ implementation of the seasonality test is based on a 𝐹(𝑑1, 𝑑2)
approximation that has been originally proposed by Maravall (2012) for Tramo-
Seats. This test is has been designed for a Blackman-Tukey window based on a
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particular choices of the truncation lag 𝑟 and sample size. Following this approach,
we determine visually significant peaks for a frequency 𝜔𝑗 when

2𝑓𝑥(𝜔𝑗)
[𝑓𝑥(𝜔𝑗+1) + 𝑓𝑥(𝜔𝑗−1)]

≥ 𝐶𝑉 (𝜔𝑗)

where 𝐶𝑉 (𝜔𝑗) is the critical value of a 𝐹(𝑑1, 𝑑2) distribution, where the degrees
of freedom are determined using simulations. For 𝜔𝑗 = 𝜋, we have a significant
peak when 𝑓𝑥(𝜔[𝑛/2])

[𝑓𝑥(𝜔[(𝑛−1)/2])] ≥ 𝐶𝑉 (𝜔𝑗)
Two significant levels for this test are considered: 𝛼 = 0.05 (code “t”) and 𝛼 =
0.01 (code “T”).
As opposed to the AR spectrum test, which is computed on the basis of the last
120 data points, we will use here all available observations. Those critical values
have been calculated given the recommended truncation lag 𝑟 = 79 for a sample
size within the interval ∈ [80, 119] and 𝑟 = 112 for 𝑛 ∈ [120, 300] . The 𝐹
approximation is less accurate for sample sizes larger than 300. For quarterly
data, 𝑟 = 44, but there are no recommendations regarding the required sample
size.
Practical implementation in GUI is detailed here

In AR Spectrum definition

The estimator of the spectral density at frequency 𝜆 ∈ [0, 𝜋] will be given by the
assumption that the series will follow an AR(p) process with large 𝑝. The spectral
density of such model, with an innovation variance 𝑣𝑎𝑟(𝑥𝑡) = 𝜎2

𝑥, is expressed
as follows:

10× 𝑙𝑜𝑔10𝑓𝑥(𝜆) = 10× 𝑙𝑜𝑔10
𝜎2

𝑥
2𝜋|𝜙(𝑒𝑖𝜆)|2 = 10×𝑙𝑜𝑔10

𝜎2
𝑥

2𝜋|1 − ∑𝑝
𝑘=1 𝜙𝑘𝑒𝑖𝑘𝜆)|2

where:

• 𝜙𝑘 denotes the AR(k) coefficient ;

• 𝑒−𝑖𝑘𝜆 = 𝑐𝑜𝑠 (−𝑖𝑘𝜆) + 𝑖𝑠𝑖𝑛 (−𝑖𝑘𝜆).
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Soukup and Findely (1999) suggest the use of p=30, which in practice much larger
than the order that would result from the AIC criterion. The minimum number of
observations needed to compute the spectrum is set to n=80 for monthly data
(or n=60) for quarterly series. In turn, the maximum number of observations con-
sidered for the estimation is n=121. This choice offers enough resolution, being
able to identify a maximum of 30 peaks in a plot of 61 frequencies: by choosing
𝜆𝑗 = 𝜋𝑗/60,for 𝑗 = 0, 1, …, 60, we are able to calculate our density estimates at
exact seasonal frequencies (1, 2, 3, 4, 5 and 6 cycles per year). Note that 𝑥 cy-
cles per year can be converted into cycles per month by simply dividing by twelve,
𝑥/12, and to radians by applying the transformation 2𝜋(𝑥/12).
The traditional trading day frequency corresponding to 0.348 cycles per month
is used in place of the closest frequency 𝜋𝑗/60. Thus, we replace 𝜋42/60 by
𝜆42 = 0.348 × 2𝜋 = 2.1865. The frequencies neighbouring 𝜆42 are set to 𝜆41 =
2.1865 − 1/60 and 𝜆43 = 2.1865 + 1/60. The periodogram below illustrates
the proximity of this trading day frequency 𝜆42 (red shade) and the frequency
corresponding to 4 cycles per year 𝜆40 = 2.0944. This proximity is precisely what
poses the identification problems: the AR spectrum boils down to a smoothed
version of the periodogram and the contribution of the of the trading day frequency
may be obscured by the leakage resulting from the potential seasonal peak at 𝜆40,
and vice-versa.

Figure 258: Periodogram with seasonal (grey) and calendar (red) frequen-
cies highlighted

JDemetra+ allows the user to modify the number of lags of this estimator and to
change the number of observations used to determine the AR parameters. These
two options can improve the resolution of this estimator.
The statistical significance of the peaks associated to a given frequency can be
informally tested using a visual criterion, which has proved to perform well in sim-
ulation experiments. Visually significant peaks for a frequency 𝜆𝑗 satisfy both
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conditions:

• 𝑓𝑥(𝜆𝑗)−max{𝑓𝑥(𝜆𝑗+1),𝑓𝑥(𝜆𝑗−1)}
[max𝑘 𝑓𝑥(𝜆𝑘)−min𝑖 𝑓𝑥(𝜆𝑖)] ≥ 𝐶𝑉 (𝜆𝑗), where 𝐶𝑉 (𝜆𝑗) can be set equal to

6/52 for all 𝑗
• 𝑓𝑥(𝜆𝑗) > 𝑚𝑒𝑑𝑖𝑎𝑛𝑗{𝑓𝑥(𝜆𝑗)}, which guarantees 𝑓𝑥(𝜆𝑗) it is not a local peak.

The first condition implies that if we divide the range max𝑘 𝑓𝑥(𝜆𝑘) −min𝑖 𝑓𝑥(𝜆𝑖)
in 52 parts (traditionally represented by stars) the height of each pick should be
at least 6 stars.
Seasonal and trading day frequencies by time series frequency

Number of months per
full period Seasonal frequency

Trading day frequency
(radians)

12 𝜋
6 , 𝜋

3 , 𝜋
2 , 2𝜋

3 , 5𝜋
6 , 𝜋 𝑑, 2.714

6 𝜋
3 , 2𝜋

3 , 𝜋 𝑑
4 𝜋

2 , 𝜋 𝑑, 1.292, 1.850, 2.128
3 𝜋 𝑑
2 𝜋 𝑑

Currently, only seasonal frequencies are tested, but the program allows you to
manually plot the AR spectrum and focus your attention on both seasonal and
trading day frequencies. Agustin Maravall has conducted a simulation experiment
to calculate 𝐶𝑉 (𝜆42) (trading day frequency) and proposes to set for all 𝑗 equal
to the critical value associated to the trading frequency, but this is currently not
part of the current automatic testing procedure of JDemetra+.
Practical implementation in GUI is detailed here

In a Periodogram

The periodogram 𝐼(𝜔𝑗) of X ∈ ℂ𝑛 is defined as the squared of the Fourier trans-
form

𝐼(𝜔𝑗) = 𝑎2
𝑗 = 𝑛−1|

𝑛
∑
𝑡=1

Xt𝑒−𝑖𝑡𝜔𝑗|2,
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where the Fourier frequencies 𝜔𝑗 are given by multiples of the fundamental fre-
quency 2𝜋

𝑛 :

𝜔𝑗 = 2𝜋𝑗
𝑛 ,−𝜋 < 𝜔𝑗 ≤ 𝜋

An orthonormal basis in ℝ𝑛:

{𝑒0, 𝑐1, 𝑠1, … , 𝑐[(𝑛−1)/2], 𝑠[(𝑛−1)/2] , 𝑒𝑛/2},

where 𝑒𝑛/2 is excluded if 𝑛 is odd,
can be used to project the data and obtain the spectral decomposition
Thus, the periodogram is given by the projection coefficients and represents the
contribution of the jth harmonic to the total sum of squares, as illustrated by Brock-
well and Davis (1991):

Source Degrees of freedom
Frequency 𝜔0 1
Frequency 𝜔1 2
⋮ ⋮
Frequency 𝜔𝑘 2
⋮ ⋮
Frequency 𝜔𝑛/2 = 𝜋 1
(excluded if 𝑛 is odd)
========= ======
Total n

In JDemetra+, the periodogram of X ∈ ℝ𝑛 is computed for the standardized time
series.
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Defining a F-test

Brockwell and Davis (1991, section 10.2) exploit the fact that the periodogram can
be expressed as the projection on the orthonormal basis defined above to derive
a test. Thus, under the null hypothesis:

• 2𝐼(𝜔𝑘) = ‖𝑃 ̄𝑠𝑝{𝑐𝑘,𝑠𝑘}
X‖2 ∼ 𝜎2𝜒2(2), for Fourier frequencies 0 < 𝜔𝑘 =

2𝜋𝑘/𝑛 < 𝜋
• 𝐼(𝜋) = ‖𝑃 ̄𝑠𝑝{𝑒𝑛/2}

X‖2 ∼ 𝜎2𝜒2(1), for 𝜋

Because 𝐼(𝜔𝑘) is independent from the projection error sum of squares, we can
define our F-test statistic as follows:

• 2𝐼(𝜔𝑘)
‖X−𝑃 ̄𝑠𝑝{𝑒0,𝑐𝑘,𝑠𝑘}X‖2

𝑛−3
2 ∼ 𝐹(2, 𝑛 − 3), for Fourier frequencies 0 < 𝜔𝑘 =

2𝜋𝑘/𝑛 < 𝜋
• 𝐼(𝜋)

‖X−𝑃 ̄𝑠𝑝{𝑒0,𝑒𝑛/2}X‖2
𝑛−2

1 ∼ 𝐹(1, 𝑛 − 2), for 𝜋

where:
-‖X − 𝑃 ̄𝑠𝑝{𝑒0,𝑐𝑘,𝑠𝑘}

X‖2 = ∑𝑛
𝑖=1 X

2
i − 𝐼(0) − 2𝐼(𝜔𝑘) ∼ 𝜎2𝜒2(𝑛 − 3) for Fourier

frequencies 0 < 𝜔𝑘 = 2𝜋𝑘/𝑛 < 𝜋
-‖X − 𝑃 ̄𝑠𝑝{𝑒0,𝑒𝑛/2}

X‖2 = ∑𝑛
𝑖=1 X

2
i − 𝐼(0) − 𝐼(𝜋) ∼ 𝜎2𝜒2(𝑛 − 2) for 𝜋

Thus, we reject the null if our F-test statistic computed at a given seasonal fre-
quency (different from 𝜋) is larger than 𝐹1−𝛼(2, 𝑛 − 3). If we consider 𝜋, our test
statistic follows a 𝐹1−𝛼(1, 𝑛 − 2) distribution.
The implementation of JDemetra+ considers simultaneously the whole set of sea-
sonal frequencies (1, 2, 3, 4, 5 and 6 cycles per year). Thus, the resulting test-
statistic is:

2𝐼(𝜋/6) + 2𝐼(𝜋/3) + 2𝐼(2𝜋/3) + 2𝐼(5𝜋/6) + 𝛿𝐼(𝜋)
‖X − 𝑃 ̄𝑠𝑝{𝑒0,𝑐1,𝑠1,𝑐2,𝑠2,𝑐3,𝑠3,𝑐4,𝑠4,𝑐5,𝑠5,𝛿𝑒𝑛/2}

X‖2
𝑛 − 12

11 ∼ 𝐹(11−𝛿, 𝑛−12+𝛿)

where 𝛿 = 1 if 𝑛 is even and 0 otherwise.
In small samples, the test performs better when the periodogram is evaluated as
the exact seasonal frequencies. JDemetra+ modifies the sample size to ensure
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the seasonal frequencies belong to the set of Fourier frequencies. This strategy
provides a very simple and effective way to eliminate the leakage problem.
Practical implementation in GUI is detailed here

Spectral graphs

The section below provides guidance on interpretation of spectral graphs, the dis-
play of which in the Graphical User Interface can be found here
The interpretation of the spectral graph is rather straightforward. When the values
of a spectral graph for low frequencies (i.e. one year and more) are large in relation
to its other values it means that the long-term movements dominate in the series.
When the values of a spectral graph for high frequencies (i.e. below one year) are
large in relation to its other values it means that the series are rather trendless
and contains a lot of noise. When the values of a spectral graph are distributed
randomly around a constant without any visible peaks, then it is highly probable
that the series is a random process. The presence of seasonality in a time series
is manifested in a spectral graph by the peaks on the seasonal frequencies.
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Reg-ARIMA models

Under construction.

Overview

The primary aim of seasonal adjustment is to remove the unobservable seasonal
component from the observed series. The decomposition routines implemented in
the seasonal adjustment methodsmake specific assumptions concerning the input
series. One of the crucial assumptions is that the input series is stochastic, i.e. it
is clean of deterministic effects. Another important limitation derives from the
symmetric linear filter used in Tramo-Seats and X-13ARIMA-Seats. A symmetric
linear filter cannot be applied to the first and last observations with the same set
of weights as for the central observations[^1]. Therefore, for the most recent
observations these filters provide estimates that are subject to revisions.
To overcome these constrains both seasonal adjustment methods discussed here
include a modelling step that aims to analyse the time series development and
provide a better input for decomposition purposes. The tool that is frequently used
for this purpose is the ARIMAmodel, as discussed by BOX, G.E.P., and JENKINS, G.M.
(1970). However, time series are often affected by the outliers, other deterministic
effects and missing observations. The presence of these effects is not in line with
the ARIMA model assumptions. The presence of outliers and other deterministic
effects impede the identification of an optimal ARIMA model due to the important
bias in the estimation of parameters of sample autocorrelation functions (both
global and partial)[^3]. Therefore, the original series need to be corrected for any
deterministic effects and missing observations. This process is called linearisation
and results in the stochastic series that can be modelled by ARIMA.
For this purpose both Tramo and Reg-ARIMA use regression models with ARIMA
errors. With these models Tramo and Reg-ARIMA also produce forecasts.
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X11 decomposition

X11 is the decomposition part of X-13-ARIMA seasonal adjustment algorithm origi-
nally developed by the US Census Bureau. It is a non parametric algorithm based
on moving averages.
The genuine X11 algorithm was meant to decompose monthly (𝑝 = 12) and quar-
terly series (𝑝 = 4). In JDemetra+ half-yearly data (𝑝 = 2), quadri-monthly
(𝑝 = 3) and bi-monthly data (𝑝 = 6) can also be handled. (𝑝 = 3 and 𝑝 = 6
only in version 3.x)
In the following chapter, explanations and examples are based on monthly and
quarterly data, but the principles can be extended to other supra-monthly fre-
quencies.
In recent years, X11 implementation in JDemetra+ v 3.x has been extended to
infra-monthly data (weekly, daily, hourly…). Handling this kind of data gave way
to a tailored X11 algorithm whose peculiarities are described in this chapter.

In this chapter

This chapter provides details on - algorithm steps - computation stages and de-
tailed output series - quality measures - filter length choices - extreme values
correction
The practical implementation as well as all the options, using the graphical user
interface or R packages are described in this chapter

Moving averages in X11

Moving averages (MA) are the building blocks of X11. They will be used succes-
sively to accomplish three goals:
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- removing seasonality

- extracting seasonality

- estimating Trend on non seasonal series

The type of MA used for each of these tasks and the computation steps are de-
scribed in the sections below.

Definitions

A moving average of order 𝑝 + 𝑓 + 1 and coefficients (𝜃𝑖) is the operator 𝑀
defined as:

𝑀𝑋𝑡 =
𝑓

∑
𝑖=−𝑝

𝜃𝑖𝑋𝑡+𝑖

The series value in 𝑡 is replaced by a weighted average of 𝑝 past values, the current
value and the 𝑓 future values. If 𝑝 = 𝑓 , the moving average is centered and if
𝜃−𝑖 = 𝜃𝑖, it is symmetrical.
Example of simple moving average of order 3:

𝑀𝑋𝑡 = 1
3(𝑋𝑡−1 + 𝑋𝑡 + 𝑋𝑡+1)

A moving average is a linear operator, 𝑀(𝑋𝑡 + 𝑌𝑡) = 𝑀(𝑋𝑡) + 𝑀(𝑌𝑡).

Combined moving averages

Centred and symmetrical moving averages preserve linear trends, which is a de-
sirable propriety. They cannot have an even order, thus for even orders they are
obtained by combining simple moving averages as arithmetic means of p moving
averages of the same order (ie. length): 𝑀𝑝×𝑜𝑟𝑑𝑒𝑟
Combination example for order 12:
There are two intuitive ways to create a Moving Average of order 12:

𝑀1𝑋𝑡 = 1
12(𝑋𝑡−6 + 𝑋𝑡−5 + 𝑋𝑡−4 + 𝑋𝑡−3 + 𝑋𝑡−2 + 𝑋𝑡−1
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+𝑋𝑡 + 𝑋𝑡+1 + 𝑋𝑡+2 + 𝑋𝑡+3 + 𝑋𝑡+4 + 𝑋𝑡+5)
The other being:

𝑀2𝑋𝑡 = 1
12(𝑋𝑡−5 + 𝑋𝑡−4 + 𝑋𝑡−3 + 𝑋𝑡−2 + 𝑋𝑡−1 + 𝑋𝑡

+𝑋𝑡+1 + 𝑋𝑡+2 + 𝑋𝑡+3 + 𝑋𝑡+4 + 𝑋𝑡+5 + 𝑋𝑡+6)
A centred and symmetrical MA with an even order (here 12) can be created:

𝑀2×12 = 1
2(𝑀1𝑋𝑡 + 𝑀2𝑋𝑡)

which is:

𝑀2×12 = 1
24(𝑋𝑡−6) + 1

12(𝑋𝑡−5 + 𝑋𝑡−4

+𝑋𝑡−3 + 𝑋𝑡−2 + 𝑋𝑡−1 + 𝑋𝑡 + 𝑋𝑡+1 + 𝑋𝑡+2

+𝑋𝑡+3 + 𝑋𝑡+4 + 𝑋𝑡+5) + 1
24(𝑋𝑡+6)

Supressing locally constant seasonality

Applying a moving average of an order equal to the periodicity of the raw series
removes a locally stable seasonality (∑12

𝑖=1 𝑆𝑡+𝑖 = 0)
A moving average of order, 12 will remove a locally stable monthly seasonality:
𝑀1×12(𝑆) = 0 and also 𝑀2×12(𝑆) = 0 with linear trend preservation.

X11 algorithm steps

The X11 decomposition algorithm has eight main steps, outlined below for a
monthly time series. (For a quarterly time series a 2 × 4 moving average would
be used, instead of 2 × 12)
Step 1: Estimation of the trend-cycle with a 2 × 12 MA

𝑇𝐶(1)
𝑡 = 𝑀2×12(𝑋𝑡)
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Step 2: Estimation of the seasonal+irregular component

(𝑆𝑡 + 𝐼𝑡)(1) = 𝑋𝑡 − 𝑇𝐶(1)
𝑡

Step 3: Estimation of the seasonal component by applying a 3 × 3 MA to each
month

𝑆(1)
𝑡 = 𝑀3×3 [(𝑆𝑡 + 𝐼𝑡)(1)] and normalisation 𝑆𝑛𝑜𝑟𝑚(1)

𝑡 = 𝑆(1)
𝑡 −𝑀2×12 (𝑆(1)

𝑡 )

Step 4: First estimation of the seasonally adjusted series

𝑋𝑠𝑎(1)
𝑡 = (𝑇𝐶𝑡 + 𝐼𝑡)(1) = 𝑋𝑡 − 𝑆𝑛𝑜𝑟𝑚(1)

𝑡

Step 5: Refined estimation of the trend-cyclewith a Henderson filter, which yields
a better approximation fo trends than 2 × 12 MA, but cannot be applied on a
seasonal series

𝑇𝐶(2)
𝑡 = 𝐻13(𝑋𝑠𝑎(1)

𝑡 )
Step 6: Refined estimation of the seasonal+irregular part

(𝑆𝑡 + 𝐼𝑡)(2) = 𝑋𝑡 − 𝑇𝐶(2)
𝑡

Step 7: Refined estimation of the seasonal component by applying a 3 × 5 MA
(generally) to each month/quarter

𝑆(2)
𝑡 = 𝑀3×5 [(𝑆𝑡 + 𝐼𝑡)(2)] and normalisation 𝑆𝑛𝑜𝑟𝑚(2)

𝑡 = 𝑆(2)
𝑡 −𝑀2×12 (𝑆(2)

𝑡 )

Step 8: Final estimation of the seasonally adjusted series

𝑋𝑠𝑎(2)
𝑡 = 𝑋𝑡 − 𝑆𝑛𝑜𝑟𝑚(2)

𝑡

Processing stages

To evaluate the different components of a series, while taking into account the pos-
sible presence of extreme observations, X11 will proceed iteratively: - estimation
of components - search for disruptive effects in the irregular component - estima-
tion of components over a corrected series - search for disruptive effects in the
irregular component - …
The steps described above will be run six times, at least.
The algorithm is split into
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• four processing stages called A, B, C and D
• two diagnostics parts: E tables and Quality Measures (Summary and Detailed
)
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Series description (input and output)

Stage A: Pre-adjustment

If a pre-treatment is performed using X-13-ARIMA algorithm is A step is not used,
results in A table appearing in JDemetra+ output are a copy of pre-treatment re-
sults.
Detailed series produced at the end of stage A, including estimated effect from
the Reg-ARIMA part

• Table A1: Original raw series;
• Table A1a: Forecast of Original Series;
• Table A2: Leap year effect;
• Table A6: Trading Day effect (1 or 6 variables);
• Table A7: The Easter effect;
• Table A8: Total Outlier Effect;
• Table A8i: Additive outlier effect;
• Table A8t: Level shift effect;
• Table A8s: Transitory effect;
• Table A9: Effect of user-defined regression variables assigned to the season-
ally adjusted series or for which the component has not been defined;

• Table 9sa: Effect of user-defined regression variables assigned to the season-
ally adjusted series;

• Table9u: Effect of user-defined regression variables for which the component
has not been defined.

Stage B: First automatic correction of the series

This stage consists of a first estimation and down-weighting of extreme obser-
vations. This stage is performed by applying twice the algorithm steps outlined
above. It starts with the linearised or raw series copied in table B1 lead to table
B20, containing adjustment values for extreme observations. B1 corrected with
weights from B20 allows to compute the series C1 which will start the next stage.
Detailed series produced at the end of stage B:
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• Table B1: Linearized Series (Original series after adjustment by the Reg-
ARIMA model);

• Table B2: Unmodified Trend (preliminary estimation using composite moving
average);

• Table B3: Unmodified Seasonal: Irregular Component (preliminary estima-
tion);

• Table B4: Replacement Values for Extreme SI Values;
• Table B5: Seasonal Component;
• Table B6: Seasonally Adjusted Series;
• Table B7: Trend (estimation using Henderson moving average);
• Table B8: Unmodified Seasonal: Irregular Component;
• Table B9: Replacement Values for Extreme SI Values;
• Table B10: Seasonal Component;
• Table B11: Seasonally Adjusted Series;
• Table B13: Irregular Component;
• Table B17: Preliminary Weights for the Irregular;
• Table B20: Adjustment Values for the original series B1, allow to compute C1.

(Up coming here: computation steps from B1 to B20)

Stage C: Second automatic correction of the series**

Following the same steps as Stage B, this stage leads to table C20, which allows
to compute the final “cleaned up” series shown in D1.
Detailed series produced at the end of stage C:

• Table C1: Modified Linearized Series;
• Table C2: Trend (preliminary estimation using composite moving average);
• Table C4: Modified Seasonal: Irregular Component;
• Table C5: Seasonal Component;
• Table C6: Seasonally Adjusted Series;
• Table C7: Trend (estimation using Henderson moving average);
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• Table C9: Seasonal: Irregular Component;
• Table C10: Seasonal Component;
• Table C11: Seasonally Adjusted Series;
• Table C13: Irregular Component;
• Table C20: Adjustment Values for the original series B1, allow to compute D1.

Stage D: Final decomposition and seasonal adjustment

In this part, all algorithm steps are applied one last time, finally leading to the
computation of the final components
Detailed series produced at the end of stage D:

• Table D1: Modified Raw Series;
• Table D2: Trend (preliminary estimation using composite moving average);
• Table D4: Modified Seasonal: Irregular Component;
• Table D5: Seasonal Component;
• Table D6: Seasonally Adjusted Series;
• Table D7: Trend (estimation using Henderson moving average);
• Table D8: Unmodified Seasonal: Irregular Component;
• Table D9: Replacement Values for Extreme SI Values;
• Table D10: Final Seasonal Factors of the decomposition phase, without pre-
adjustment effects meant to be allocated to the seasonal component in ver-
sion 3, and with those effects version 2;

• Table D10A: Forecast of Final Seasonal Factors of the decomposition phase;
• Table D11: Final Seasonally Adjusted Series (obtained with D10 factors);
• Table D11A: Forecast of Final Seasonally Adjusted Series;
• Table D12: Final Trend, without pre-adjustment effects meant to be allocated
to the trend in version 3, and with those effects version 2;

• Table D12A: Forecast of Final Trend Component;
• Table D13: Final Irregular Component without pre-adjustment effects meant
to be allocated to the irregular in version 3, and with those effects version 2;

430



D-Final-Table

In version 3 the very final components including pre-adjustment effects are stored
in the D-Final-Table

• Table D11: Final Seasonally Adjusted Series (obtained with D16 factors);
• Table D11A: Forecast of Final Seasonally Adjusted Series;
• Table D12: Final Trend ;
• Table D12A: Forecast of Final Trend Component;
• Table D13: Final Irregular Component;
• Table D16: Final Seasonal Factors ;
• Table D16A: Forecast of Final Seasonal Factors;
• Table D18: Combined Calendar Effects Factors.

Stage E: Components modified for large extreme values

In this part, additional series will are computed and used in the Quality Measures
part
Detailed series produced at the end of stage E:

• Table E1: Raw Series Modified for Large Extreme Values
• Table E2: SA Series Modified for Large Extreme Values
• Table E3: Final Irregular Component Adjusted for Large Extreme Values
• Table E11: Robust Estimation of the Final SA Series

Quality Measures

All the diagnostics below can be displayed in the GUI by expanding the NODES
Decomposition(X11) > Quality Measures > Summary
Decomposition(X11) > Quality Measures > Details
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M-statisctics

M statistics are specific quality measures (ref: Lothian and Mory (1979))

• 0 < 𝑀𝑥 < 3, acceptance region 𝑀𝑥 ≤ 1
• 11 statistics of the decomposition quality (M1 to M11) and 2 summary indica-
tors (Q and Q-M2)

Detailed description:

• 𝑀1 measures the contribution of the irregular component to the total vari-
ance. When it is above 1 some changes in outlier correction should be con-
sidered.

• 𝑀2, which is a very similar to 𝑀1, is calculated on the basis of the contri-
bution of the irregular component to the stationary portion of the variance.
When it is above 1, some changes in an outlier correction should be consid-
ered.

• 𝑀3 compares the irregular to the trend taken from a preliminary estimate
of the seasonally adjusted series. If this ratio is too large, it is difficult to
separate the two components from each other. When it is above 1 some
changes in outlier correction should be considered.

• 𝑀4 tests the randomness of the irregular component. A value above 1 de-
notes a correlation in the irregular component. In such case a shorter sea-
sonal moving average filter should be considered.

• 𝑀5 is used to compare the significance of changes in the trend with that in
the irregular. When it is above 1 some changes in outlier correction should
be considered.

• 𝑀6 checks the SI (seasonal: irregular components ratio). If annual changes
in the irregular component are too small in relation to the annual changes
in the seasonal component, the 3 × 5 seasonal filter used for the estima-
tion of the seasonal component is not flexible enough to follow the seasonal
movement. In such case a longer seasonal moving average filter should be
considered. It should be stressed that𝑀6 is calculated only if the 3×5 filter
has been applied in the model.

• 𝑀7 is the combined test for the presence of an identifiable seasonality. The
test compares the relative contribution of stable and moving seasonality[^m-
X11-decomposition-2].
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• 𝑀8 to𝑀11 measure if the movements due to the short-term quasi-random
variations and movements due to the long-term changes are not changing
too much over the years. If the changes are too strong then the seasonal
factors could be erroneous. In such case a correction for a seasonal break or
the change of the seasonal filter should be considered.

The 𝑄 statistic is a composite indicator calculated from the𝑀 statistics.

𝑄 = 10𝑀1 + 11𝑀2 + 10𝑀3 + 8𝑀4 + 11𝑀5 + 10𝑀6 + 18𝑀7 + 7𝑀8 + 7𝑀9 + 4𝑀10 + 4𝑀11
100

𝑄 = 𝑄 − 𝑀2 (also called 𝑄2) is the 𝑄 statistic for which the 𝑀2 statistics was
excluded from the formula, i.e.:

𝑄−𝑀2 = 10𝑀1 + 10𝑀3 + 8𝑀4 + 11𝑀5 + 10𝑀6 + 18𝑀7 + 7𝑀8 + 7𝑀9 + 4𝑀10 + 4𝑀11
89

If a time series does not cover at least 6 years, the 𝑀8, 𝑀9, 𝑀10 and 𝑀11
statistics cannot be calculated. In this case the 𝑄 statistic is computed as:

𝑄 = 14𝑀1 + 15𝑀2 + 10𝑀3 + 8𝑀4 + 11𝑀5 + 10𝑀6 + 32𝑀7
100

Detailed Quality measures

Average percent change (or Average differences) without regard to sign over the
indicated span

The first table presents the average percent change without regard to sign of the
percent changes (multiplicative model) or average differences (additive model)
over several periods (from 1 to 12 for a monthly series, from 1 to 4 for a quarterly
series) for the following series:

• 𝑂: Original series (Table A1);
• CI: Final seasonally adjusted series (Table D11);
• 𝐼 : Final irregular component (Table D13);
• 𝐶: Final trend (Table D12);
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• 𝑆: Final seasonal factors (Table D10);
• 𝑃 : Preliminary adjustment coefficients, i.e. regressors estimated by the Reg-
ARIMA model (Table A2);

• 𝑇𝐷&𝐻: Final calendar component (Tables A6 and A7);
• Mod.O: Original series adjusted for extreme values (Table E1);
• Mod.CI: Final seasonally adjusted series corrected for extreme values (Table
E2);

• Mod.I: Final irregular component adjusted for extreme values (Table E3).

In the case of an additive decomposition, for each component the average abso-
lute changes over several periods are calculated as:

Component𝑑 = 1
𝑛 − 𝑑

𝑛
∑

𝑡=𝑑+1
|𝑇 𝑎𝑏𝑙𝑒𝑡 − 𝑇𝑎𝑏𝑙𝑒𝑡−𝑑|

where:
𝑑: time lag in periods (from a monthly time series 𝑑 varies from to 4 or from 1 to
12);
𝑛: total number of observations per period;
Component: the name of the component;
Table: the name of the table that corresponds to the component.

For the multiplicative decomposition the following formula is used:

Component𝑑 = 1
𝑛 − 𝑑

𝑛
∑

𝑡=𝑑+1
| Tabl𝑒𝑡
Table𝑡−𝑑

− 1|
.
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Relative contribution to the variance of the differences in the components of the original
series

Relative contributions of the different components to the differences (additive
model) or percent changes (multiplicative model) in the original series is displayed
express the relative importance of the changes in each component. Assuming that
the components are independent, the following relation is valid:

𝑂2
𝑑 ≈ 𝐶2

𝑑 + 𝑆2
𝑑 + 𝐼2

𝑑 + 𝑃 2
𝑑 + 𝑇𝐷&𝐻2

𝑑

In order to simplify the analysis, the approximation can be replaced by the follow-
ing equation:

𝑂∗2
𝑑 = 𝐶2

𝑑 + 𝑆2
𝑑 + 𝐼2

𝑑 + 𝑃 2
𝑑 + 𝑇𝐷&𝐻2

𝑑

The column Total denotes total changes in the raw time series.
Data presented in Table F2B indicate the relative contribution of each component
to the percent changes (differences) in the original series over each span, and are
calculated as:
𝐼2

𝑑
𝑂∗2

𝑑
, 𝐶2

𝑑
𝑂∗2

𝑑
, 𝑆2

𝑑
𝑂∗2

𝑑
, 𝑃2

𝑑
𝑂∗2

𝑑
and 𝑇𝐷&𝐻2

𝑑
𝑂∗2

𝑑
where: 𝑂∗2

𝑑 = 𝐼2
𝑑 + 𝐶2

𝑑 + 𝑆2
𝑑 + 𝑃 2

𝑑 +𝑇𝐷&𝐻2
𝑑.

The last column presents the Ratio calculated as: 100× 𝑂∗2
𝑑

𝑂2
𝑑
, which is an indicator

of how well the approximation (𝑂∗
𝑑)

2 ≈ 𝑂2
𝑑 holds.

Average differences with regard to sign and standard deviation over indicated span

When an additive decomposition is used, Table F2C presents the average and stan-
dard deviation of changes calculated for each time lag 𝑑, taking into consideration
the sign of the changes of the raw series and its components. In case of a mul-
tiplicative decomposition the respective table shows the average percent differ-
ences and related standard deviations.
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Average duration of run

Average duration of run is an average number of consecutive monthly (or quar-
terly) changes in the same direction (no change is counted as a change in the
same direction as the preceding change). JDemetra+ displays this indicator for
the seasonally adjusted series, for the trend and for the irregular component.

Figure 259: Average duration of run

I/C ratio over indicated span and global

The 𝐼
𝐶 ratios for each value of time lag 𝑑, presented in Table F2E, are computed

on a basis of the data in Table F2A. Global IC is displayed below the table

Figure 260: I/C ratio
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Relative contribution to the stationary part of the variance in the original series

The relative contribution of components to the variance of the stationary part of
the original series is calculated for the irregular component (𝐼), trend made sta-
tionary (𝐶), seasonal component (𝑆) and calendar effects (TD&H).
The trend is made stationary by by extracting a linear trend from the trend com-
ponent presented in Table D12.

Figure 261: Relative contribution to the stationary part of the variance in
the original series

Autocorrelations in the irregular

The last table shows the autocorrelogram of the irregular component from Table
D13. In the case of multiplicative decomposition it is calculated for time lags be-
tween 1 and the number of periods per year +2 using the formula:

Corr𝑘𝐼 =
∑𝑁

𝑡=𝑘+1 (𝐼𝑡 − 1)(𝐼𝑡−𝑘 − 1)
∑𝑁

𝑡=1 (𝐼𝑡 − 1)2

where 𝑁 is number of observations in the time series and 𝑘 the lag.
For the additive decomposition the formula is:

𝐶𝑜𝑟𝑟𝑘𝐼𝑡 =
∑𝑁

𝑡=𝑘+1 (𝐼𝑡 × 𝐼𝑡−𝑘)
∑𝑁

𝑡=1 (𝐼𝑡)
2
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Figure 262: Autocorrelations in the irregular

Heteroskedasticity

A Cochran test on equal variances within each period is performed in the extreme
value detection procedure to check if the irregular component is heteroskedastic.
In this procedure the standard errors of the irregular component are used for an
identification of extreme values. If the null hypothesis (for all the periods (months,
quarters) the variances of the irregular component are identical) is rejected, the
standard errors will be computed separately for each period. This will happen only
if in the option Calendarsigma=signif has been selected.

Figure 263: Heteroskedasticity

Moving seasonality ratios (MSR)

For each 𝑖th month we will be looking at the mean annual changes for each com-
ponent by calculating:

𝑆𝑖 = 1
𝑁𝑖 − 1

𝑁𝑖

∑
𝑡=2

|𝑆𝑖,𝑡 − 𝑆𝑖,𝑡−1|

and

𝐼 𝑖 = 1
𝑁𝑖 − 1

𝑁𝑖

∑
𝑡=2

|𝐼𝑖,𝑡 − 𝐼𝑖,𝑡−1|
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where𝑁𝑖 refers to the number of months i in the data, and the moving seasonality
ratio of month 𝑖:

𝑀𝑆𝑅𝑖 = 𝐼 𝑖
𝑆𝑖

The Moving Seasonality Ratio (MSR) is used to measure the amount of noise in the
Seasonal-Irregular component. By studying these values, the user can select for
each period the seasonal filter that is the most suitable given the noisiness of the
series.

Figure 264: Moving Seasonality Ratio (MSR)

Filter length choice

Trend estimation with Henderson Moving average

In iteration B (Table B7), iteration C (Table C7) and iteration D (Table D7 and Table
D12) the trend component is extracted from an estimate of the seasonally adjusted
series using Henderson moving averages.
The algorithm chooses between different filter lengths automatically according to
the 𝐼/𝐶 ratio, the user can modify this choice (first step is computed with𝐻13)

Seasonality extraction filters

In iteration D, Table D10 shows an estimate of the seasonal factors implemented
on the basis of the modified SI (Seasonal: Irregular) factors estimated in Tables D4
and D9bis. This component will be smoothed to estimate the seasonal component;
depending on the importance of the irregular in the SI component
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Figure 265: Calculation of I-C ratios

Step 1: Estimating the irregular and seasonal components

An estimate of the seasonal component is obtained by smoothing, month by
month and therefore column by column, Table D9bis using a simple 7-term mov-
ing average, i.e. of coefficients 1

7 {1, 1, 1, 1, 1, 1, 1}. In order not to lose three
points at the beginning and end of each column, all columns are completed as fol-
lows. Let us assume that the column that corresponds to the month is composed
of 𝑁 values {𝑥1, 𝑥2, 𝑥3, …𝑥𝑁−1, 𝑥𝑁}. It will be transformed into a series
{𝑥−2, 𝑥−1, 𝑥0, 𝑥1, 𝑥2, 𝑥3, …𝑥𝑁−1, 𝑥𝑁 , 𝑥𝑁+1, 𝑥𝑁+1, 𝑥𝑁+2, 𝑥𝑁+3} with
𝑥−2 = 𝑥−1 = 𝑥0 = 𝑥1+𝑥2+𝑥3

3 and 𝑥𝑁+1 = 𝑥𝑁+2 = 𝑥𝑁+3 = 𝑥𝑁+𝑥𝑁−1+𝑥𝑁−2
3 .

We then have the required estimates: 𝑆 = 𝑀7(𝐷9𝑏𝑖𝑠) and 𝐼 = 𝐷9𝑏𝑖𝑠 − 𝑆.

Step 2: Calculating the Moving Seasonality Ratios

For each 𝑖th month the mean annual changes for each component is obtained by
calculating

440



𝑆𝑖 = 1
𝑁𝑖 − 1

𝑁𝑖

∑
𝑡=2

∣𝑆𝑖,𝑡 − 𝑆𝑖,𝑡−1∣

and

𝐼 𝑖 = 1
𝑁𝑖 − 1

𝑁𝑖

∑
𝑡=2

∣𝐼𝑖,𝑡 − 𝐼𝑖,𝑡−1∣

where𝑁𝑖 refers to the number of months iin the data, and the moving seasonality
ratio of month 𝑖:

𝑀𝑆𝑅𝑖 = 𝐼 𝑖
𝑆𝑖

These ratios are presented in Detailed Quality Measures

Step 3: Calculating the overall Moving Seasonality Ratio

The overall Moving Seasonality Ratio is calculated as follows:

MSR𝑖 = ∑𝑖 𝑁𝑖 𝐼 𝑖
∑𝑖 𝑁𝑖𝑆𝑖

Step 4: Selecting a moving average and estimating the seasonal

component
Depending on the value of the ratio, the program automatically selects a mov-
ing average that is applied, column by column (i.e. month by month) to the Sea-
sonal/Irregular component in Table D8 modified, for extreme values, using values
in Table D9.
The default selection procedure of a moving average is based on the Moving Sea-
sonality Ratio in the following way:
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• If this ratio occurs within zone A (MSR < 2.5), a 3 × 3 moving average is
used; if it occurs within zone C (3.5 < MSR < 5.5), a 3 × 5 moving average
is selected; if it occurs within zone E (MSR 6.5), a 3 × 9 moving average is
used;

• If the MSR occurs within zone B or D, one year of observations is removed
from the end of the series, and the MSR is recalculated. If the ratio again
occurs within zones B or D, we start over again, removing a maximum of five
years of observations. If this does not work, i.e. if we are again within zones
B or D, a 3 × 5 moving average is selected.

The chosen symmetric moving average corresponds, as the case may be 5 (3×3),
7 (3×5) or 11 (3×9 3×9) terms, and therefore does not provide an estimate for
the values of seasonal factors in the first 2 (or 3 or 5) and the last 2 (or 3 or 5) years.
These are then calculated using associated asymmetric moving averages.

Extreme values: identification and replacement

Though it is recommended rely on the pre-adjustment stage to correct for outliers
(transparent method with explicit modelling), X11 has its own (historical) module
for identification and treatment of extreme values based on a comparison between
the actual and the theoretical value of 𝐼 .
Stages B and C aim only at correcting for extreme values and contain several
iterations of the following steps.
If the irregular is heteroskedastic the standard deviations used for identifying out-
liers will be computed separately period by period or for distinct groups of several
periods.
Step 1: 𝐼 is estimated once 𝑆 has been extracted from 𝑆 + 𝐼
• for each year the standard deviation 𝜎 is computed on the 5 neighbouring
years

• 𝐼 has a theoretical value 𝑚, for multiplicative model 𝑚 = 1, 𝑚 = 0 for an
additive model

• for a given year 𝑦: any point such as |𝐼𝑡 − 𝑚| > 2, 5𝜎𝑦 is considered as an
extreme value and suppressed….

• …all the yearly sigmas (𝜎𝑦) are computed without those points (more robust
sigmas )
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Step 2: The distance |𝐼𝑡 − 𝑚| is computed for each point and evaluated with 𝜎𝑦
as a benchmark, a weight 𝑤𝑡 is then assigned to each point, 3 cases:

1) value unchanged

|𝐼𝑡 − 𝑚| < 1.5𝜎𝑦 ⇒ 𝑤𝑡 = 1
2) value downsized

1, 5𝜎𝑦 < |𝐼𝑡 − 𝑚| < 2, 5𝜎𝑦 ⇒ 𝑤𝑡 = 2.5𝜎𝑦 − |𝐼𝑡 − 𝑚|
2.5𝜎𝑦 − 1.5𝜎𝑦

3) value removed and replaced

|𝐼𝑡 − 𝑚| > 2, 5𝜎𝑦 ⇒ 𝑤𝑡 = 0
Step3:
Using this weights, a new value of 𝑆 + 𝐼 will be computed:
• if 𝑤𝑡 = 1, 𝑆 + 𝐼 remains unchanged for point {t}
• if 𝑤𝑡 < 1 then the new value of 𝑆 + 𝐼 will be an average of 𝑤𝑡 ∗ (𝑆 + 𝐼)𝑡
and the values of (𝑆 + 𝐼) of the two closest neighbours in the future and in
the past with 𝑤 = 1
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Seats decomposition

Seats is an ARIMA Model Based (AMB) decomposition method which is the second
part of Tramo-Seats seasonal adjustment algorithm, originally developed by the
Bank of Spain (Caporello and Maravall 2004).
Seats draws from the ARIMA-model-based (AMB) decomposition framework devel-
oped by CLEVELAND, W.P., and TIAO, G.C. (1976), BURMAN, J.P. (1980), HILLMER,
S.C., and TIAO, G.C. (1982), BELL, W.R., and HILLMER, S.C. (1984) and MARAVALL,
A., and PIERCE, D.A. (1987).
In recent years, Seats implementation in JDemetra+ v 3.x has been extended to
infra-monthly data (weekly, daily, hourly…). Handling this kind of data gave way to
a tailored AMB decomposition whose peculiarities are described in this chapter.

In this chapter

This chapter provides details on seats algorithm steps.
The practical implementation as well as all the options, using the graphical user
interface or R packages are described in this chapter

Seats steps: overview

Seats decomposes the linearized series into trend, seasonal, transitory and irregu-
lar components, provides forecasts for these components, together with the asso-
ciated standard errors, and finally assigns the deterministic effects to each com-
ponent yielding the final components.
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ARIMA model identification for the components

Input from Tramo

In JDemetra+ the input for the model based signal extraction procedure is always
provided by Tramo and includes the original series 𝑦𝑡, the linearized series 𝑥𝑡
(i.e. the original series 𝑦𝑡 with the deterministic effects removed), the ARIMAmodel
for the linearized time series 𝑥𝑡 and the deterministic effects (calendar, outliers
and other regression variable effects).

ARIMA modelling of the raw series

One of the fundamental assumptions made by Seats is that the linearized time
series 𝑥𝑡 follows an ARIMA model:

𝜙(𝐵)𝛿(𝐵)𝑥𝑡 = Θ(𝐵)𝑎𝑥,𝑡 (0.24)

where:

• 𝐵 – backshift operator 𝐵(𝑥𝑡) = 𝑥𝑡−1;
• 𝑠 – number of observations per year
• 𝛿(𝐵) – a non-stationary autoregressive (AR) polynomial in𝐵 and𝐵𝑆 (regular
and seasonal unit roots);

• Θ(𝐵) – an invertible moving average (MA) polynomial in𝐵 and in𝐵𝑆, which
can be expressed in the multiplicative form (1 + 𝜗1𝐵 + … + 𝜗𝑞𝐵𝑞)(1 +
𝜃1𝐵𝑠 + …+ 𝜃𝑄𝐵sQ) ;

• 𝑝ℎ𝑖(𝐵) – a stationary autoregressive (AR) polynomial in 𝐵 and in 𝐵𝑆

• 𝑎𝑥,𝑡 – a white-noise variable with the variance 𝑉𝑎.

It should be noted that the time series 𝑥𝑡 can be predicted using its past observa-
tions and making an error. The variable 𝑎𝑥,𝑡, which is assumed to be white noise,
is the fundamental innovation to the series at time t, that is the part that cannot
be predicted based on the past history of the series.
Denoting Φ(𝐵) = 𝜙(𝐵)𝛿(𝐵),can be written in a more concise form as

Φ(𝐵)𝑥𝑡 = Θ(𝐵)𝑎𝑥,𝑡 (0.25)
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where Φ(𝐵) contains both the stationary and the nonstationary (unit) roots.

Derivation of the models for the components

Let us consider an additive decomposition model(if a multiplicative model is better
suited, the series can be log-transformed)

𝑥𝑡 =
𝑘

∑
𝑖=1

𝑥it (0.26)

where i refers to the components: trend, seasonal, transitory and irregular. These
components are by assumption orthogonal. Apart from the irregular component,
supposed to be a white noise,
A helpful simple case is to consider the series as a sum of a signal 𝑠𝑡 (of interest)
and noise 𝑛𝑡 𝑥𝑡 = 𝑠𝑡 + 𝑛𝑡

it is assumed that each component follows an ARIMA model which can be repre-
sented, using the notation of Equation 0.25 as:

Φ𝑖(𝐵)𝑥it = Θ𝑖(𝐵)𝑎it (0.27)

where

• Φ𝑖(𝐵) = 𝜙𝑖(𝐵)𝛿𝑖(𝐵),
• Φ𝑖(𝐵) and Θ𝑖(𝐵) are finite polynomials of order 𝑝𝑖 and 𝑞𝑖, respectively,
• 𝑎it is a white noise process with zero mean and constant variance 𝑉𝑎𝑖 and 𝑎it
and 𝑎jt are not correlated for 𝑖 ≠ 𝑗 and for any 𝑡.

In the simplest case, we would have two models :

• model for the signal

Φ𝑠(𝐵)𝑠𝑡 = 𝜃𝑠(𝐵)𝑎𝑠,𝑡

• model for the noise
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Φ𝑛(𝐵)𝑛𝑡 = 𝜃𝑛(𝐵)𝑎𝑛,𝑡

These disturbances are functions of the innovations in the series and are called
“pseudo-innovations” in the literature concerning the AMB decomposition as they
refer to the components that are never observed, in JDemetra+ documentation
the term “innovations” is used to refer to “pseudo-innovations”.(GÓMEZ, V., and
MARAVALL, A. (2001a).
The following assumptions hold for Equation 0.27. For each i the polynomials
𝜙𝑖(𝐵), 𝛿𝑖(𝐵) and Θ𝑖(𝐵) are prime and of finite order. The roots of 𝛿𝑖(𝐵) lies on
the unit circle; those of 𝜙𝑖(𝐵) lie outside, while all the roots ofΘ𝑖(𝐵) are on or out-
side the unit circle. This means that nonstationary and noninvertible components
are allowed. Since different roots of the AR polynomial induce peaks in the spec-
trum of the series at different frequencies, and given that different components
are associated with the spectral peaks for different frequencies, it is assumed that
for 𝑖 ≠ 𝑗 the polynomials 𝜙𝑖(𝐵) and 𝜙𝑗(𝐵) do not share any common root (they
are coprime). Finally, it is assumed that the polynomials Θ𝑖(𝐵), 𝑖 = 1, … , 𝑘
are prime and share no unit root in common, guaranteeing the invertibility of the
overall series. In fact, since a unit root in Θ𝑖(𝐵) induces a spectral zero, when
the polynomials Θ𝑖(𝐵), 𝑖 = 1, … , 𝑘 share no unit root in common, there is no
frequency for which all component spectra become zero.
For description of the spectrum see chapter on Spectral Analysis.(MARAVALL, A.
(1995).
By replacing the series 𝑥𝑡 and its components by their models in (Equation 0.55),
the following identity can be derived :

Θ(𝐵)
Φ(𝐵)𝑎𝑥,𝑡 =

𝑘
∑
𝑖=1

Θ𝑖(𝐵)
Φ𝑖(𝐵)𝑎it (0.28)

By polynomial identification in (eq5?), the two following identities can be de-
rived:

• a relation between the series and components AR polynomials

Φ(𝐵) =
𝑘

∏
𝑖=1

Φ𝑖(𝐵) (0.29)
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In the simplest case
Φ(𝐵) = Φ𝑠(𝐵)Φ𝑛(𝐵)

- a relation between the series MA polynomial and components AR and MA polyno-
mials

Θ(𝐵)𝑎𝑥,𝑡 =
𝑘

∑
𝑖=1

Φni(𝐵)Θ𝑖(𝐵)𝑎it (0.30)

where

• Φni(𝐵) is the product of all 𝜑𝑗(𝐵), 𝑗 = 1, … , 𝑘, except Φ𝑖(𝐵).
In the simplest case

Θ(𝐵)𝑎𝑥,𝑡 = Φ𝑠(𝐵)𝜃𝑛(𝐵)𝑎𝑛,𝑡 + Φ𝑛(𝐵)𝜃𝑠(𝐵)𝑎𝑠,𝑡

Factorisation of AR polynomials

Consider AR polynomial Φ(𝑧). It has real and complex roots (solutions). Complex
number 𝑥 = 𝑎 + 𝑏𝑖, with 𝑎 and b both real numbers, can be represented as
𝑥 = 𝑟(𝑐𝑜𝑠(𝜔) + 𝑖 𝑠𝑖𝑛(𝜔)), where 𝑖 is the imaginary unit 𝑖2 = −1), 𝑟 is the
modulus of 𝑥, that is 𝑟 = |𝑥| =

√
𝑎2 + 𝑏2 and 𝜔 is the argument (frequency).

When roots are complex, they are always in pairs of complex conjugates. The
representation of the complex number 𝑥 = 𝑎 + 𝑏𝑖 has a geometric interpretation
in the complex plane established by the real axis and the orthogonal imaginary
axis.
Representing the roots of the characteristic Equation 0.11 in the complex plane
enhances understanding how they are allocated to the components. When the
modulus 𝑟 of the roots in z are greater than 1 (i.e. modulus of the roots in 𝜑(𝐵) <
1), the solution of the characteristic equation has a systematic explosive process,
which means that the impact of the given impulse on the time series is more and
more pronounced in time. This behaviour is not in line with the developments that
can be identified in actual economic series. Therefore, the models estimated by
Tramo-Seats (and X-13ARIMA-Seats) have never inverse roots in 𝐵 with modulus
greater than 1.
The characteristic equations associated with the regular and the seasonal differ-
ences have roots in 𝜑(𝐵) with modulus 𝑟 = 1. They are called non-stationary
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Figure 266: Geometric representation of a complex number and of its con-
jugate
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roots and can be represented on the unit circle. Let us consider the seasonal dif-
ferencing operator applied to a quarterly time series (1 − 𝐵4). Its characteristic
equation is (𝑧4 − 1) = 0 with solutions given by𝑧 = 4√1, i.e. 𝑧1,2 = ±1 and
𝑧3,4 = ±𝑖1. The first two solutions are real and the last two are complex conju-
gates. They are represented by the black points on the unit circle on the figure
below.

Figure 267: Unit roots on the unit circle

For the seasonal differencing operator (1−𝐵12) applied to themonthly time series
the characteristic equation (𝑧12 − 1) = 0 has twelve non-stationary solutions
given by 𝑧 = 12√1 ∶ two real and ten complex conjugates, represented by the
white circles in unit roots figure above.
The complex conjugates roots generate the periodic movements of the type:
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𝑧𝑡 = 𝐴𝑡 cos(𝜔𝑡 + 𝑊) (0.31)

where:

• 𝐴 – amplitude;
• 𝜔 – angular frequency (in radians);
• 𝑊 – phase (angle at 𝑡 = 0).

The frequency 𝑓 , i.e. the number of cycles per unit time, is 𝜔
2𝜋 . If it is multiplied by s,

the number of observations per year, the number of cycles completed in one year
is derived. The period of function in Equation 0.31, denoted by 𝜏 , is the number
of units of time (months/quarters) it takes for a full circle to be completed.
For quarterly series the seasonal movements are produced by complex conjugates
roots with angular frequencies at 𝜋

2 (one cycle per year) and𝜋 (two cycles per year).
The corresponding number of cycles per year and the length of the movements
are presented in the table below.
Seasonal frequencies for a quarterly time series

Angular
frequency (𝜔)

Frequency
(cycles per unit
time) (𝑓) Cycles per year

Length of the
movement
measured in
quarters (𝜏 )

𝜋
2 0.25 1 4
𝜋 0.5 2 2

For monthly time series the seasonal movements are produced by complex conju-
gates roots at the angular frequencies: 𝜋

6 , 𝜋
3 , 𝜋

2 , 2𝜋
3 , 5𝜋

6 and 𝜋. The corresponding
number of cycles per year and the length of the movements are presented in the
table below:
Seasonal frequencies for a monthly time series

Angular
frequency (𝜔)

Frequency
(cycles per time
unit) (𝑓) Cycles per year

Length of the
movement
measured in
months (𝜏 )

𝜋
6 0.083 1 12
𝜋
3 0.167 2 6
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Angular
frequency (𝜔)

Frequency
(cycles per time
unit) (𝑓) Cycles per year

Length of the
movement
measured in
months (𝜏 )

𝜋
2 0.250 3 4
2𝜋
3 0.333 4 3

5𝜋
6 0.417 5 2.4
𝜋 0.500 6 2

In JDemetra+ Seats assigns the roots of the AR full polynomial to the components
according to their associated modulus and frequency (For details see MARAVALL,
A., CAPORELLO, G., PÉREZ, D., and LÓPEZ, R. (2014))

• Roots of (1 − 𝐵)𝑑 are assigned to trend component.

• Roots of (1−𝐵𝑠)𝑑𝑠 = ((1 − 𝐵)(1 + 𝐵 + … + 𝐵𝑠−1))𝑑𝑠 are assigned to the
trend component (root of (1 − 𝐵)𝑑𝑠) and to the seasonal component (roots
of (1 + 𝐵 + … + 𝐵𝑠−1)𝑑𝑠).

• When the modulus of the inverse of a real positive root of 𝜑(𝐵) is greater
than 𝑘 or equal to 𝑘, where 𝑘 is the threshold value controlled by the Trend
boundary parameter, then the root is assigned to the trend component. Oth-
erwise it is assigned to the transitory component.

• Real negative inverse roots of ϕ𝑝(𝐵) associated with the seasonal two-period
cycle are assigned to the seasonal component if their modulus is greater than
k, where 𝑘 is the threshold value controlled by the Seasonal boundary and
the Seas. boundary (unique) parameters. Otherwise they are assigned to the
transitory component.

• Complex roots, for which the argument (angular frequency) is close enough
to the seasonal frequency are assigned to the seasonal component. Close-
ness is controlled by the Seasonal tolerance and Seasonal tolerance (unique)
parameters. Otherwise they are assigned to the transitory component.

• If 𝑑𝑠 (seasonal differencing order) is present and Bphi < 0 (Bphi is the es-
timate of the seasonal autoregressive parameter), the real positive inverse
root is assigned to the trend component and the other (𝑠 − 1) inverse roots
are assigned to the seasonal component. When 𝑑𝑠 = 0, the root is assigned
to the seasonal when Bphi < −0.2 and/or the overall test for seasonality indi-
cates presence of seasonality. Otherwise it goes to the transitory component.
Also, when Bphi > 0, roots are assigned to the transitory component.
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It should be highlighted that when 𝑄 > 𝑃 , where 𝑄 and 𝑃 denote the orders
of the polynomials 𝜑(𝐵) and 𝜃(𝐵), the Seats decomposition yields a pure MA
(𝑄−𝑃) component (hence transitory). In this case the transitory component will
appear even when there is no AR factor allocated to it.
Once these rules are applied, the factorization of the AR polynomial presented by
Equation 0.25 yields to the identification of the AR polynomials for the components
which contain, respectively, the AR roots associated with the trend component, the
seasonal component and the transitory component.
The AR roots close to or at the trading day frequency generates a stochastic trad-
ing day component. A stochastic trading day component is always modelled as
a stationary ARMA(2,2), where the AR part contains the roots close to the TD fre-
quency, and the MA(2) is obtained from the model decomposition (MARAVALL, A.,
and PÉREZ, D. (2011)). This component, estimated by Seats, is not implemented
by the current version of JDemetra+.
Then with the partial fraction expansion the spectrum of the final components are
obtained.
For example, the Airline model for a monthly time series:

(1 − 𝐵)(1 − 𝐵12)𝑥𝑡 = (1 + 𝜃1𝐵)(1 + Θ1𝐵12) 𝑎𝑥,𝑡 (0.32)

is decomposed by Seats into the model for the trend component:

(1 − 𝐵)(1 − 𝐵)𝑐𝑡 = (1 + 𝜃𝑐,1𝐵 + 𝜃𝑐,2𝐵2)𝑎𝑐,𝑡 (0.33)

and the model for the seasonal component:

(1 + 𝐵 + … + 𝐵11)𝑠𝑡 = (1 + 𝜃𝑠,1𝐵 + … + 𝜃𝑠,11𝐵11)𝑎𝑠,𝑡, (0.34)

As a result, the Airline model is decomposed as follows:

(1 + 𝜃1𝐵)(1 + Θ1𝐵12)
(1 − 𝐵)(1 − 𝐵) 𝑎𝑥,𝑡 = (1 + 𝜃𝑠,1𝐵 + … + 𝜃𝑠,11𝐵11)

(1 + 𝐵 + … + 𝐵11) 𝑎𝑠,𝑡 + (1 + 𝜃𝑐,1𝐵 + 𝜃𝑐,2𝐵2)
(1 − 𝐵)(1 − 𝐵) 𝑎𝑐,𝑡 + 𝑢𝑡

(0.35)
The transitory component is not present in this case and the irregular component
is the white noise.
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The partial fractions decomposition is performed in a frequency domain. In
essence, it consists in portioning of the pseudo-spectrum of 𝑥𝑡 into additive
spectra of the components. When the AMB decomposition of the ARIMA model
results in the non-negative spectra for all components, the decomposition is called
admissible. In such case an infinite number of admissible decompositions exists,
i.e. decompositions that yield the non-negative spectra of all components.
Therefore, the MA polynomials and the innovation variances cannot be yet iden-
tified from the model of 𝑥𝑡. As sketched above, to solve this under identification
problem and identify a unique decomposition, it is assumed that for each compo-
nent the order of the MA polynomial is no greater than the order of the AR poly-
nomial and the canonical solution of S.C. Hillmer and G.C. Tiao is applied, i.e. all
additive white noise is added to the irregular component As a consequence all
components derived from the canonical decomposition, except from the irregular,
have a spectral minimum of zero and are thus non invertible.
Given the stochastic features of the series, it can be shown by that the canoni-
cal decomposition produces as stable as possible trend and seasonal components
since it maximizes the variance of the irregular and minimizes the variance of the
other components. However, there is a price to be paid as canonical components
can produce larger revisions in the preliminary estimators of the component than
any other admissible decomposition.
The term pseudo-spectrum is used for a non-stationary time series, while the term
spectrum is used for a stationary time series.
If the ARIMA model estimated in Tramo does not accept an admissible decomposi-
tion, Seats replaces it with a decomposable approximation. The modified model is
therefore used to decompose the series. There are also other rare situations when
the ARIMA model chosen by Tramo is changed by Seats. It happens when, for ex-
ample, the ARIMA models generate unstable seasonality or produce a senseless
decomposition. Such examples are discussed by MARAVALL, A. (2009).
HILLMER, S.C., and TIAO, G.C. (1982).
GÓMEZ, V., and MARAVALL, A. (2001a).
HILLMER, S.C., and TIAO, G.C. (1982).
MARAVALL, A. (1986).
The figure below represents the pseudo-spectrum for the canonical trend and an
admissible trend.
A pseudo-spectrum is denoted by𝑔𝑖(𝜔), where 𝜔 represents the angular frequency.
The pseudo-spectrum of 𝑥it is defined as the Fourier transform of ACGF of 𝑥𝑡 which
is expressed as:
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Figure 268: A comparison of canonical trend and admissible trend

𝜓𝑖(𝐵)𝜓𝑖(𝐹)
𝛿𝑖(𝐵)𝛿𝑖(𝐹) 𝑉 (𝑎𝑖) (0.36)

where:

• 𝜓𝑖(𝐹) = 𝜃𝑖(𝐹)
𝜙𝑖(𝐹)

• 𝜓𝑖(𝐵) = 𝜃𝑖(𝐵)
𝜙𝑖(𝐵)

A pseudo-spectrum for a monthly time series 𝑥𝑡 is presented in the figure below:
The pseudo-spectrum for a monthly series. The frequency 𝜔 = 0 is associated
with the trend, frequencies in the range [0 + 𝜖1, 𝜋

6 − 𝜖2] with [0 + 𝜖1, 𝜋
6 − 𝜖2]

𝜖1, 𝜖2 > 0 and 𝜖1 < 𝜋
6 − 𝜖2 are usually associated with the business-cycle and

correspond to a period longer than a year and bounded.
The frequencies in the range [𝜋6 , 𝜋] are associated with the short term movements,
whose cycle is completed in less than a year. If a series contains an important
periodic component, its spectrum reveals a peak around the corresponding fre-
quency and in the ARIMA model it is captured by an AR root. In the example below
spectral peaks occur at the frequency 𝜔 = 0 and at the seasonal frequencies (𝜋6 ,2𝜋
6 , 3𝜋

6 , 4𝜋
6 , 5𝜋

6 , 𝜋).
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Figure 269: The pseudo-spectrum for a monthly series

In the decomposition procedure, the pseudo-spectrum of the time series 𝑥𝑡 is di-
vided into the spectra of its components (in the example figure below, four com-
ponents were obtained).

MA polynomials

Under identification problem to be explained

• parameters to estimate
• equations

Further assumptions are therefore needed to cope with the under identification
problem:

i) 𝑝𝑖 ≥ 𝑞𝑖
ii) the canonical decomposition, i.e. the decomposition that allocate all additive
white noise to the irregular component (yielding non invertible components
except the irregular).
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Figure 270: The pseudo-spectra for the components

Estimation of the components

The various components are estimated using Wiener-Kolmogorow (WK) filters.
JDemetra+ includes three options to estimate the WK filter, namely Burman,
KalmanSmoother and MCElroyMatrix[^m-seats-decomposition_old-12]. Here
the first of above mentioned options, proposed by BURMAN, J.P. (1980) will be
explained.
The estimation procedure and the properties of the WK filter are easier to explain
with a two-component model. Let the seasonally adjusted series (𝑠𝑡) be the signal
of interest and the seasonal component (𝑛𝑡) be the remainder, “the noise”. The
series is given by the model in Equation 0.25 and from Equation 0.27 the models
for theoretical components are:

𝜑𝑠(𝐵)𝑠𝑡 = 𝜃𝑠(𝐵)𝑎st (0.37)

and

𝜑𝑛(𝐵)𝑛𝑡 = 𝜃𝑛(𝐵)𝑎nt (0.38)
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From Equation 0.29 and Equation 0.30 it is clear that 𝜑(𝐵) = 𝜑𝑠(𝐵)𝜑𝑛(𝐵) and
𝜃(𝐵)𝑎𝑥,𝑡 = 𝜃𝑠(𝐵)𝑎st + 𝜃𝑛(𝐵)𝑎nt.
As the time series components are never observed, their estimators have to be
used. Let us note𝑋𝑇 an infinite realization of the time series 𝑥𝑡. Seats computes
the Minimum Mean Square Error (MMSE) estimator of 𝑠𝑡, e.g. the estimator ̂𝑠𝑡
that minimizes 𝐸[(𝑠𝑡 − ̂𝑠𝑡)

2|𝑋𝑇 )]. Under the normality assumption ̂𝑠𝑡|𝑇 is also
equal to the conditional expectation 𝐸(𝑠𝑡|𝑋𝑇 ), so it can be presented as a linear
function of the elements in 𝑋𝑇 .WHITTLE (1963) shows that the MMSE estimator
of ̂𝑠𝑡 is:

̂𝑠𝑡 = 𝑘𝑠
𝜓𝑠(𝐵)𝜓𝑠(𝐹)
𝜓(𝐵)𝜓(𝐹) 𝑥𝑡 (0.39)

where

• 𝜓(𝐵) = 𝜃(𝐵)
𝜙(𝐵) ,

• 𝑘𝑠 = 𝑉 (𝑎𝑠)
𝑉𝑎

,

𝑉 (𝑎𝑠) is the variance of 𝑎𝑠𝑡 and 𝑉𝑎 is the variance of 𝑎𝑥,𝑡.

Expressing the 𝜓(𝐵) polynomials as functions of the AR and MA polynomials, after
cancellation of roots, the estimator of 𝑠𝑡 can be expressed as:

̂𝑠𝑡 = 𝑘𝑠
𝜃𝑠(𝐵)𝜃𝑠(𝐹)𝜑𝑛(𝐵)𝛿𝑛(𝐵)𝜑𝑛(𝐹)𝛿𝑛(𝐹)

𝜃(𝐵)𝜃(𝐹) 𝑥𝑡 (0.40)

where:

𝜈𝑠(𝐵, 𝐹) = 𝑘𝑠
𝜃𝑠(𝐵)𝜃𝑠(𝐹)𝜑𝑛(𝐵)𝛿𝑛(𝐵)𝜑𝑛(𝐹)𝛿𝑛(𝐹)

𝜃(𝐵)𝜃(𝐹) (0.41)

is a WK filter.
Equation 0.41 shows that the WK filter is two-sided (uses observations both from
the past and from the future), centred (the number of points in the past is the
same as in the future) and symmetric (for any 𝑘 the weight applied to 𝑥𝑡−𝑘 and𝑥𝑡+𝑘 is the same), which allows the phase effect to be avoided. Due to invertibility
of 𝜃(𝐵) (and 𝜃(𝐹)) the filter is convergent in the past and in the future.
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The estimator can be presented as

̂𝑠𝑡 = 𝜈𝑖(𝐵, 𝐹)𝑥𝑡 (0.42)

where 𝜈𝑖(𝐵, 𝐹) = 𝜈0 + ∑∞
𝑗=1 𝜈𝑖𝑗(𝐵𝑗 + 𝐹 𝑗) is the WK filter.

The example of the WK filters obtained for the pseudo-spectra of the series illus-
trated above is shown on the figure below: WK filters for components.

Figure 271:WK filters for components

The WK filter from Equation 0.41 can also be expressed as a ratio of two pseudo-
autocovariance generating functions (p-ACGF). The p-ACGF function summarizes
the sequence of absolutely summable autocovariances of a stationary process 𝑥𝑡
(see Spectral Analysis).
The ACGF function of an ARIMA process is expressed as:

𝑎𝑐𝑔𝑓(𝐵) = 𝜃(𝐵)𝜃(𝐹)
𝜙(𝐵)𝛿(𝐵)𝜙(𝐹)𝛿(𝐹)𝑉𝑎 (0.43)

And, the WK filter can be rewritten as:
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𝜈𝑠(𝐵, 𝐹) = 𝛾𝑠(𝐵, 𝐹)
𝛾(𝐵, 𝐹) (0.44)

where:

• 𝛾𝑠(𝐵, 𝐹) = 𝜃𝑠(𝐵)𝜃𝑠(𝐹)
𝜙𝑠(𝐵)𝛿𝑠(𝐵)𝜙𝑠(𝐹)𝛿𝑠(𝐹)𝑉 (𝑎𝑠) is the p-ACGF of 𝑠𝑡;

• 𝛾(𝐵, 𝐹) = 𝜃(𝐵)𝜃(𝐹)
𝜙(𝐵)𝛿(𝐵)𝜙(𝐹)𝛿(𝐹)𝑉𝑎 is the p-ACGF of 𝑥𝑡.

From Equation 0.41 it can be seen that the WK filter depends on both the compo-
nent and the series models. Consequently, the estimator of the component and
the WK filter reflect the characteristic of data and by construction, the WK filter
adapts itself to the series under consideration. Therefore, the ARIMA model is
of particular importance for the Seats method. Its misspecification results in an
incorrect decomposition.
This adaptability, if the model has been correctly determined, avoids the dangers
of under and overestimation with an ad-hoc filtering. For example, for the series
with a highly stochastic seasonal component the filter adapts to the width of the
seasonal peaks and the seasonally adjusted series does not display any spurious
seasonality. Examples of WK filters for stochastic and stable seasonal components
are presented on the figure below. (MARAVALL, A. (1995)).
The derivation of the components requires an infinite realization of 𝑥𝑡 in the di-
rection of the past and of the future. However, the convergence of the WK filter
guarantees that, in practice, it could be approximated by a truncated (finite) fil-
ter and, in most applications, for large 𝑘 the estimator for the central periods of
the series can be safely seen as generated by the WK filter (MARAVALL, A., and
PLANAS, C. (1999)).

̂𝑠𝑡 = 𝜈𝑘𝑥𝑡−𝑘 + … + 𝜈0𝑥𝑡 + … + 𝜈𝑘𝑥𝑡+𝑘 (0.45)

When 𝑇 > 2𝐿 + 1, where 𝑇 is the last observed period, and 𝐿 is an a priori
number that typically expands between 3 and 5 years, the estimator expressed
by Equation 0.40 can be assumed as the final (historical) estimator for the central
observations of the series2. In practice, the Wiener-Kolmogorov filter is applied
to 𝑥𝑡 extended with forecasts and backcasts from the ARIMA model. The final or
historical estimator of ̂𝑠𝑡, is obtained with a doubly infinite filter, and therefore con-
tains an error 𝑒𝑠𝑡 called final estimation error, which is equal 𝑒𝑠𝑡 = 𝑠𝑡 associated
with the regular and the seasonal differences have roots in 𝜑(𝐵) with modulus
2MARAVALL, A. (1998).
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Figure 272:WK filters for stable and stochastic seasonal components

𝑟 = 1. They are called non-stationary roots and can be represented on the unit
circle. Let us consider the seasonal differencing operator applied to a quarterly
time series (1 − 𝐵4). Its characteristic equation is (𝑧4 − 1) = 0 with solutions
given by 𝑧 = 4√1, i.e. 𝑧1,2 = ±1 and 𝑧3,4 = ±𝑖1. The first two solutions are
real and the last two are complex conjugates. They are represented by the black
points on the unit circle on the figure below.
In the frequency domain, the Wiener-Kolmogorov filter 𝜈(𝐵, 𝐹) that provides the
final estimator of 𝑠𝑡 is expressed as the ratio of the 𝑠𝑡 and 𝑥𝑡 pseudo-spectra:

̃𝜈(𝜔) = 𝑔𝑠(𝜔)
𝑔𝑥(𝜔) (0.46)

The function ̃𝜈(𝜔) is also referred as the gain of the filter. GÓMEZ, V., and MAR-
AVALL, A. (2001a) show that when for some frequency the signal (the seasonally
adjusted series) dominates the noise (seasonal fluctuations) the gain ̃𝜈(𝜔) ap-
proaches 1. On the contrary, when for some frequency the noise dominates the
gain ̃𝜈(𝜔) approaches 0.
The spectrum of the estimator of the seasonal component is expressed as:
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Figure 273: Unit roots on the unit circle
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𝑔 ̂𝑠(𝜔) = [𝑔𝑠(𝜔)
𝑔𝑥(𝜔)]

2𝑔𝑥(𝜔) (0.47)

where

• [ ̃𝜈(𝜔)]2 = [ 𝑔𝑠(𝜔)
𝑔𝑥(𝜔) ]2 = [ 𝑔𝑠(𝜔)

𝑔𝑠(𝜔)+𝑔𝑛(𝜔) ]2 = [ 1
1+ 1

𝑟(𝜔)
]2 is the squared gain of the

filter ;
• 𝑟(𝜔) = 𝑔𝑠(𝜔)

𝑔𝑛(𝜔) represents the signal-to-noise ratio.

For each 𝜔, the MMSE estimation gives the signal-to-noise ratio. If this ratio is high,
then the contribution of that frequency to the estimation of the signal will be also
high. Assume that the trend is a signal that needs to be extracted from a seasonal
time series. Then 𝑅(0) = 1 and the frequency 𝜔 = 0 will only be used for trend
estimations. For seasonal frequencies 𝑅(𝜔) = 0, so that these frequencies are
ignored in computing the trend resulting in spectral zeros in 𝑔 ̂𝑠(𝜔). For this reason,
unlike the spectrum of the component, the component spectrum contains dips as
it can be seen on the figure below: Component spectrum and estimator spectrum
for trend.

Figure 274: Component spectrum and estimator spectrum for trend

From the Equation 0.46 it is clear that the squared gain of the filter determines how
the variance of the series contributes to the variance of the seasonal component
for the different frequencies. When ̃𝜈(𝜔) = 1, the full variation of 𝑥𝑡 for that
frequency is passed to ̂𝑠𝑡, while if ̃𝜈(𝜔) = 0 the variation of 𝑥𝑡 for that frequency
is fully ignored in the computation of ̂𝑠𝑡. These two cases are well illustrated by
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the figure below that shows the square gain of the WK filter for two series already
analysed in the figure above (Figure: WK filters for stable and stochastic seasonal
components).

Figure 275: The squared gain of the WK filter for stable and stochastic
seasonal components.

Since 𝑟(𝜔) ≥ 0, then ̃𝜈(𝜔) ≤ 1 and from Equation 0.46 it can be derived that
𝑔 ̂𝑠(𝜔) = ̃𝜈(𝜔)𝑔𝑠(𝜔). As a result, the estimator will always underestimate the
component, i.e. it will be always more stable that the component.
Since 𝑔𝑛̂(𝜔) < 𝑔𝑛(𝜔) and 𝑔 ̂𝑠(𝜔) < 𝑔𝑠(𝜔) the expression: 𝑔𝑥(𝜔) − [𝑔𝑛̂(𝜔) +
𝑔 ̂𝑠(𝜔)] ≥ 0 is the cross-spectrum. As it is positive, the MMSE yields correlated es-
timators. This effect emerges since variance of estimator is smaller than the vari-
ance of component. Nevertheless, if at least one non-stationary component exists,
cross-correlations estimated by Tramo-Seats will tend to zero as cross-covariances
between estimators of the components are finite. In practice, the inconvenience
caused by this property will likely be of little relevance.
Preliminary estimators for the components
GÓMEZ, V., and MARAVALL, A. (2001a) point out that the properties of the estima-
tors have been derived for the final (or historical) estimators. For a finite (long
enough) realization, they can be assumed to characterize the estimators for the
central observations of the series, but for periods close to the beginning of the end
the filter cannot be completed and some preliminary estimator has to be used. In-
deed, the historical estimator shown in Equation 0.45 is obtained for the central
periods of the series. However, when 𝑡 approaches 𝑇 (last observation), the WK
filter requires observations, which are not available yet. For this reason a prelimi-
nary estimator needs to be used.
To introduce preliminary estimators let us consider a semi-finite realization
[𝑥−∞,…$ x_{T}]$, where 𝑇 is the last observed period. The preliminary
estimator of 𝑥it obtained at 𝑇 , (𝑇 − 𝑡 = 𝑘 ≥ 0) can be expressed as

̂𝑥𝑖𝑡|𝑡+𝑘 = 𝜈𝑖(𝐵, 𝐹)𝑥𝑒
𝑡|𝑇 (0.48)
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where

• 𝜈𝑖(𝐵, 𝐹) is the WK filter ;
• 𝑥𝑒

𝑡|𝑇 is the extended series, such that 𝑥𝑒
𝑡|𝑇 = 𝑥𝑡 for 𝑡 ≤ 𝑇 and 𝑥𝑒

𝑡|𝑇 = ̂𝑥𝑡|𝑇
for 𝑡 > 𝑇 , where ̂𝑥𝑡|𝑇 denotes the forecast of 𝑥𝑡 obtained at period 𝑇 .

The future 𝑘 values necessary to apply the filter are not yet available and are
replaced by their optimal forecasts from the ARIMA model on 𝑥𝑡. When 𝑘 = 0
the preliminary estimator becomes the concurrent estimator. As the forecasts are
linear functions of present and past observations of 𝑥𝑡, the preliminary estimator
̂𝑥𝑖𝑡 will be a truncated asymmetric filter applied to 𝑥𝑡 that generates a phase effect
(KAISER, R., and MARAVALL, A. (2000)).
When a new observation 𝑥𝑇+1 becomes available the forecast ̂𝑥𝑇+1|𝑇 is replaced
by the observation and the forecast ̂𝑥𝑖𝑇+𝑗|𝑇 , 𝑗 > 1 are updated to 𝑥𝑇+𝑗|𝑇+1 result-
ing in the revision error (MARAVALL, A. (1995)). The total error in the preliminary
estimator 𝑑𝑖𝑡|𝑡+𝑘 is expressed as a sum of the final estimation error (𝑒𝑖𝑡) and the
revision error (𝑟𝑖𝑡|𝑡+𝑘), i.e.:

𝑑𝑖𝑡|𝑡+𝑘 = 𝑥𝑖𝑡 − ̂𝑥𝑖𝑡|𝑡+𝑘 = (𝑥𝑖𝑡 − ̂𝑥𝑖𝑡) + ( ̂𝑥𝑖𝑡 − ̂𝑥𝑖𝑡|𝑡+𝑘) = 𝑒𝑖𝑡 + 𝑟𝑖𝑡|𝑡+𝑘 (0.49)

where:

• 𝑥𝑖𝑡 − 𝑖𝑡ℎ component;
• ̂𝑥𝑖𝑡|𝑡+𝑘- the estimator of 𝑥𝑖𝑡 when the last observation is 𝑥𝑡+𝑘.

Therefore the preliminary estimator is subject not only to the final error but also
to a revision error, which are orthogonal to each other (MARAVALL, A. (2009)). The
revision error decreases as 𝑘 increases, until it can be assumed equal to 0 for large
enough 𝑘.
It’s worth remembering that Seats estimates the unobservable components of the
time series so the “true” components are never observed. Therefore, MARAVALL, A.
(2009) stresses that the error in the historical estimator is more of academic rather
than practical interest. In practice, interest centres on revisions. (…) the revision
standard deviation will be an indicator of how far we can expect to be from the
optimal estimator that will be eventually attained, and the speed of convergence
of 𝜃(𝐵)−1 will dictate the speed of convergence of the preliminary estimator to
the historical one. The analysis of an error is therefore useful for making decision
concerning the revision policy, including the policy for revisions and horizon of
revisions.
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PsiE-weights

The estimator of the component is calculated as ̂𝑥𝑖𝑡 = 𝜈𝑠(𝐵, 𝐹)𝑥𝑡. By replacing
𝑥𝑖𝑡 = 𝜃(𝐵)

𝛾(𝐵)𝛿(𝐵)𝑎𝑥,𝑡, the component estimator can be expressed as (KAISER, R.,
and MARAVALL, A. (2000)):

̂𝑥𝑖𝑡 = 𝜉𝑠(𝐵, 𝐹)𝑎𝑥,𝑡 (0.50)

where 𝜉𝑠(𝐵, 𝐹) = … + 𝜉𝑗𝐵𝑗 + … + 𝜉1𝐵 + 𝜉0 + 𝜉−1𝐹 … 𝜉−𝑗𝐹 𝑗 + ….
This representation shows the estimator as a filter applied to the innovation 𝑎𝑥,𝑡,
rather than on the series 𝑥𝑡. Hence, the filter from Equation 0.49 can be divided
into two components: the first one, i.e.…+𝜉𝑗𝐵𝑗 +…+𝜉1𝐵+𝜉0, applies to prior
and concurrent innovations, the second one, i.e. 𝜉−1𝐹 + … + 𝜉−𝑗𝐹 𝑗 applies to
future (i.e. posterior to 𝑡) innovations. Consequently, 𝜉𝑗 determines the contribu-
tion of 𝑎𝑡−𝑗 to ̂𝑠𝑡 while 𝜉−𝑗 determines the contribution of 𝑎𝑡+𝑗 to ̂𝑠𝑡. Finally, the
estimator of the component can be expressed as:

̂𝑥𝑖𝑡 = 𝜉𝑖(𝐵)−𝑎𝑥,𝑡 + 𝜉𝑖(𝐹)+𝑎𝑡+1 (0.51)

where:

• 𝜉𝑖(𝐵)−𝑎𝑥,𝑡 is an effect of starting conditions, present and past innovations
in series;

• 𝜉𝑖(𝐹)+𝑎𝑡+1 is an effect of future innovations.

For the two cases already presented in figure WK filters for stable and stochastic
seasonal components and figure The squared gain of the WK filter for stable and
stochastic seasonal components above, the psi-weights are shown in the figure
below.

Figure 276:WK filters and squared gain of the WK filter
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It can be shown that 𝜉−1,… , 𝜉−𝑗 are convergent and 𝜉𝑗,… , 𝜉1, 𝜉0 are divergent.
From Equation 0.50, the concurrent estimator is equal to:

̂𝑥𝑖𝑡|𝑡 = 𝐸𝑡𝑥𝑖𝑡 = 𝐸𝑡 ̂𝑥𝑖𝑡 = 𝜉𝑖(𝐵)−𝑎𝑥,𝑡 (0.52)

so that the revision

𝑟𝑖𝑡 = ̂𝑥𝑖𝑡 − ̂𝑥𝑖𝑡|𝑡 = 𝜉𝑖(𝐹)+𝑎𝑡+1 (0.53)

is a zero-mean stationary MA process. As a result, historical and preliminary esti-
mators are co-integrated. From Equation 0.42 the relative size of the full revision
and the speed of convergence can be obtained.
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SA of high-frequency data

Overview

This chapter provides guidance on seasonal adjustment of infra-monthly, or high-
frequency (HF), time-series data with JDemetra+ tailored algorithms.
Currently available topics:

• description of HF data specificities
• R functions for pre-treatment, extended X-11 and extended Seats

Topics under construction

• Graphical User Interface 3.x functionalities for HF data
• STL functions
• State space framework

Data specificities

HF data often display multiple seasonal patterns with potentially non-integer pe-
riodicities which cannot be modeled with classical SA algorithms. JD+ provides
tailored versions of these algorithms.

Table 42: Periodicities (number of observations per cycle)

Data Day Week Month Quarter Year
quarterly 4
monthly 3 12
weekly 4.3481 13.0443 52.1775
daily 7 30.4368 91.3106 365.2425
hourly 24 168 730.485 2191.4550 8765.82
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Tailored algorithms in JDemetra+

Col1 Algorithm GUI v 3.x R package
Pre-treatment Extended Airline Model ✔ rjd3highfreq
Decomposition Extended Seats Extended Airline

Model
✔ rjd3highfreq

Extended X-11 ✔ rjd3x11plus
Extended STL ✖ rjd3stl

One-Step SSF Framework ✖ rjd3sts

Unobserved Components

Raw series decomposition

Figure 277: [Decomposition diagram]

Multiple seasonal patterns

HF data often contain multiple seasonal patterns. For example, daily economic
time series often display strong infra-weekly and infra-yearly seasonality. An infra-
monthly seasonal pattern may also be present, but its strength is usually less pro-
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nounced in practice. In theory, the full decomposition of the seasonal component
in daily data is given by:

𝑆𝑡 = 𝑆𝑡,7 ∘ 𝑆𝑡,30.44 ∘ 𝑆𝑡,365.25

The decomposition is done iteratively periodicity by periodicity starting with the
smallest one (highest frequency) as:

• highest frequencies usually display the biggest and most stable variations
• cycles of highest frequencies can mix up with lower ones

Identifying seasonal patterns

JDemetra+ provides the Canova-Hansen test in the rjd3toolkit package.

Pre-adjustment

In classical X-13-ARIMA and Tramo-Seats, a pre-adjustment step is performed to
remove deterministic effects, such as outliers and calendar effects, with a Reg-
ARIMA model. In the extended version for HF data, it is also the case with an
extended Airline model.
A general Reg-ARIMA model is written as follows:

(𝑌𝑡 − ∑𝛼𝑖𝑋𝑖𝑡) ∼ 𝐴𝑅𝐼𝑀𝐴(𝑝, 𝑑, 𝑞)(𝑃 , 𝐷, 𝑄)

These models contain seasonal backshift operators𝐵𝑠(𝑦𝑡) = 𝑦𝑡−𝑠. Here 𝑠 can be
non-integer. JDemetra+ will rely on a modified version of a frequently used ARIMA
model: the “Airline” model:

(1 − 𝐵)(1 − 𝐵𝑠)𝑦𝑡 = (1 − 𝜃1𝐵)(1 − 𝜃2𝐵𝑠)𝜖𝑡 𝜖𝑡 ∼ NID(0, 𝜎2
𝜖 )

For HF data, the potentially non-integer periodicity 𝑠 will be written: 𝑠 = 𝑠′ + 𝛼,
with 𝛼 ∈ [0, 1) (for example 52.18 = 52+0.18 is the yearly periodicity for weekly
data)
Taylor series development around 1 of 𝑓(𝑥) = 𝑥𝛼
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𝑥𝛼 = 1 + 𝛼(𝑥 − 1) + 𝛼(𝛼+1)
2! (𝑥 − 1)2 + 𝛼(𝛼+1)(𝛼+2)

3! (𝑥 − 1)3 + ⋯
𝐵𝛼 ≅ (1 − 𝛼) + 𝛼𝐵

Approximation of 𝐵𝑠+𝛼 in an extended Airline model

𝐵𝑠+𝛼 ≅ (1 − 𝛼)𝐵𝑠 + 𝛼𝐵𝑠+1

Example for a daily series displaying infra-weekly (𝑝1 = 7) and infra-yearly (𝑝2 =
365.25) seasonality:

(1−𝐵)(1−𝐵7)(1−𝐵365.25)(𝑌𝑡−∑𝛼𝑖𝑋𝑖𝑡) = (1−𝜃1𝐵)(1−𝜃2𝐵7)(1−𝜃3𝐵365.25)𝜖𝑡

𝜖𝑡
𝑖𝑖𝑑∼ N(0, 𝜎2

𝜖 )
with

1 − 𝐵365.25 = 1 − (0.75𝐵365 + 0.25𝐵366)

Calendar correction

Calendar regressors can be defined with the rjd3toolkit package and added to pre-
treatment function as a matrix.

# Create a calendar with rjd3toolkit
# Define a national calendar
frenchCalendar <- national_calendar(days = list(

fixed_day(7, 14), # Bastille Day
fixed_day(5, 8, validity = list(start = "1982-05-08")), # Victory Day
special_day("NEWYEAR"),
special_day("CHRISTMAS"),
special_day("MAYDAY"),
special_day("EASTERMONDAY"),
special_day("ASCENSION"),
special_day("WHITMONDAY"),
special_day("ASSUMPTION"),
special_day("ALLSAINTSDAY"),
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special_day("ARMISTICE")
))
# Generrate calendar regressors
q <- holidays(

calendar = frenchCalendar,
start = "1968-01-01",
length = length(df_daily$births),
type = "All",
nonworking = 7L

)

# Argument type = All : taking all holidays into account
# Argument type = Skip : taking into account only the holidays falling on a week day

Outliers and intervention variables

Outliers detection is available in the pre-treatment function. Detected outliers are
AO, LS and WO. Critical value can be computed by the algorithm or user-defined.

Linearization

Example using rjd3highfreq::fractionalAirlineEstimation function:

pre_adjustment <- rjd3highfreq::fractionalAirlineEstimation(y_raw,
x = q, # q = daily calendar regressors
periods = c(7, 365.25),
ndiff = 2, ar = FALSE, mean = FALSE,
outliers = c("ao", "ls", "wo"),
criticalValue = 0, # computed in the algorithm
precision = 1e-9, approximateHessian = TRUE

)

“pre_adjustment” R object is a list of lists in which the user can retrieve input series,
parameters and output series. For more details see chapter on R packages and
rjd3highfreq help pages R, where all parameters are listed.
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Decomposition

Extended X-11

X-11 is the decomposition module of X-13-ARIMA, the linearized series from the
pre-adjustment step is split into seasonal (𝑆), trend (𝑇 ) and irregular (𝐼) com-
ponents. In case of multiple periodicities the decomposition is done periodicity
by periodicity starting with the smallest one. Global structure of the iterations
is the same as in “classical” X-11 but modifications were introduced for tackling
non-integer periodicities. They rely on the Taylor approximation for the seasonal
backshift operator:

𝐵𝑠+𝛼 ≅ (1 − 𝛼)𝐵𝑠 + 𝛼𝐵𝑠+1

Modification of the first trend filter for removing seasonality

The first trend estimation is thanks to a generalization of the centred and symmet-
rical moving averages with an order equal to the periodicity 𝑝.
• filter length 𝑙: smallest odd integer greater than 𝑝
• examples: 𝑝 = 7 → 𝑙 = 7, 𝑝 = 12 → 𝑙 = 13, 𝑝 = 365.25 → 𝑙 = 367,

𝑝 = 52.18 → 𝑙 = 53
• central coefficients 1/𝑝 (1/12,1/7, 1/365.25)
• end-point coefficients 𝕀{𝐸(𝑝) even} + (𝑝 − 𝐸(𝑝))/2𝑝
• example for 𝑝 = 12: (1/12 and 1/24) (we fall back on𝑀2×12 of the monthly
case

• example for 𝑝 = 365.25: (1/365.25 and 0.25/(2 ∗ 365.25))

Modification of seasonality extraction filters

Computation is done on a given period
Example 𝑀3×3

𝑀3×3𝑋 = 1
9(𝑋𝑡−2𝑝) + 2

9(𝑋𝑡−𝑝) + 3
9(𝑋𝑡) + 2

9(𝑋𝑡+𝑝) + 1
9(𝑋𝑡+2𝑝)
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if 𝑝 integer: no changes needed
if 𝑝 non-integer: Taylor approximation of the backshift operator

Modification of final trend estimation filter

As seasonality has been removed in the first step, there is no non-integer periodic-
ity issue in the final trend estimation, but extended X-11 offers additional features
vs classic X-11, in which final trend is estimated with Henderson filters and Mus-
grave asymmetrical surrogates. In extended X-11, a generalization of this method
with local polynomial approximation is available.

Example of decomposition

Here the raw series is daily and displays two periodicities 𝑝 = 7 and 𝑝 = 365.25
# extraction of day-of-the-week pattern (dow)
x11.dow <- rjd3x11plus::x11plus(y_linearized,

period = 7, # DOW pattern
mul = TRUE,
trend.horizon = 9, # 1/2 Filter length : not too long vs p
trend.degree = 3, # Polynomial degree
trend.kernel = "Henderson", # Kernel function
trend.asymmetric = "CutAndNormalize", # Truncation method
seas.s0 = "S3X9", seas.s1 = "S3X9", # Seasonal filters
extreme.lsig = 1.5, extreme.usig = 2.5

) # Sigma-limits

# extraction of day-of-the-week pattern (doy)
x11.doy <- rjd3x11plus::x11plus(x11.dow$decomposition$sa, # previous sa

period = 365.2425, # DOY pattern
mul = TRUE,
trend.horizon = 371, # 1/2 final filter length
trend.degree = 3,
trend.kernel = "Henderson",
trend.asymmetric = "CutAndNormalize",
seas.s0 = "S3X15", seas.s1 = "S3X5",
extreme.lsig = 1.5, extreme.usig = 2.5

)
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ARIMA Model Based (AMB) Decomposition (Extended Seats)

Example

# extracting DOY pattern
amb.doy <- rjd3highfreq::fractionalAirlineDecomposition(

amb.dow$decomposition$sa, # DOW-adjusted linearised data
period = 365.2425, # DOY pattern
sn = FALSE, # Signal (SA)-noise decomposition
stde = FALSE, # Calculate standard deviations
nbcasts = 0, nfcasts = 0

) # Numbers of back- and forecasts

Summary of the process

For the time being, seasonal adjustment processing in rjd3highfreq cannot be en-
compassed by one function like for lower frequency, e.g rjd3x13::x13(y_raw)
The user has to run the steps one by one, here is an example with 𝑝 = 7 and
𝑝 = 365.25
• computation of the linearized series 𝑌𝑙𝑖𝑛 = 𝐸𝑥𝑡𝑒𝑛𝑑𝑒𝑑𝐴𝑖𝑟𝑙𝑖𝑛𝑒(𝑌 )
• computation of the calendar corrected series 𝑌𝑐𝑎𝑙
• computation of 𝑆7 by decomposition of the linearized series
• computation of 𝑆365.25 by decomposition of the seasonally adjusted series
with 𝑝 = 7

• finally adjusted series 𝑠𝑎𝑓𝑖𝑛𝑎𝑙 = 𝑌𝑐𝑎𝑙/𝑆7/𝑆365.25 (if multiplicative model)

STL decomposition

Not currently available. Under construction.

State Space framework

Not currently available. Under construction.
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Quality assessment

Residual seasonality

JDemetra+ provides the Canova-Hansen test in rjd3toolkit package which allows
to check for any remaining seasonal periodicity in the final SA data.
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Tests

In this chapter

This chapter provides a theoritical overview of all the tests available in JDemetra+,
via Graphical User Interface and R packages.

Tests on residuals

Test Purpose
GUI
display

GUI
output

Cruncher
output

R stan-
dalone

R in SA
estima-
tion

Ljung-
Box

autocorrelation✔ ✔ ✔ rjd3toolkit rjd3x13 /
rjd3tramoseats

Doornik-
Hansen

normality ✔ ✔ ✔ rjd3toolkit rjd3x13 /
rjd3tramoseats

Skewness skewness ✔

Ljung-Box

For R code estimation object is obtained as
The Ljung-Box Q-statistics given by :

LB(𝐾) = 𝑛 × (𝑛 + 2) ×
𝐾

∑
𝑗=1

̂𝜌2
𝑎,𝑗

𝑛 − 𝑗

where ̂𝜌2
𝑗,𝑘 is the sample autocorrelation coefficient at lag 𝑗 of the residuals ̂𝑎𝑡, 𝑛

is the number of terms in the differenced series. 𝐾 is the number of lags being
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considered, in JDemetra+𝐾 = 24 for a monthly series and𝐾 = 8 for a quarterly
series.
If the residuals are random (which is the case for residuals from a well specified
model), ̂𝜌 will be distributed as 𝜒2

(𝐾−𝑚), where𝑚 is the number of parameters in
the model which has been fitted to the data.

Dornik-Hansen

The Doornik-Hansen test for multivariate normality (DOORNIK, J.A., and HANSEN,
H. (2008)) is based on the skewness and kurtosis of multivariate data that is trans-
formed to ensure independence.
The skewness and kurtosis are defined, respectively, as: 𝑠 = 𝑚3√𝑚2

3 and 𝑘 = 𝑚4
𝑚2

2
,

where:

• 𝑚𝑖 = 1
𝑛 ∑𝑛

𝑖=1 (𝑥𝑖−𝑥)𝑖 ;

• 𝑥 = 1
𝑛 ∑𝑛

𝑖=1 𝑥𝑖 ;

• 𝑛 number of (non-missing) residuals.
The Doornik-Hansen test statistic derives from SHENTON, L.R., and BOWMAN, K.O.
(1977) and uses transformed versions of skewness and kurtosis.
The transformation for the skewness 𝑠 into z1 is as in D’AGOSTINO, R.B. (1970):

𝛽 = 3(𝑛2 + 27𝑛 − 70)(𝑛 + 1)(𝑛 + 3)
(𝑛 − 2)(𝑛 + 5)(𝑛 + 7)(𝑛 + 9)

𝜔2 = −1 + √2(𝛽 − 1)

𝛿 = 1
√log (𝜔2)

𝑦 = 𝑠√(𝜔2 − 1)(𝑛 + 1)(𝑛 + 3)
12(𝑛 − 2)
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𝑧1 = 𝛿𝑙𝑜𝑔(𝑦 + √𝑦2 − 1)

The kurtosis 𝑘 is transformed from a gamma distribution to 𝜒2, which is then trans-
formed into standard normal 𝑧2 using the Wilson-Hilferty cubed root transforma-
tion:

𝛿 = (𝑛 − 3)(𝑛 + 1)(𝑛2 + 15𝑛 − 4)

𝑎 = (𝑛 − 2)(𝑛 + 5)(𝑛 + 7)(𝑛2 + 27𝑛 − 70)
6𝛿

𝑐 = (𝑛 − 7)(𝑛 + 5)(𝑛 + 7)(𝑛2 + 2𝑛 − 5)
6𝛿

𝑙 = (𝑛 + 5)(𝑛 + 7)(𝑛3 + 37𝑛2 + 11𝑛 − 313)
12𝛿

𝛼 = 𝑎 + 𝑐 × 𝑠2

𝜒 = 2𝑙(𝑘 − 1 − 𝑠2)

𝑧2 =
√

9𝛼( 1
9𝛼 − 1 + 3√ 𝜒

2𝛼)

Finally, the Doornik-Hansen test statistic is defined as the sum of squared trans-
formations of the skewness and kurtosis. Approximately, the test statistic follows
a 𝜒2 distribution, i.e.:

𝐷𝐻 = 𝑧2
1 + 𝑧2

2 ∼ 𝜒2(2)

Skewness Test

from cruncher, is part of the Doornik Hansen
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Seasonality tests

Test Purpose Display GUI R package
QS test Autocorrelation at seasonal lags ✔
F-test with seasonal dummies Stable seasonality ✔ rjd3toolkit
Canova-Hansen Seasonal frequencies ✖ rjd3toolkit
Identification of spectral peaks Seasonal frequencies ✔
Friedman test Stable seasonality ✔ rjd3toolkit
Two-way variance analysis Moving seasonality ✔

QS Test on autocorrelation at seasonal lags

The QS test is a variant of the Ljung-Box test computed on seasonal lags, where
we only consider positive auto-correlations
More exactly,

𝑄𝑆 = 𝑛(𝑛 + 2)
𝑘

∑
𝑖=1

[max(0, ̂𝛾𝑖⋅𝑙)]2
𝑛 − 𝑖 ⋅ 𝑙

where 𝑘 = 2, so only the first and second seasonal lags are considered. Thus,
the test would check the correlation between the actual observation and the ob-
servations lagged by one and two years. Note that 𝑙 = 12 when dealing with
monthly observations, so we consider the autocovariances ̂𝛾12 and ̂𝛾24 alone. In
turn, 𝑘 = 4 in the case of quarterly data.
Under H0, which states that the data are independently distributed, the statis-
tics follows a 𝜒(𝑘) distribution. However, the elimination of negative correlations
makes it a bad approximation. The p-values would be given by 𝑃(𝜒2(𝑘) > 𝑄)
for 𝑘 = 2. As 𝑃(𝜒2(2)) > 0.05 = 5.99146 and 𝑃(𝜒2(2)) > 0.01 = 9.21034,
𝑄𝑆 > 5.99146 and 𝑄𝑆 > 9.21034 would suggest rejecting the null hypothesis
at 95% and 99% significance levels, respectively.
Maravall (2012) proposes approximate the correct distribution (p-values) of the
QS statistic using simulation techniques. Using 1000K replications of sample size
240, the correct critical values would be 3.83 and 7.09 with confidence levels of
95% and 99%, respectively (lower than the 5.99146 and 9.21034 shown above).
For each of the simulated series, he obtains the distribution by assuming𝑄𝑆 = 0

480



when ̂𝛾12, so in practice this test will detect seasonality only when any of these
conditions hold:

• Statistically significant positive autocorrelation at lag 12
• Non-negative sample autocorrelation at lag 12 and statistically significant
positive autocorrelation at lag 24

F-test on seasonal dummies

The F-test on seasonal dummies checks for the presence of deterministic season-
ality. The model used here uses seasonal dummies (mean effect and 11 seasonal
dummies for monthly data, mean effect and 3 for quarterly data) to describe the
(possibly transformed) time series behaviour.
The test statistic checks if the seasonal dummies are jointly statistically not sig-
nificant. When this hypothesis is rejected, it is assumed that the deterministic
seasonality is present.
This test refers to Model-Based χ2 and F-tests for Fixed Seasonal Effects proposed
by LYTRAS, D.P., FELDPAUSCH, R.M., and BELL, W.R. (2007) that is based on the
estimates of the regression dummy variables and the corresponding t-statistics of
the RegARIMAmodel, in which the SARIMA part of themodel as one of the following
forms:

• (0 1 0)(0 0 0)
• (1 0 0)(0 0 0)
• (0 0 0)(0 0 0)

In that way, the model can always be quickly estimated by a simple OLS. The first
form will be the default for original series and for seasonally adjusted series. The
last form is reserved for tests on irregular components and on residuals. Using
more complex ARIMA models does not significantly change the results.
For instance, in the case of a monthly series and structure (0 1 0)(0 0 0), the
RegARIMA model structure is as follows:

(1 − 𝐵)(𝑦𝑡 − 𝛽1𝑀1,𝑡 − … − 𝛽11𝑀11,𝑡 − 𝛾𝑋𝑡) = 𝜇 + 𝑎𝑡 (0.54)

where:
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• 𝑀𝑗,𝑡 =
⎧{
⎨{⎩

1 in month 𝑗 = 1, … , 11
−1 in December
0 otherwise

-dummy variables;

• 𝑦𝑡 – the original time series;
• 𝐵 – backshift operator;
• 𝑋𝑡 – other regression variables used in the model (e.g. outliers, calendar
effects, user-defined regression variables, intervention variables);

• 𝜇 – mean effect;
• 𝑎𝑡 – white-noise variable with mean zero and a constant variance.

The consequences of a misspecification of a model are discussed in LYTRAS, D.P.,
FELDPAUSCH, R.M., and BELL, W.R. (2007).
One can use the individual t-statistics to assess whether seasonality for a given
month is significant, or a chi-squared test statistic if the null hypothesis is
that the parameters are collectively all zero. The chi-squared test statistic is
𝜒̂2 = ̂𝛽′[𝑉 𝑎𝑟( ̂𝛽) )−1] ̂𝛽 in this case compared to critical values from a 𝜒2(df)-
distribution, with degrees of freedom 𝑑𝑓 = 11 (monthly series) or 𝑑𝑓 = 3
(quarterly series). Since the 𝑉 𝑎𝑟( ̂𝛽) computed using the estimated variance of
𝛼𝑡 may be very different from the actual variance in small samples, this test is
corrected using the proposed F statistic:

𝐹 = 𝜒̂2

𝑠 − 1 × 𝑛 − 𝑑 − 𝑘
𝑛 − 𝑑

where 𝑛 is the sample size, 𝑑 is the degree of differencing, s is time series fre-
quency (12 for a monthly series, 4 for a quarterly series) and 𝑘 is the total number
of regressors in the Reg-ARIMA model (including the seasonal dummies M𝑗,𝑡 and
the intercept).
This statistic follows a 𝐹𝑠−1,𝑛−𝑑−𝑘 distribution under the null hypothesis.

Friedman test for stable seasonality

The Friedman test is a non-parametric method for testing that samples are drawn
from the same population or from populations with equal medians. The signifi-
cance of the month (or quarter) effect is tested. The Friedman test requires no
distributional assumptions. It uses the rankings of the observations. If the null hy-
pothesis of no stable seasonality is rejected at the 0.10% significance level then
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the series is considered to be seasonal and the test’s outcome is displayed in
green.
The test statistic is constructed as follows. Consider first the matrix of data
{𝑥𝑖𝑗}𝑛×𝑘 with 𝑛 rows (the blocks, i.e. number of years in the sample), 𝑘 columns
(the treatments, i.e. either 12 months or 4 quarters, depending on the frequency
of the data).
The data matrix needs to be replaced by a new matrix {𝑟𝑖𝑗}𝑛×𝑘, where the entry
𝑟𝑖𝑗 is the rank of 𝑥𝑖𝑗 within block 𝑖 .
The test statistic is given by

𝑄 = 𝑆𝑆𝑡
𝑆𝑆𝑒

where 𝑆𝑆𝑡 = 𝑛 ∑𝑘
𝑗=1(𝑟.𝑗 − 𝑟)2 and 𝑆𝑆𝑒 = 1

𝑛(𝑘−1) ∑𝑛
𝑖=1 ∑𝑘

𝑗=1(𝑟𝑖𝑗 − 𝑟)2. It
represents the variance of the average ranking across treatments j relative to the
total.
Under the hypothesis of no seasonality, all months can be equally treated. For
the sake of completeness:-𝑟 ∗ .𝑗 is the average ranks of each treatment (month) j
within each block (year)-The average rank is given by 𝑟 = 1

𝑛𝑘 ∑𝑛
𝑖=1 ∑𝑘

𝑗=1 𝑟𝑖𝑗

For large 𝑛 or 𝑘 , i.e. 𝑛 > 15 or 𝑘 > 4, the probability distribution of 𝑄 can be
approximated by that of a chi-squared distribution. Thus, the p-value is given by
𝑃(𝜒2

𝑘−1 > 𝑄).

Moving seasonality test

The evolutive seasonality test is based on a two-way analysis of variance model.
The model uses the values from complete years only. Depending on the decompo-
sition type for the Seasonal/Irregular component it uses Equation 0.54 (in the case
of a multiplicative model) or Equation 0.25 (in the case of an additive model):

|SIij − 1| = 𝑋ij = 𝑏𝑖 + 𝑚𝑗 + 𝑒ij

|SIij| = 𝑋ij = 𝑏𝑖 + 𝑚𝑗 + 𝑒ij
where:
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• 𝑚𝑗 – monthly or quarterly effect for 𝑗-th period, 𝑗 = (1, … , 𝑘), where 𝑘 = 12
for a monthly series and 𝑘 = 4 for a quarterly series;

• 𝑏𝑗 – annual effect 𝑖, (𝑖 = 1, … , 𝑁) where𝑁 is the number of complete years;

• 𝑒ij – residual effect.
The test is based on the following decomposition:

𝑆2 = 𝑆2
𝐴 + 𝑆2

𝐵 + 𝑆2
𝑅, (0.55)

where:

• 𝑆2 = ∑𝑘
𝑗=1 ∑𝑁

𝑖=1(𝑋 ij − 𝑋••)2 –the total sum of squares;

• 𝑆2
𝐴 = 𝑁 ∑𝑘

𝑗=1(𝑋•𝑗 − 𝑋••)2 – the inter-month (inter-quarter, respectively)
sum of squares, which mainly measures the magnitude of the seasonality;

• 𝑆2
𝐵 = 𝑘 ∑𝑁

𝑖=1(𝑋𝑖• − 𝑋••)2 – the inter-year sum of squares, which mainly
measures the year-to-year movement of seasonality;

• 𝑆2
𝑅 = ∑𝑁

𝑖=1 ∑𝑘
𝑗=1(𝑋 ij − 𝑋𝑖• − 𝑋•𝑗 − 𝑋••)2 – the residual sum of squares.

The null hypothesis 𝐻0 is that 𝑏1 = 𝑏2 = ... = 𝑏𝑁 which means that there is no
change in seasonality over the years. This hypothesis is verified by the following
test statistic:

𝐹𝑀 =
𝑆2

𝐵
(𝑛−1)

𝑆2
𝑅

(𝑛−1)(𝑘−1)

which follows an 𝐹 -distribution with 𝑘 − 1 and 𝑛 − 𝑘 degrees of freedom.

Combined seasonality test

This test combines the Kruskal-Wallis test along with test for the presence of sea-
sonality assuming stability (𝐹𝑆), and evaluative seasonality test for detecting the
presence of identifiable seasonality (𝐹𝑀). Those three tests are calculated using
the final unmodified SI component. The main purpose of the combined seasonality
test is to check whether the seasonality of the series is identifiable. For example,
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the identification of the seasonal pattern is problematic if the process is domi-
nated by highly moving seasonality (DAGUM, E.B. (1987)). The testing procedure
is shown in the figure below.

Figure 278: Combined seasonality test, source: LADIRAY, D., QUEN-
NEVILLE, B. (2001)

Identification of spectral peaks

Tests related to identification of spectral peaks in a periodogram, autoregressive
spectrum or Tuckey spectrum are detailed here in the chapter dedicated to spectral
analysis.
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STL: Local regression decomposition

Up coming content.
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Benchmarking and Temporal disaggregation

Benchmarking Underlying Theory

Benchmarking3 is a procedure widely used when for the same target variable the
two or more sources of data with different frequency are available. Generally, the
two sources of data rarely agree, as an aggregate of higher-frequency measure-
ments is not necessarily equal to the less-aggregated measurement. Moreover,
the sources of data may have different reliability. Usually it is thought that less
frequent data are more trustworthy as they are based on larger samples and com-
piled more precisely. The more reliable measurement is considered as a bench-
mark.

Benchmarking in Seasonal adjustment

In seasonal adjustment methods benchmarking is the procedure that ensures the
consistency over the year between adjusted and non-seasonally adjusted data.
It should be noted that the ESS Guidelines on Seasonal Adjustment (2024), do
not recommend benchmarking as it introduces a bias in the seasonally adjusted
data. The U.S. Census Bureau also points out that “forcing the seasonal adjust-
ment totals to be the same as the original series annual totals can degrade the
quality of the seasonal adjustment, especially when the seasonal pattern is under-
going change. It is not natural if trading day adjustment is performed because
the aggregate trading day effect over a year is variable and moderately different
from zero”[^2]. Nevertheless, some users may need that the annual totals of the
seasonally adjusted series match the annual totals of the original, non-seasonally
adjusted series[^3].
According to the ESS Guidelines on Seasonal Adjustment (2015), the only bene-
fit of this approach is that there is consistency over the year between adjusted
and the non-seasonally adjusted data; this can be of particular interest when

3Description of the idea of benchmarking is based on DAGUM, B.E., and CHOLETTE, P.A. (1994)
and QUENNEVILLE, B. et all (2003). Detailed information can be found in: DAGUM, B.E., and
CHOLETTE, P.A. (2006)
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low-frequency (e.g. annual) benchmarking figures officially exist (e.g. National Ac-
counts, Balance of Payments, External Trade, etc.) and where users’ needs for
time consistency are stronger..
The benchmarking procedure in JDemetra+ is available for a single seasonally ad-
justed series and for an indirect seasonal adjustment of an aggregated series. In
the first case, univariate benchmarking ensures consistency between the raw and
seasonally adjusted series. In the second case, the multivariate benchmarking
aims for consistency between the seasonally adjusted aggregate and its season-
ally adjusted components.
Given a set of initial time series

{𝑧𝑖,𝑡}𝑖∈𝐼
, the aim of the benchmarking procedure is to find the corresponding

{𝑥𝑖,𝑡}𝑖∈𝐼

that respect temporal aggregation constraints, represented by𝑋𝑖,𝑇 = ∑𝑡∈𝑇 𝑥𝑖,𝑡
and contemporaneous constraints given by

𝑞𝑘,𝑡 = ∑
𝑗∈𝐽𝑘

𝑤kj𝑥𝑗,𝑡

or, in matrix form:

𝑞𝑘,𝑡 = 𝑤𝑘𝑥𝑡
.
The underlying benchmarking method implemented in JDemetra+ is an extension
of Cholette’s4 method, which generalises, amongst others, the additive and the
multiplicative Denton procedure as well as simple proportional benchmarking.
The JDemetra+ solution uses the following routines that are described in DURBIN,
J., and KOOPMAN, S.J. (2001):

• The multivariate model is handled through its univariate transformation,
• The smoothed states are computed by means of the disturbance smoother.

4CHOLETTE, P.A. (1979).
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The performance of the resulting algorithm is highly dependent on the number of
variables involved in the model (∝ 𝑛3). The other components of the problem
(number of constraints, frequency of the series, and length of the series) are much
less important (∝ 𝑛).
From a theoretical point of view, it should be noted that this approach may han-
dle any set of linear restrictions (equalities), endogenous (between variables) or
exogenous (related to external values), provided that they don’t contain incompat-
ible equations. The restrictions can also be relaxed for any period by considering
their “observation” as missing. However, in practice, it appears that several kinds
of contemporaneous constraints yield unstable results. This is more especially
true for constraints that contain differences (which is the case for non-binding
constraints). The use of a special square root initializer improves in a significant
way the stability of the algorithm.

Temporal disaggregation

Temporal disaggregation is a process by means of which a high frequency time se-
ries is obtained from its low frequency observations and, possibly, some additional
information, such as a related high frequency time series.
By low and high frequency we may refer, for example, to a time series observed
yearly or quarterly (in low frequency) that we try to estimate for each month (in
high frequency), or to a time series observed yearly that we try to estimate for
each quarter.
There are several types of temporal disaggregation methods. We will classify them
according to two criteria, their deterministic or stochastic nature and whether they
use any related time series or not.
In temporal disaggregation, we use 𝑠 as low frequency time index variable and 𝑡
as high frequency time index variable. So, 𝑦𝑠 is the observed low frequency time
series of interest, 𝑦𝑡 is the desired, but not observed, high frequency time series
of interest, while 𝑧𝑠 and 𝑧𝑡 are the corresponding auxiliary time series, where,
usually, 𝑧𝑡 is observed and 𝑧𝑠 is computed from 𝑧𝑡. The objective is to compute
the estimates ̂𝑦𝑡.
In benchmarking the notation is similar, but now 𝑦𝑡 is observed. The purpose is to
calibrate it using 𝑧𝑠 or 𝑧𝑡 (whichever is available). The calibrated values are the
̂𝑦𝑡.
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Deterministic Methods

We now briefly describe some of the deterministic methods used for temporal
disaggregation and benchmarking.

Pro-rata

For temporal disaggregation, if we have 𝑦𝑠 and 𝑧𝑡, we first compute 𝑧𝑠 and then
̂𝑦𝑡 = 𝑦𝑠

𝑧𝑡
𝑧𝑠
(we pro-rate 𝑦 proportionally to 𝑧).

For benchmarking, if we have 𝑦𝑡 and 𝑧𝑠, we first compute 𝑦𝑠 and then ̂𝑦𝑡 = 𝑧𝑠
𝑦𝑡
𝑦𝑠

(we pro-rate 𝑧𝑠 with the ratios 𝑦𝑡/𝑦𝑠).
The advantage of this method is that it is simple to use, but there are some other
methods which have more desirable properties.

Denton

The Denton method5 was designed to preserve the movement of the indicator in
the benchmarked or disaggregated series.

For benchmarking assume that we observe 𝑌 = (𝑦1, ⋯ , 𝑦𝑇 )𝑇 and that we have
a set of 𝑟 < 𝑇 linear constraints on the benchmarked values ̂𝑌 = ( ̂𝑦1, ⋯ , ̂𝑦𝑇 )𝑇
of the form

𝐶 ̂𝑌 = 𝑑, that is (
𝐶11 ⋯ 𝐶1𝑇⋯ ⋯ ⋯
𝐶𝑟1 ⋯ 𝐶𝑟𝑇

)(
̂𝑦1⋯
̂𝑦𝑇
) = (

𝑑1⋯
𝑑𝑟,

)

For example, the 𝑦𝑖 values could be monthly values, the 𝑐𝑖,𝑗 could be all zeros and
ones (twelve consecutive ones in each row) and the 𝑑𝑗 could be accurate annual
totals obtained from an external source of information. So, the restrictions would
mean that we know more exact annual totals than the annual totals obtained by
summing the 𝑦𝑖, and we require that the annual sums of the benchmarked ̂𝑦𝑖
match those 𝑑𝑗.

5Denton(1971). Adjustment of Monthly or Quarterly Series to Annual Totals: An Approach Based on
Quadratic Minimization. Journal of the American Statistical Association, 66(333):99-102, 1971.
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There are several variations of the Denton method. The additive first differences
Denton method tries, after taking regular differences once, to preserve the move-
ment of the 𝑦𝑡 in the benchmarked values ̂𝑦𝑡. Exactly it minimizes

min
̂𝑦𝑡

𝑇
∑
𝑗=2

[( ̂𝑦𝑡 − 𝑦𝑡) − ( ̂𝑦𝑡−1 − 𝑦𝑡−1)]2, subject to 𝐶 ̂𝑌 = 𝑑, (0.56)

where ( ̂𝑦𝑡 −𝑦𝑡)− ( ̂𝑦𝑡−1 −𝑦𝑡−1) = ̂𝑧𝑡 −𝑧𝑡 and 𝑧𝑡 = 𝑦𝑡 −𝑦𝑡−1 are the first regular
differences of the 𝑦𝑡.
The proportional first differences Denton method is similar, but it assumes that
the short term fluctuations, such as seasonal and irregular, have a multiplicative
effect, instead of additive. It minimizes:

min
̂𝑦𝑡

𝑇
∑
𝑗=2

[ ̂𝑦𝑡
𝑦𝑡

− ̂𝑦𝑡−1
𝑦𝑡−1

]
2
, subject to 𝐶 ̂𝑌 = 𝑑, (0.57)

The additive and proportional second differences Denton methods are also fre-
quently used and are similar to the first differences ones, but taking two regular
differences instead of one.
There exist also some multivariate Denton methods. In them, several time series
are benchmarked or disaggregated, each one with its own restrictions but, addi-
tionally, there are also some new restrictions that involve simultaneously two or
more of the time series at some fixed time points. The optimization has a single
objective function in which all the time series are included, and a different weight
can be assigned to each series.

Stochastic methods

These methods assume some kind of statistical model involving the time series
and the indicator.
Most methods in this category can be considered as particular cases of the method
proposed by Stram and Wei6 7 8. There is a basic assumption made when we

6Stram andWei (1986). Temporal Aggregation in the ARIMA Process. Journal of Time Series Analysis,
7(4):279-292, 1986.

7Stram and Wei (1986). A Methodological Note on the Disaggregation of Time Series Totals. Journal
of Time Series Analysis, 7(4):293-302, 1986.

8Wei and Stram (1990). Disaggregation of Time Series Models. Journal of the Royal Statistical
Society, Ser. B, 52(3):453-467, 1990.
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use any method in this category to temporally disaggregate a time series. That
assumption is that there are no hidden periodicities, and it means that if the (often
unknown) high frequency model is 𝐴𝑅𝑀𝐴(𝑝, 𝑞), namely 𝜙(𝐵)𝑦𝑡 = 𝜃(𝐵)𝜀𝑡, and
if 𝑟1, ⋯ , 𝑟𝑝 are the inverses of the roots of the 𝜙(𝐵) polynomial, then, if for any
𝑖, 𝑗, 𝑟𝑚

𝑖 = 𝑟𝑚
𝑗 this implies that 𝑟𝑖 = 𝑟𝑗, where 𝑚 is the disaggregation period

(for example, 𝑚 is 4 for yearly to quarterly, 12 for yearly to monthly and 3 for
quarterly to monthly). Without this assumption important problems may arise,
that are related to what in system theory is called lack of observability, see Gómez
and Aparicio-Pérez (2009)9 for an in-depth discussion of this subject and how to
proceed when there are hidden periodicities. All the disaggregation methods used
in JDemetra+ use models that assume that there are no hidden periodicities.

Chow-Lin, Litterman and Fernandez

These methods can be all expressed with the same equation, but with different
models for the error term:

𝑦𝑡 = 𝑧𝑡𝛽 + 𝛼𝑡,

𝛼𝑡 = 𝜙𝛼𝑡−1 + 𝜀𝑡, with |𝜙| < 1 (Chow-Lin),
𝛼𝑡 − 𝛼𝑡−1 = 𝜙(𝛼𝑡−1 − 𝛼𝑡−2) + 𝜀𝑡, with |𝜙| < 1 (Litterman),

𝛼𝑡 − 𝛼𝑡−1 = 𝜀𝑡. (Fernandez).
It is assumed that 𝑧𝑡 is observed in high frequency while 𝑦𝑡 is observed only in low
frequency.
As it can be seen, these methods assume a linear regresion model between 𝑦𝑡
and 𝑧𝑡, with residuals that are 𝐴𝑅𝐼𝑀𝐴(1, 0, 0) (Chow-Lin), 𝐴𝑅𝐼𝑀𝐴(1, 1, 0)
(Litterman) or 𝐴𝑅𝐼𝑀𝐴(0, 1, 0) (Fernández), so Fernandez is a special case of
Litterman with 𝜙 = 0 and is also a limit case of Chow-Lin when 𝜙 → 1.
When using modern software like JDemetra+, these models are estimated using
state-space techniques, though some older programs use regression techniques
after writing the model in matrix notation, obtaining then the low frequency model,
estimating it and projecting the solution into high frequency using the conditional
expectation to get the ̂𝑦𝑡. This latter process is also sometimes used to explain
the method when no knowledge of state-space techniques is assumed.

9Gómez and Aparicio-Pérez (2009). A new State-space Methodology to Disaggregate Multivariate
Time Series. Journal of Time Series Analysis, 30(1):97-124, 2009.
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Autoregressive distributed lags models (ADL).

These models are particular cases of 𝐴𝑅𝑀𝐴𝑋 models, that is, autoregressive,
moving average with exogenous input models. An 𝐴𝑅𝑀𝐴𝑋(𝑝, 𝑞, 𝑟) model is of
the form

𝜙(𝐵)𝑦𝑡 = 𝜔(𝐵)𝑧𝑡 + 𝜃(𝐵)𝜖𝑡,
where the 𝜙(𝐵), 𝜃(𝐵) and 𝜔(𝐵) polynomials have respective degrees 𝑝, 𝑞 and 𝑟,
𝜖𝑡 is a white noise process with variance 𝜎2

𝜖 and 𝑧𝑡 is an exogenous input series.

As a particular case, an autoregressive distributed lags 𝐴𝐷𝐿(𝑝, 𝑟) model is de-
fined as a 𝐴𝑅𝑀𝐴𝑋(𝑝, 1, 𝑟) model, that is

𝜙(𝐵)𝑦𝑡 = 𝜔(𝐵)𝑧𝑡 + 𝜖𝑡,
When, additionally, 𝑝 = 1 is imposed, the resulting 𝐴𝐷𝐿(1, 𝑟) model is called a
distributed lags model.
The idea behind using these models for temporal disaggregation is that the in-
clusion of lagged dependent variables 𝑦𝑡−1, 𝑦𝑡−2, ⋯ may significantly reduce the
autocorrelation of the residuals in models such as Chow-Lin and others.

Santos Silva and Cardoso.

In Santos, Silva and Cardoso (2001)10 the 𝐴𝐷𝐿(1, 0) model

𝑦𝑡 = 𝜙𝑦𝑡−1 + 𝑧𝑡𝛽 + 𝜖𝑡
is proposed.
Some variants of this model are also possible, for example

𝑦𝑡 = 𝛼 + 𝜙𝑦𝑡−1 + 𝑧𝑡𝛽 + 𝜖𝑡
where a constant term is included. It is also possible to work in logarithms, for
example with the model log 𝑦𝑡 = 𝛼 + 𝜙 log 𝑦𝑡−1 + log 𝑧𝑡𝛽 + 𝜖𝑡.

10Santos, Silva and Cardoso (2001). The Chow-Lin Method Using Dynamic Models. Economic Mod-
elling, 18:269-280, 2001.
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Proietti

In Proietti (2006)11 the 𝐴𝐷𝐿(1, 1) model with linear deterministic trend
𝑦𝑡 = 𝜙𝑦𝑡−1 + 𝑚 + 𝑔𝑡 + 𝑧𝑡𝛽 + 𝑧𝑡−1𝛾 + 𝜖𝑡

is considered.
As a particular case, if 𝑚 = 𝑔 = 0 and 𝛾 = −𝛽𝜙, we get (1 − 𝜙𝐵)𝑦𝑡 = 𝛽(1 −
𝜙𝐵)𝑧𝑡 +𝜀𝑡, that is Chow-Lin (multiplying by (1−𝜙𝐵) in Chow-Lin we get exactly
this model).

11Proietti (2006). Temporal Disaggregation by State Space Methods: Dynamic Regression Methods
Revisited. Econometric Journal, 9:357-372, 2006.
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Revision Analysis

In this Chapter

This chapter gives some methodological background on revision analysis. Avail-
able JDemetra+ algorithms are described in this chapter

Motivation

why ?
how to analyse the behaviour of revisions of frequently published (and revised)
macro-economic indicators.
details on methods
Bell, William R, and Steven C Hillmer. 1984. “Issues Involved With the Seasonal
Adjustment of Economic Time Series.” Journal of Business & Economic Statistics
2 (4): 291–320.

Burman, J P. 1980. “Seasonal Adjustment by Signal Extraction.” Journal of the
Royal Statistical Society: Series A (General) 143 (3): 321–37.

Caporello, Gianluca, and Agustin Maravall. 2004. “Program TSW: Revised Refer-
ence Manual.” {T}echnical {R}eport, {R}esearch {D}epartment. Banco de
España. https://www.bde.es/f/webbde/SES/Secciones/Publicaciones/Publicacio
nesSeriadas/DocumentosOcasionales/04/Fic/do0408e.pdf.

Cleveland, William P, and George C Tiao. 1976. “Decomposition of Seasonal Time
Series: A Model for the Census x-11 Program.” Journal of the American Statis-
tical Association 71 (355): 581–87.

Hillmer, Steven C, and George C Tiao. 1982. “An ARIMA Model-Based Approach to
Seasonal Adjustment.” Journal of the American Statistical Association 77 (377):
63–70.

Maravall, Agustin, and David A Pierce. 1987. “A Prototypical Seasonal Adjustment
Model.” Journal of Time Series Analysis 8 (2): 177–93.
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